


Get more mileage out of 
your modem with SET COMM. 

Equipped with a modem and SITcomm, you can 
communicate across town or around the globe. Unlike 
other modem software, SITcomm doesn’t require you 
to be an expert at communications. SITcomm is the 
first program smart enough to automatically navigate 
you around the technical barriers so you'll get more 
from your modem immediately. ; 

Address Book keeps track of Keep notes while online 
your online services. or compose thoughts offline 

Connect as quick as a click. to save phone charges. 

Worldwide 
| Automaticall 

connections your calling card 
made simple. number on the road. 

SITcomm’s Toolbar puts key features at your fingertips. 
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—If you 

can point and click, you can connect to online services 

like CompuServe, Dow Jones, MCI Mail, the Internet, 

and local bulletin boards (BBSs). SITcomm already 

knows how to connect to most major online services, 
so you can get started right away. No fuss, no muss, 

and NO scripting. 

—A graphical palette gives you quick and easy 

access to all of SITcomm’s most useful features. 

— Jot down information during your session or 

compose your thoughts offline using the Notepad. 

—$ITcomm includes features designed 

expressly for the traveler. If you’re dialing long distance, 

SITcomm can automatically use your calling card 

number. On PowerBooks, SITcomm goes out of its way 

to conserve battery life. 

—SITcomm can automatically expand any 

compressed files you receive, including files compressed 
with Stufflt (sit), Compact Pro (.cpt), and BinHex 
(.hqx). SITcomm can also compress files and folders 
into a Stuffit archive before sending, saving you 

considerable connection time and telephone charges. 

—SITcomm’s power extends 

beyond the Macintosh, expanding compression formats 

from other computer platforms, such as PC-compatibles 
(.zip and .arc) and Unix (.tar, .Z, and .uu). 

—Users of AppleScript and UserLand Frontier 

can automate communication and compression tasks. 

One way to script is just like a tape recorder; you can 

easily record and playback all of your SITcomm actions. 

—If you have anti-viral 
software, SITcomm can automatically check newly 

downloaded files for viruses. 

SITcomm is based on the Macintosh Communications 
Toolbox and handles all major serial and modem 
connections with TTY, VT52, and VT102 terminal =, 
emulations. All major transfer protocols, including 

XMODEM, YMODEM, ZMODEM, and Kermit a 
supported. You can expal comm’s ¢ a) 

simply adding new Co 





Aladdin License Agreement 

This is a legal agreement between you, the end user, and Aladdin Systems, Inc. Be sure to read the following 
agreement before using the software. BY OPENING THIS ENVELOPE AND USING THE SOFTWARE, YOU ARE 
AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF 
THIS AGREEMENT, PROMPTLY RETURN THE ENTIRE PACKAGE (with all accompanying items) TO THE PLACE 
YOU OBTAINED THEM FOR A FULL REFUND. 

ALADDIN SOFTWARE LICENSE 

1. GRANT OF LICENSE. Aladdin Systems grants to you the right to use one copy of the enclosed software program 
(the "SOFTWARE") on a single computer (i.e. with a single CPU). You may not network the SOFTWARE or otherwise 
use it or make it available for use on more than one computer at the same time. 

2. COPYRIGHT. The SOFTWARE is owned by Aladdin Systems and is protected by United States copyright laws ani 
international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g. a 
book or musical recording) except that you may either (a) make one copy of the SOFTWARE solely for backup or 
archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for 
backup or archival purposes. You may not copy the written materials accompanying the software. 

3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and 
accompanying written materials on a permanent basis provided you retain no copies and the recipient agrees to the 
terms of this agreement. You may not electronically transfer the SOFTWARE from one computer to another. You 
may not modify, adapt, translate, reverse engineer, decompile, or disassemble the SOFTWARE. 

4. MISCELLANEOUS. This Agreement shall be governed by the laws of the State of California. If for any reason a 
court of competent jurisdiction finds any provision of this Agreement, or portion thereof, to be unenforceable, that 
provision of the Agreement shall be enforced to the maximum extent permissible so as to effect the intent of the 
parties, and the remainder of this Agreement shall continue in full force and effect. 

5. DISCLAIMER OF WARRANTY AND LIMITED WARRANTY. THE SOFTWARE AND ACCOMPANYING WRITTEN 
MATERIALS (INCLUDING INSTRUCTIONS FOR USE) ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. 
FURTHER ALADDIN SYSTEMS DOES NOT WARRANT, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, 
OR THE RESULTS OF THE USE, OF THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, 
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. 

Aladdin Systems warrants that the disks on which the SOFTWARE is recorded is free from defects in materials and 
workmanship under normal use for a period of ninety (90) days from purchase. You may obtain a replacement disk 
by returning the original disk to: 

Aladdin Systems, Inc., 165 Westridge, Watsonville, California, 95076, United States of America, (408)761-6200 phone, 

(408)761-6206 fax. 

THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE THAT ARE MADE BY ALADDIN SYSTEMS ON THIS ALADDIN SYSTEMS PRODUCT. NO ORAL OR 

: WRITTEN INFORMATION OR ADVICE GIVEN BY ALADDIN SYSTEMS, ITS DEALERS, DISTRIBUTORS, AGENTS, OR 
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND 
YOU MAY NOT RELY ON SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE. 

NEITHER ALADDIN SYSTEMS NOR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION, 
PRODUCTION, OR DELIVERY OF THE SOFTWARE SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, 
CONSEQUENTIAL, OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR 
THE INABILITY TO USE THE SOFTWARE EVEN IF ALADDIN SYSTEMS HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY 
FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES OR THE LIMITATION OF DURATION OF IMPLIED 
WARRANTY , THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. Aladdin Systems ' entire liability and your 
exclusive remedy as to the disk and SOFTWARE shall be, at Aladdin Systems’ option, either (a) return of the 
purchase price or (b) replacement of may defective disk. 

US. GOVERNMENT RESTRICTED RIGHTS 

The SOFTWARE and documentation is provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subdivision (b) (3) (ii) of The Rights in Technical Data and 
Computer Software clause at 252.227-7018. Manufacturer is Aladdin Systems, Inc., 165 Westridge, Watsonville, 
California, 95076. 

Our lawyers are happy. 
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WELCOME T0 

*& SITCOM 

All of us at Aladdin Systems thank you for purchasing SITcomm. We think you'll find 

SITcomm to be the easiest telecommunications program available today. We want you 

to get started with SITcomm right away, so we’ve put together important information on 

these cards. With them, you'll be using SITcomm to travel the online services in no time. 

Installation 
SITcomm is very easy to install. See the other side of this card for instructions on 

how to install SITcomm. 

“Read Us First!” Folder 
After installing SITcomm, see the “Read Us First!” folder (in the SITcomm folder on 

your hard disk) for important information about SITcomm. 

Register Your Software 
If you have not already done so, please complete and mail the postage-paid Registration 

Card located in the Reference Card. Registered users are entitled to free technical support, 

upgrade notices, and special offers on Aladdin Systems products. 

| The User's Guide 
» Even though the software is easy to use, the comprehensive User’s Guide covers 

every feature of the software. Additions to the User’s Guide can be found in the 

“Read Us First!” folder. 

Reference Card 
See the Quick Start Section to get started immediately. The other sections contain a 

compendium of handy information and shortcuts. 

SITcomm 12/98 



INSTALLATION 

You have a choice of how to install SITcomm. Doing a standard installation automatically 

installs all of the parts of SITcomm in the appropriate places on your hard disk. A custom 

installation lets you choose which parts of SITcomm you want to install. 

Installing SITCOM: 
1) Lock your original SITcomm disks. To lock a disk, slide the square tab in the back upper 

corner of the disk until it clicks and you can see through the hole. A locked disk cannot 

be erased, reformatted, or changed in any way. — 

_ Make a copy of your original disks and store these copies in a safe place, away from dust and 

magnets. You should install SITcomm from the original disks. 

For the standard installation: 
2) Insert SITcomm Disk 1 into the floppy drive and double-click on the 

“SITcomm™ 1.0 Installer” icon. 

3) Asplash appears; click “Continue.” 

4) An informational dialog appears; read it and click “Continue.” 

5) An installation dialog appears; click “Install.” 

6) Choose the desired location of your SITcomm folder, and click “Save.” 

7) Insert Disk 2 when instructed. 

8) When the installation is finished, a dialog box will tell you the installation is successful. 

Click “Quit” to exit the Installer. 

When you first open the SITcomm application, you will be asked to personalize it with your 

registration number. (The number is located on your Reference Card.) 

For a custom installation: 
Steps 1 through 4 remain the same. 

5) An installation dialog appears; click “Custom.” | 

6) A custom installation dialog appears. Command-shift-click on each item you wish to install. 

Click “Install.” Continue with Step 6 of the standard installation. 



© SITCOM 
REFERENCE CARD 

QUICK START 
To create an entry in the Address Book: 
1) Choose “Address Book...” from the Session menu. 

2) Click “New...” to create a new entry. 

3) Choose the online service from the Service pop-up menu. 

4.) Type in a name, phone number, and access information. 

5) Click the “Tools” icon. 

6) Review the connection, terminal, and file transfer settings to ensure they 

| correspond with the recommended settings of your online service. 

7) To change any of these settings, click on the appropriate button. 

8) Press Return or click “Save.” 

To connect to an Address Book entry: 
1) Ifyou have just created a new entry and are still in the Address Book, click “Connect.” 

If you are not in the Address Book: 

1) Choose “Address Book...” from the Session menu. — 

2) Click once on the entry you want to use. 

3) Click “Connect.” 

Alternative: | 

1) Scroll through the Address Book pop-up menu on the top left panel of the Toolbar. 

2) Release the mouse when your online service is highlighted in the pop-up menu. 

3) Click the “Connect” button in the Toolbar. 

To receive (download) a file: 
1) Ask the system with whom you're connected to start the transfer. 

2) Click the “RECV” button in the Toolbar (or choose “Receive File” from the File menu). 

To send (upload) a file: 
1) Ask the system with whom you're connected to get ready to receive the transfer. 

2) Click on the “Send...” button in the Toolbar. 

3) A dialog will appear. Locate each file you wish to send and click “Add” for each one. 

4) If you do not want to compress the files before sending them, 

uncheck the “Stuff files for sending” box. 

5) Click “Send.” 

SITcomm 12/98 



ADDRESS BOOK ENTRY ; 

Name: | PMUG BBS 

Service:| Manual Logon vr 

Username: Transfers 

Tools — Click on Connection, Terminal, and File 
Transfer to change your modem and transfer setups. 

—X] Expand L] Automatically open connection 
>] Delete after Expanding 

[x] Expand Stuffit Archives 

f] Expand Compact Pro Archives 

>] Expand AppleLink Packages 

—] Decode BinHex 

—x] Expand result 

[] Recognize DEC Printer Sequences 

Capture Data: 

@ from Terminal 

© from Connection 

C] strin contral characters (1 Detect viruses with 

Transfers — Decide what to do after receiving files. General — Set other preferences here. 

TOOLBAR 

Show Address Book/ 

Pop-Up Menu Open Notepad Connect/Disconnect Turn On/Off Capturing 

File Transfer Settings Connection Settings Turn On/Off Printing Receive File 

Terminal Settings Pause/Resume Connection Send File 



~ COMMAND KEY EQUIVALENTS 

Command-T — Send File... (File menu) — 

Command-R — Receive File (File menu) 

Command-S — Stuff... (File menu) 

Command-E — Expand... _ (File menu) 

Command-L = View File... (File menu) 

Command-P — Print... (File menu) 

Command-Q — Quit (File menu) 

Command-Z — Undo (Edit menu) 

Command-X — Cut (Edit menu) 

Commande — Copy (Edit menu) 

Command-V — Paste (Edit menu) 

Command-A — Select All (Edit menu) 

Command-= — Append to Notepad (Edit menu) 

Command-F — Find... (Edit menu) 

Command-G — Find Again (Edit menu) 

Command-K — Connect (Session menu/Toolbar) 

Command-D — Quick Dial... (Session menu/Toolbar) 

Command-B — Address Book... (Session menu/Toolbar) 

Command-W — Close Window (Windows menu) 

Command-N — Notepad (Windows menu) 
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AA 22480 
Registration Number 

(Registration Number begins with AA.) ALADDIN ASSISTANCE 

Aladdin Systems is committed to providing the 
hest customer support in the business. 
We're willing to back up those words with a range of s services that go beyond most 

other manufacturers. Our registered users can take advantage of free technical 

support, reasonable upgrades, training, advance product announcements and bulletins. 

In addition, Aladdin Systems sponsors Academic, User Group and oe Programs. 

30-Day, Money-Back Guarantee 

We are confident that you will like every Aladdin Systems product. However, if you are 

dissatisfied with this product, you may return it for a full refund. Write or call us for 

more information. 

Registration Card 

By registering you are entitled to free technical are and upgrade notices. Please take 

a few moments to complete and mail this postage-paid card. 

Technical Support 
If you have any problems using this product, we recommend the following: 

Review the manual — it answers most questions and problems. If you still have a question, 

you may contact us by any of the methods below. If you choose to call, please have your 

manual and original program disk(s) on hand. Also, being seated at your computer with 

the program running will help us serve you better. 

Technical 

Mailing Address Support Hotline Online 

Aladdin Systems, Inc. (408) 761-6200 AppleLink, America Online: ALADDIN 

165 Westridge Drive (408) 761-6206 fax GEnie: ALADDINSYS 

Watsonville, CA 95076 Monday — Friday CompuServe: 75300,1666 

9 am — 5 pm Pacific Internet: aladdin@well.sf.ca.us 

Your Comments 
If you have any comments or suggestions, please feel free to contact us by any of the above 

methods. We welcome your input. Also, please take a moment to let us know what you think 

about SITcomm. By completing the attached questionnaire and returning it to us, you will be 

providing us with valuable information we can use to produce even better products in the 

future. We value your comments just as we value your business. 



S1TCONM REGISTRATION CARD AA 22480 
Please write legibly and complete entire card. prmicmeeccer agte 

Name 

Company (if applicable) 

Address 

City State Zip/Postal Code Country 

Daytime telephone Fax 

Where can we reach you online? 

Please send me information on: J Site licenses (1 Volume purchases - UW Aladdin Systems products 

Place purchased | Date purchased / / 

Which other Aladdin products do you own? 

Where did you hear LI Friend (J Dealer/Mail Order LJ Ad in 

about SITcomm? _J User group (I Trade show LJ Other - 

Macintosh owned Hard disk size Networked? [J Yes I No 

RAM memory Modem speed Use E-Mail? (1) Yes CI No 

Printer 

Occupation People in company: 1-9 (310-49 050-99 (1100+ 

SITcomm 12/93 

WE WELCOME YOUR INPUT 
If you have any comments or suggestions, please contact us by sending in this postage-paid card. 

What do you like about SITcomm? 

ue don’t you like about SITcomm? 

What are the a important features of this software? 

What are the least important features of this software? 

What would you like to see in the future? 

SITcomm 12/93 
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Systems. 
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Colophon 

The type used is Courier, ITC Century Condensed, and Zapf Dingbats. Text 

and graphics were generated using Microsoft Word and Canvas 3.0. The 

screen capture utility used was Screenshot. Layout was done with 

FrameMaker and pages were proofed using an Apple LaserWriter IIf. 
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Welcome 

What is SITcomm? 

Chapter 1. Introduction 

Welcome to SITcomm™ , Simply Intuitive Telecommunications, the 

complete, easy-to-use communications software for your Apple® 

Macintosh®. If you are new to the world of communications, you'll be 

delighted by how easy SITcomm is to learn and use. If you have some 

telecommunications experience, you'll appreciate SITcomm’s more 

advanced features, including its built-in Aladdin Technology and 

AppleScriptability. 

With SITcomm, your Macintosh computer can communicate with a variety of 

other computers. The computers may be linked by cables or by telephone 

lines. With SITcomm and the required equipment, you can exchange 

information with: 

e a colleague who is using another computer (Macintosh or non-Macintosh) 

with the appropriate communications software. 

e aclient by way of an electronic mail service, such as CompuServe or GEnie. 

e your company’s or school’s remote minicomputer or mainframe. 

The other computer that you communicate with can be located across the 

room, across town, or on the other side of the world. You can get stock quotes 

and up-to-date news from an information service like Dow Jones News/ 

Retrieval. Access whole libraries of information through various commercial 

databases, like CompuServe. You can even communicate directly with other 

computer users in a special interest group (SIG) and tap into all kinds of 

databases on low-cost local bulletin board systems (BBSs). 

Note: Terms in italics are defined in the Glossary at the back of this manual. 

SITcomm is an easy-to-use, yet powerful communications software package 

for the Macintosh. Here are just a few of the many things you can do with 

SITcomm: 
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e Automatically dial and connect your computer to another Macintosh, other 

personal computer, minicomputer, or mainframe computer. 

e Automatically dial and connect to a commercial online service, or a BBS. 

e Establish connections either directly or remotely. 

e Carry on real-time conversations with other computer users online. 

e Send and receive files to and from other computers. 

e Compress files before sending them, or expand files after receiving them. 

e Read non-Macintosh files. 

SITcomm uses the tools in the Macintosh Communications Toolbox, which 

is a set of extensions to Macintosh system software that provides a 

consistent interface across communications applications. 

Unlike many other communications packages on the market, SITcomm 

features an intuitive graphical interface that is extremely easy to learn and 

use. A Toolbar gives you quick access to all of SITcomm’s features with just a 

click of the mouse. 

You can accomplish more in less time with SITcomm. The SITcomm Address 

Book stores dialing and connection instructions for up to 200 addresses. An 

address might be your CompuServe account or your favorite BBS. Each 

address includes a phone number, your user name or ID, and password 

settings. All you do is select an Address Book entry, and SITcomm dials and 

connects for you. 

Another time-saving feature is Quick Dial. With one simple click of the 

mouse, the Quick Dial feature lets you dial and connect to another computer, 

online service, or BBS. 

Besides ease of use and time efficiency, SITcomm gives you flexibility. With 

the Buffered Keyboard, you can type and edit the text to send without 

sending it right away. The text stays in the buffer until you tell SITcomm to 

send it. Or, you can use the Notepad to keep notes while you are online. 

SITcomm is sophisticated and easy to use; you get advanced Aladdin Systems 

technologies built right into SITcomm, including: 

e Compression. Aladdin’s industry-standard StuffIt file compression is 

included with SITcomm. That means you can reduce the size of a file before 

transferring it to another computer, thereby saving transfer time and 

expense. 

e Auto-expansion. SITcomm is set to automatically expand any compressed 

file you download. 

e Translators. SITcomm Translators let you translate and read just about 

any file format, including files created on an IBM PC (or compatible) or on 

UNIX machines. 
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The SITcomm Package 

About this Manual 

e Viewers. You don’t need to leave SITcomm and run a separate application 

to view your downloaded documents. Text and PICT Viewers come with 

SITcomm. 

SITcomm also makes use of Apple events to communicate with other 

Macintosh applications. For example, Apple events make it possible for 

SITcomm to automate routine tasks. You can also run anti-viral applications 

from SITcomm. You can take advantage of Apple events by writing scripts 

using AppleScript or Userland’s Frontier. 

SITComm has extensive balloon help, so that help is always available 

immediately and easily. 

Note: If you are new to the world of telecommunications, you can get an 

overview of communications terms and concepts. See “Section One: 

Introduction to Communications” on page 15. 

The SITcomm package consists of the following items: 

e Two 3.5” disks containing the SITcomm application and associated files 

e SITcomm User’s Guide (this manual) 

e Registration Card 

e Quick Reference Card 

The SITcomm software is comprised of much more than the application 

itself. Here is a list of all of the SITcomm elements: 

e SITcomm, the application 

e Apple Communications Tools (Apple Modem Tool, Serial Tool, TTY Tool, 

VT102 Tool, and Text Tool) 

e Aladdin Communications Tools (Aladdin X/YMODEM Tool, Aladdin 

ZMODEM Tool, and Aladdin Kermit Tool) 

e Stuffit Engine 

e Viewer Engine 

e Viewers 

e Translators 

e Sample runtime scripts for AppleScript and Frontier 

This is your guide to learning and using SITcomm. To use this manual, you 

need to know basic Macintosh techniques and operations, including: 

e Pointing, clicking, and dragging with the mouse 

e Using the Clipboard through Cut, Copy, and Paste 
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e Working in the Finder 

e Choosing commands from menus 

e Using dialog boxes 

e Selecting and editing text 

e Working with disks 

If you aren’t familiar with these, refer to the user guides that came with your 

Macintosh. 

How to Use this Manual This manual is intended to help you get the most out of SITcomm as quickly 
as possible. Throughout the manual, you’ll find many step-by-step procedures 

(called Examples) you can follow to accomplish specific tasks. These 

procedures follow a specific structure. 

Feature Explained: Identifies the SITcomm feature(s) explained in the 

procedure. 

Related Topic: Provides a cross-reference where you can turn elsewhere in 

the manual for more or related information. 

Problem: Identifies the practical task that procedure seeks to accomplish. 

Solution: Provides the necessary steps to follow to accomplish the task. 

In addition to Examples, this manual offers Close-ups, which provide in- 

depth reference material on a given topic. For example, a Close-up may 

explain the options available in a particular dialog box. 

This manual is organized into the following chapters: 

Chapter 1. Introduction (this chapter), gives you a first-look at the 

SITcomm product, including what SITcomm is and what you can do with it. 

Chapter 2. Installation, shows you how to install SITcomm using Standard 

or Custom Install. This chapter also explains where each of the SITcomm 

files are installed on your hard disk. 

Chapter 3. The Basics, teaches you the basics of SITcomm. Included is an 

introduction to the SITcomm environment, an introduction to 

telecommunications, an introduction to file compression and archiving, and 

a tutorial to get you into SITcomm as quickly as possible. 

Chapter 4. Beyond the Basics, covers everything you can do with SITcomm, 

including how to use the Address Book, specify settings (connection, 

terminal emulation, and file transfer), connect to another computer, 

download and upload files, compress data, capture and print text, use the 

Notepad, use the Buffered Keyboard, and disconnect. 

Chapter 5. Mastering SITcomm, covers advanced topics, including setting 

preferences, automating SITcomm with scripts, and using Translators and 

Viewers. 
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Conventions Used in This 
Manual 

Where To Go From Here 

Chapter 6. Troubleshooting: Commonly Asked Questions, features 

questions frequently asked of our technical support specialists and the 

answers. You can use this information for solving most problems you may 

encounter as you use SITcomm. 

Appendices. Appendix A gives an overview of the different commercial 

online services available and offers tips for using BBSs. Appendix B provides 

useful tips for Apple PowerBook users. Appendix C is a reference to the 

AppleScript language that SITcomm supports. 

Glossary defines the terms that appear in italic style throughout this 

manual. 

Note: At a minimum, you should read the Installation and Basics chapters. 

That way, you will know how to install SITcomm and get up to speed with it 

as quickly as possible. Although you can use the other chapters in the manual 

as reference during your work with SITcomm, we strongly recommend that 

you work through the step-by-step procedures throughout the manual. 

For consistency and clarity, this manual uses several conventions. 

e Numbered items are steps that you must follow to complete a procedure. 

For example, procedures appear as numbered lists in the Examples. 

e Alternate methods for completing a procedure are marked with a square 

(like this ml) 

e Terms that appear in italics are defined in the Glossary. 

Note: Text that appears between lines like this contains additional 

information. 

The next chapter describes how to install SITcomm and where files are 

installed on your hard disk. 
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Requirements 

Standard 
Installation 

Chapter 2. Installation 
You have a choice of how to install SITcomm. Doing a standard installation 

automatically installs all of the parts of SITcomm in the appropriate places 

on your hard disk. A custom installation lets you choose which parts of 

SITcomm you want to install. 

To install and use SITcomm, you must have the following: 

e Macintosh computer, running System 7.0 or later 

e Basic Macintosh computer user skills 

e 2 megabytes of RAM 

e Hard disk drive 

e At least 2 megabytes of free disk space 

e A modem, or network connection 

Before you install SITcomm, lock your original SITcomm disks. To lock a disk, 

slide the square tab in the back upper corner of the disk until it clicks and 

you can see through the hole. A locked disk cannot be erased, re-formatted, 

or written to. 

We suggest that you make copies of your original disks, and install SITcomm 

from these copies. Store the original SITcomm disks in a safe place, away 

from dust and magnets. 

Take a few moments now to complete the registration card and return it to 

Aladdin Systems immediately (it’s postage paid). 

Note: If a problem occurs during installation, try installing without system 

extensions loaded. To do this, restart your Macintosh while holding down the 

Shift key. This disables all extensions. Then try installing SITcomm again. 

To proceed with the standard installation: 

Chapter 2. Installation 7 



1. Insert the disk labeled “SITcomm Disk 1” into the floppy 

disk drive of your Macintosh. 

2. Double-click the “SITcomm™ Install” icon. 

3. An informational dialog box appears; when you are ready, 

click Continue. 

The Installer dialog box appears. 

$iTcomm™ Standard Install 

Click "Install" to install the $ITcomm™ 

product. For more options, select 

"Custom". 

Installation requires : 2533K 

Notice that the size of the files you are installing appears in the lower left 

corner of the dialog box. Make sure you have enough room on your hard 

disk before you proceed. If you don’t, the Installer cannot install 

SITcomm. 

The Custom install option lets you select only those SITcomm elements 

you want, thus saving yourself some disk space. See “Custom Installation” 

on page 10 for details. 

Note: If you change your mind and don’t want to install SITcomm at this time, 

click Quit. The Finder appears and nothing is installed on your hard disk. 

4. To begin the installation process, click Install. 

A dialog box appears that lets you choose where to install SITcomm. You 

can also change the name of the SITcomm folder, if you wish. 

= Graphics 
() Adobe Photoshop™ 2.5 

C Aldus Digital Darkroom 

© Aldus Gallery Effects 

© Aldus PageMaker 

© Amortize Folder 

© Apple Extras 

Install software as: 
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Personalizing 
SITcomm 

5. To install SITcomm in a new folder called “SITcomm™ ” on 

your hard disk, click Save. 

Note: To save the SITcomm folder to a different location, navigate to the 

desired disk and/or folder. To install the SITcomm folder in a new folder, click 

New. To give the SITcomm folder another name, type the new name in the 

“Install software as:” box, and click Save. To stop the installation, click 

Cancel. 

A progress bar indicates the status of the installation procedure. If you 

want to stop the installation at this point, press Command-. (period). 

The Installer creates the SITcomm™ folder and installs the application 

and all associated files into the proper locations on your hard disk. See 

“Where SITcomm is Installed” on page 12 for details on where the 

Installer places which files. 

6. When Disk 1 ejects, insert Disk 2 as instructed. 

When installation is complete, a dialog box appears telling you that the 

install process was successful. 

7. Click Quit to exit the Installer. 

Now you need to personalize the SITcomm application, as follows: 

1. Open the SITcomm folder on your hard disk. 

2. Double-click the SITcomm icon. 

SIT comm™ 
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SITcomm opens and a dialog box appears for you to personalize your 

software by entering your name, your company’s name, and your SITcomm 

software registration number. 

G.. =e 

By entering a registration number , you agree to the terms of the license 

(Cancet ) N — — 

3. Type your name, and press Tab to move to the Organization 

field. 

Note: If you are using SITcomm at home, press Tab again to move to the 

registration number, and skip to Step 5. 

4. Type your company’s name, and press Tab. 

5. Type your SITcomm registration number in the last field. 

The registration number is located inside the separate Reference card 

that came in the package. 

6. Click OK to permanently save this information. 

Custom Install ation Use Custom installation to select the specific items of SITcomm that you want 

installed. If you haven’t already done so, you should lock the SITcomm disks, 

then make a copy of the SITcomm disks, store the duplicates in a safe place, 

and use the originals to install SITcomm on your hard disk. Also, don’t forget 

to fill out the software registration card and return it to Aladdin Systems. 

1. Insert the disk labeled “SITcomm Disk 1” into the floppy 

disk drive of your Macintosh. 

2. Double-click the “SITcomm™ Install” icon. 

3. An informational dialog box appears; when you are ready, 

click OK. 
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The Installer dialog box appears. 

oS $iTcomm™ Standard Install 

Click “Install” to install the $ITcomm™ 

product. For more options, select 

"Custom". 

Installation requires : 2533K 

4. Click Custom to begin selecting items for a customized 

installation. 

The Custom Install dialog box opens, listing the groups of files available 

for installation. 

Install the following: 

Full $iTcomm™ Install 

Sifcomm™ Application 

Translator Extensions 

Viewer Extensions 

Scripting Tools 

This package installs the Text, Aladdin X/YMODEM, Aladdin 

ZMODEM and Aladdin Kermit file transfer tools. They allow you 
to exchange files with other computers. 

Installation requires : 305K 

Standard 

5. Scroll through the list of items, and Shift-click the ones you 

want to install. 

The size of the files you are installing appears at the bottom of the dialog 

box. If you select only one item, an explanation of the item appears. Make 

sure you have enough room on your hard disk before you proceed. 

If you change your mind and want SITcomm to do a standard install, either 

click Standard, or select “Full SITcomm™ Install” and then click Install. 

If you change your mind and don’t want to install SITcomm at this time, 

click Quit. The Finder appears and nothing is installed on your hard disk. 

6. To proceed with the installation, click Install. 

The Installer automatically installs the selected items in the appropriate 

places on your hard disk, and displays a progress bar. 

If you want to stop the installation, press Command-. (period). 
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7. If you are instructed to do so, insert Disk 2 to proceed with 

the installation. 

When installation is complete, a dialog box appears telling you that the 

install process was successful. 

8. Click Quit to close the Installer and return to the Finder. 

Where SITcomm is The SITcomm Installer places files and folders in three locations: the 

Installed SITcomm folder, the System Folder, and a folder named Aladdin that is 

created within the Extensions folder in your System Folder. The following 

sections describe the contents of each of these folders. 

Note: If you have other Aladdin software, such as StuffIt Deluxe or 

SpaceSaver, you may have Viewers, Translators, the StuffIt Engine, and the 

Viewer Engine already installed. SITcomm overwrites these existing files only 

with newer versions when appropriate. If an existing file is newer than the 

one SITcomm would install, it doesn’t get overwritten. 

The SITcomm Folder The SITcomm folder is created on your hard disk when you installed the 
software. It contains the SITcomm application and other tools and 

documents that help you use SITcomm. 

SW” SS_j_a_aSa_a_a_—=== 

5 items 37.9 MB in disk 11.3 MB available 

Es 2 S 

Read Us First Scripting Tools 

bh i 

SlTcormm™ 

Services 

Address Book 

The System Folder The SITcomm installation automatically adds the appropriate files to the 
Extensions and the Preferences folders within your System Folder. 

The Extensions that are installed with SITcomm include the 

communications tools (Aladdin Kermit Tool, Aladdin X/YMODEM Tool, 

Aladdin ZMODEM Tool, Serial Tool, Apple Modem Tool, TTY Tool, VT102 Tool, 

and Text Tool), the Stufflt Engine, and the Viewer Engine. The Extensions 

folder also contains a new folder, called the Aladdin folder. Read the next 

section for details on its contents. 

The Preferences associated with SITcomm are SITcomm Preferences, 

Aladdin Kermit Tool Prefs, Aladdin X/YMODEM Tool Prefs, and Aladdin 

ZMODEM Tool Prefs. 
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The Aladdin Folder 

Where To Go From Here 

Within the Extensions folder of your System Folder, you’ll find an Aladdin 

folder. This folder contains the plug-in modules that are used by SITcomm. 

These modules include Translators and Viewers. 

Translators Viewers 

ER IE 

Now you are ready to begin using SITcomm! We suggest you start using the 

software by turning to the next page and reading “Chapter 3. The Basics,” 

which provides an overview of SITcomm and includes a Quick-Start Tutorial. 

Note: Please take a moment to fill out and send in your registration card. 

Being a registered owner entitles you to technical support and product 

upgrades. When SITcomm is upgraded, registered users are the first to know 

about new features. 
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Section One: 

The World of 
Telecommunications 

Chapter 3. The Basics 
This chapter introduces you to the basics of SITcomm and consists of three 

sections: 

e Section One: Introduction to Communications, an introductory overview 

to telecommunications terms and concepts, file transfer protocols, 

compression, and archiving. 

e Section Two: Introducing the SITcomm Environment, an introduction to 

the Terminal Window, Toolbar, and other SITcomm windows. 

e Section Three: Quick-Start Tutorial, a no-nonsense tutorial to get you up 

and running with SITcomm as quickly as possible. 

Introduction to Communications 

SITcomm lets you make connections to share information with other 

computers, and ultimately other computer users. When you share 

information between computers you transmit data over telephone lines or 

over a network. The process of connecting to other computers and 

transmitting information is called telecommunicating. The period of time 

that you are telecommunicating with another computer is called a 

COMMUNICATLONS SESSION. 

A typical communications session follows this basic set of steps: 

1. Specify settings, preferences, and other options. Use the 

Address Book to store the settings and options for your 

favorite connections, so that next time you can connect 

with a single click. 

2. Dial and connect to the other computer. 
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3. Communicate online between computers. 

4. (Optional) Transfer files, capture or print text. 

5. Disconnect from the other computer. 

To make telecommunications possible, SITcomm uses the Apple 

Communications Toolbox, which includes a set of system extensions, called 

communications tools. Once the communications tools are installed in your 

System folder, you must have a modem to telecommunicate. 

A modem converts information from the digital form (which is on or off) 

normally used by your computer into a corresponding series of tones that 

can be transmitted to the receiving computer via telephone (or other audio 

device). The receiving computer (or network) must have a modem which 

performs the opposite conversion, to get the original digital information 

back from the tones. 

If you have an external modem, you connect your modem to the modem port 

of your Macintosh with a cable designed specifically for connecting modems 

to Macintoshes. You also connect the modem to a phone jack via a standard 

telephone cable and to a power source via the power cord and power supply 

that came with your modem. 

Phone jack 

Phone cable 

DIN-8 Cable 

Modem 

If you have an internal modem, you don’t need any special cable to connect 

the modem to the Macintosh; all you need is a phone cable to connect your 

modem to the phone jack. 

The key feature that distinguishes one modem from another is baud rate, 

which is the speed at which a modem transmits data. Most modems are 

available with these standard speeds: 300, 1200, 2400, 9600, and 14400 baud. 

SITcomm supports all these speeds. 



File Transfer Basics 

The higher the baud rate, the faster your modem can send and receive data. 

The money you invest in a faster modem may offset the telephone and online 

charges you incur during a communications session. 

SITcomm gives you the powerful ability to share files with other computers 

and other computer users. You can share everything from public domain 

programs to personal memos to graphic, spreadsheet, database, word 

processor, or any other type of files. 

The process of sending a file between computers is called a file transfer. 

Transferring files across your modem involves either sending a file to 

another computer (wploading ) or receiving a file from the other computer 

(downloading ). 

Before you can send and receive files, file transfer settings must be specified 

so SITcomm knows how to handle the transfer. File transfer settings define 

the protocol used when you send data to or receive data from another 

computer. A protocol is a pre-arranged set of rules for interaction that 

determine such things as data format, error detection, and connection/ 

disconnection procedures. When transferring a file, you must make sure that 

you and the other computer are using the same file transfer protocol with 

compatible settings. 

Because SITcomm uses the Communications Toolbox, specifying a file 

transfer protocol is as simple as selecting a file transfer tool, which 

implements the associated protocol and the appropriate settings. SITcomm 

supports the following file transfer protocols: 

e Text 

e X/YMODEM 

e ZMODEM 

e Kermit 

The Text file transfer protocol is the only one that is best used for straight 

ASCII text files or word processor files that you want to transfer without 

formatting information. It is also the only protocol that doesn’t 

automatically check for errors during transmission. All of the other file 

transfer protocols are best used either for binary files, which contain a 

variety of data (such as text and graphics), or for text files whose formatting 

you want to retain. Plus, the X/‘YMODEM, ZMODEM, and Kermit protocols do 

error checking and correction during data transmission. 

XMODEM is the most commonly used file transfer protocol; YMODEM and 

ZMODEM are extensions of XMODEM. However, ZMODEM is the most 

intelligent, advanced, and fastest of the file transfer protocols. If the other 

computer supports ZMODEM, set SITcomm to use it instead of XMODEM or 

YMODEM. 
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The Kermit file transfer protocol is most prevalent within a university or 

education network. Unless you are exchanging files with these types of 

networks, you probably won’t need to use Kermit very often. 

Note: Each file transfer protocol has an associated file transfer tool. For 

example, the ZMODEM protocol is implemented by the Aladdin ZMODEM 

Tool in the Communications Toolbox. For complete information on each of 

these file transfer tools and their settings, see “Close-up: File Transfer 

Settings” on page 84, in chapter 5. 

To find out how to transfer files, see “Transferring Data” on page 54, in 

Chapter 4. 

Introductionto Compression is the process of making a file or folder smaller so it occupies 

Compre ssion less disk space. Compressed files also take less time to transfer electronically. 
Compression software uses algorithms to analyze and reorganize the 

sequences of characters that comprise a file in a more efficient manner. 

The three primary reasons to compress files or folders are: 

e To speed modem and network transfers. 

e To save disk space. 

e To save space when doing a backup. 

A compressed file that contains more than one file or folder is called an 

archive. SITcomm uses the same compression algorithm found in StuffIt 

Deluxe and SpaceSaver (both also from Aladdin Systems). Like Stuffit 

Deluxe and StuffIt SpaceSaver, SITcomm saves compressed archives with a 

“sit” filename extension. 

With SITcomm, you can create a Stuffit archive (“.sit”), and also create a 

special type of archive called a self-extracting archive, which has a “.sea” 

filename extension. This type of archive can be decompressed by anyone — 

even if the recipient doesn’t own SITcomm, Stuffit, or any other compression 

product. 

On the /nternet, many compressed files have also been encoded with 

BinHex4. This format is a standard conversion algorithm used to convert 

Macintosh binary files to and from ASCII format. BinHex4 is primarily for 

transmission over networks that only support characters that can be typed 

from a keyboard, like Internet mail/news. These compressed files have a 

.HQX filename extension. 

For information on how to compress files in SITcomm, see “Example: 

Stuffing Data” on page 54, in Chapter 4. 
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Section Two: 

Terminal Window 

Introducing the SITcomm 
Environment 
When you open the SITcomm application, you see the Terminal Window, and 

the SITcomm Toolbar. 

$iTcomm # Connection Closed 

Terminal Window 

Show Address Book fE) Notepad Turn On Capturing E\+* Toolbar 

2400-N-8-1 %/YMODEM Turn On Printing — |] SEND J] RECV 

The Terminal Window displays all incoming and outgoing communications 

between your Macintosh and the other computer. This is where you view and 

work with data during a communications session. The Terminal Window is 

always open; you can move it around the screen to any position you want. 

SITcomm is a session-based communications program. Session data (text 

you type and data you receive from the other computer) is stored in the 

screen buffer. You can view the most recent lines of text in the buffer via the 

Terminal Window. When you quit the application, SITcomm automatically 

saves the buffer to disk in the SITcomm Preferences file. The next time 

SITcomm launches, it restores the contents of the Terminal Window from 

the last session. 

During a communications session, the display of all incoming and outgoing 

text begins at the bottom of the window and scrolls up as the 

communications session progresses. Older lines of text become part of the 

buffer, which you can view by scrolling up in the window. 

To clear the contents of the buffer, choose “Clear Buffer” from the Edit 

menu. SITcomm asks if you really want to completely clear the buffer. If you 

do, click OK; the contents of the Terminal Window disappear. 

When you launch SITcomm, the title bar of the Terminal Window says 

“SITcomm ¢ Connection Closed.” When you are connected, the title bar says 
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Toolbar 

Close-up: Toolbar Buttons 

Address Book 
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“STTcomm.” If you hide the Toolbar, the title bar says “<session name>,” 

which is the name you've given to the session’s corresponding Address Book 

entry. For example, if the current Address Book entry is My Favorite BBS, 

the title bar says “My Favorite BBS.” 

The timer appears in the lower left corner of the Terminal Window. The 

timer displays the elapsed time between opening and closing a connection. 

The timer helps you keep track of your connection time so you can estimate 

connection charges. You can reset the timer to 00:00:00 by clicking it. 

iS SIS eo 

The SITcomm Toolbar is the “hub” of SITcomm. At a glance, it gives you 

information about your current communications settings. The Toolbar also 

provides quick access to the most frequently-used SITcomm features simply 

with a click of the mouse. Each button in the Toolbar has an equivalent menu 

command. 

Notepad Connection on Capture on Send File 
Address Book pop-up menu _ button and off button and off button button 

Turn On Capturing | (Ej 
Turn pn Printing 

Connection Tool Terminal Tool File Transfer Pause and resume Printing on and Receive File 
button button Tool button connection button off button button 

The Toolbar is a floating window. You can move it around the screen to any 

position you want. You can close the Toolbar by clicking its close box, or by 

choosing “Toolbar” from the Windows menu to uncheck it. 

The next section gives you a detailed description of each of the Toolbar 

buttons. 

Each button in the Toolbar corresponds to a frequently-accessed menu 

command or dialog box option. Refer to the Toolbar figure above as you read 

the description of each button. 

The Address Book button displays the Address Book entry you used in your 

most current or most recent session. If the Address Book has no entries, 

clicking this button is equivalent to choosing “Address Book” from the 

Session menu. If the Address Book does contain entries, clicking this button 

opens a pop-up menu listing the entries. You can switch to another entry by 

selecting it from the pop-up menu. For more information on the Address 

Book, see “Using the Address Book” on page 34. 



Notepad 

Connection Tool 

Terminal Tool 

File Transfer Tool 

Connect 

Pause/Resume 

Turn On Capturing 

The Notepad button opens the Notepad for you to write, save, and print notes. 

(For more information on the Notepad, see “Using the Notepad” on page 64.) 

The Connection button indicates the current connection settings for your 

modem, including baud rate, parity, data bits, and stop bits. Clicking this 

button is equivalent to choosing “Connection” from the Session menu. Doing 

so opens the Connection Settings dialog box. (For information on specifying 

connection settings, see “Close-up: Connection Settings” on page 71.) 

The Terminal button indicates the current terminal emulation tool in effect. 

Clicking this button is equivalent to choosing “Terminal” from the Session 

menu, which brings up the Terminal Settings dialog box. (For details, see 

“Close-up: Terminal Emulation Settings” on page 77.) 

Use the File Transfer button to change the current file transfer tool. Clicking 

this button is equivalent to choosing “File Transfer” from the Session menu, 

which opens the File Transfer Settings dialog box. (For more information, see 

“Close-up: File Transfer Settings” on page 84.) 

Clicking the Connect button initiates a connection and is equivalent to 

choosing “Connect” from the Session menu. If an Address Book entry is in 

effect (or you have already supplied a phone number to dial), SITcomm 

automatically dials and connects to the other computer. Otherwise, SITcomm 

prompts you for a phone number, then initiates the connection. Using this 

button is the quickest way to connect. (See “Connecting” on page 46 for more 

information about initiating a connection. ) 

Clicking the Pause Connection button tells the other computer to temporarily 

pause data transmission and is equivalent to choosing “Pause Connection” 

from the Session menu. This is most useful when you are receiving incoming 

text more quickly than you can read it. Don’t worry about incoming data — 

the other computer holds it until you resume the connection by clicking this 

button again. 

Clicking the Turn On Capturing button tells SITcomm to start capturing all 

incoming text to disk in a text file and is equivalent to choosing “Turn On 

Capturing” from the Session menu. The file is saved with the file creator 

specified in Preferences, and is saved in the folder specified by “Select 

Receive Folder” in the File menu (or in the SITcomm folder, if none is 

specified). To select another capture file and/or location, hold down the 

Option key as you click this button. To turn capturing off, click this button 

again. (For more information on capturing text, see “Example: Capturing 

Text” on page 60.) 
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Turn On Printing 

SEND 

RECV 

Other SITcomm Windows 

Address Book 

Notepad 
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Clicking the Turn On Printing button sends all incoming text to the printer 

selected in the Chooser. It is equivalent to choosing “Turn On Printing” from 

the File menu. To turn printing off, click the button again. (For more 

information on sending text to the printer, see “Printing Text” on page 62.) 

Click the SEND button to select a file to send (upload) to another computer. 

You must be connected to use this button. If you aren’t, the Connect button 

flashes to remind you to initiate a connection first. Clicking this button is like 

choosing “Send File” from the File menu. (For more information on sending 

files, see “Transferring Data” on page 54.) 

Click the RECV button to receive a file (download) from another computer. 

You must be connected to use this button. If you aren’t, the Connect button 

flashes to remind you to initiate a connection first. Clicking this button is like 

choosing “Receive File” from the File menu. (For more information on 

receiving files, see “Transferring Data” on page 54.) 

In addition to the Terminal Window and the Toolbar, SITcomm has three 

other windows that you'll use as you work with the program — the Address 

Book, Notepad, and Buffered Keyboard. 

The Address Book stores dialing and connection instructions for up to 200 

entries. The Address Book entries can be online services, bulletin boards, or 

the phone number of another computer’s modem. For complete information 

on the Address Book, see “Using the Address Book” on page 384. 

Address Book 

© Default Tool Settings 

Connection © 2400-N-8-1 

Terminal > TTY 

= Automatically open connection Transfer © XMODEM 

The Notepad acts like an online scratch pad for you to keep notes during a 

session. SITcomm maintains two types of Notepads: a global Notepad, and a 



Buffered Keyboard 

Moving On 

Section Three: 

separate Notepad for each Address Book entry. For more information, see 

“Using the Notepad,” beginning on page 64. 

Global Notepad 

This text is just some notes I'm 
saving in the Notepad. The Notepad 

acts like an online scratch pad for 

you to keep notes during a session or 
when you aren't online,| 

The Buffered Keyboard provides an area for you to type and send multiple 

lines of text at a time instead of one character at a time. This is useful for 

online conference or chat sessions. For more information, see “Using the 

Buffered Keyboard,” beginning on page 67. 

Now that you have an understanding of the basics of telecommunications and 

know a little bit about SITcomm, the “Quick-Start Tutorial” (next section) 

will teach you the quickest way to be most productive with SITcomm. 

(Juick-Start Tutorial 
This section presents a tutorial that will help you learn how to use SITcomm. 

The sample exercise has you connect to a BBS. In a series of step-by-step 

procedures, you will use the Address Book to create a new entry for the BBS, 

dial the BBS, download a file, leave a message, and disconnect. 

The tutorial is designed to get you up and running with SITcomm and to 

accomplish real-world tasks with SITcomm as soon as possible. It is assumed 

that you have already installed SITcomm. (If you need to do so, turn to 

“Chapter 2. Installation,” for details.) Before you begin, make sure your 

modem is on and properly connected to your Macintosh. Turn on your 

computer. You should be at the Finder. 

As you work through the tutorial, you may need to refer to your modem’s 

manual for modem configuration information (such as baud rate). So keep 

the modem manual handy. 
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Creating an Address 
Book Entry 
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Note: In this example, the BBS you will connect to, PMUG BBS, is located in 

the 503 area code. This number may result in a long-distance call, and long- 

distance phone charges may apply. If you don’t want to incur these charges, 

you can substitute a local BBS phone number in the example. 

To begin the tutorial, you will launch SITcomm. Once the application is open 

on your screen, you will create an Address Book entry for the BBS. 

1. Double-click the SITcomm icon in the Finder to launch the 

application. 

You see the SITcomm environment, which consists of the SITcomm menu 

bar, the Terminal Window, and the Toolbar. 

To connect to the BBS, you will create a new Address Book entry. This way, 

you specify the appropriate settings once, then store them in the Address 

Book for future use. 

2. Click “Show Address Book” in the Toolbar to open the 

Address Book. 

An empty Address Book appears. The only entry you see is called “Default 

Tool Settings.” 

Address Bok SSS 

© Default Tool Settings 

Connection “> 2400-N-8-1 

Terminal © TTY 

G = Automatically open connection Transfer © XMODEM 

3. Click New to create a new entry for the BBS. 



The Address Editor opens for you to set up the new entry. The Logon icon 

is selected in the left area of the dialog box, indicating that SITcomm 

expects you to enter information about the remote connection. 

Address Editor 

Service:| Manual Logon v 

General 

4. Type “PMUG BBS” in the Name field. 

5. Type “1-503-241-9641” in the Phone field. 

Note: If this is a local call for you, you may not need to type the area code or 

the “1.” Check with your telephone service provider. It isn’t necessary to type 

the hyphens, but it makes the number easier to read, and SITcomm ignores 

them. 

The Address Editor should now look like the following illustration: 

Address Editor 

Name: 

Phone: 
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Connecting to the BBS 
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6. Click the Tools icon in the left side of the dialog box. 

Address Editor 

2400-N-8-1 
Connection... 

omy 
Terminal... 

& © H/¥MODEM 
File Transfer... 

You see the current settings for the connection, terminal emulation, and 

file transfer. 

All of these settings are correct for dialing the PMUG BBS. 

General 

Note: If you have a high-speed modem, the PMUG BBS supports baud rates 

up to 9600. Click the Connection icon to change the baud rate. For more 

information on how to do this, see “Close-up: Connection Settings” on page 

71. 

7. Click Save to save your new BBS entry and return to the 

Address Book. 

Now, any time you want to dial this BBS, you don’t have to re-enter the phone 

number and other settings. SITcomm automatically keeps it for you in the 

Address Book for simple, easy connecting. 

M@ Instead of using the Address Book, you can specify the appropriate 

settings by choosing “Connection,” “Terminal,” and/or “File Transfer” 

from the Session menu. Then choose “Quick Dial” (Command-D) from the 

Session menu to supply a phone number and initiate the connection. 

Now that you have an Address Book entry for the BBS, you are ready to dial. 

Note: Many of the following steps are specific to the PMUG BBS. When you 

connect to another BBS, the prompts and responses will vary. 

1. With “PMUG BBS” selected in the Address Book, click 

Connect. 

SITcomm dials the modem and displays a modem status box to indicate 

the connection progress. Once connected, the Terminal Window displays 

all incoming text from the BBS. 



Registering for the BBS 

Note: You can break the connection at any time and hang up the modem by 

clicking “Disconnect” in the Toolbar. 

2. You hear “Connection Established” when your modem has 

connected to the BBS. 

Note: If you would like to save all the information about this session for later 

review, Click the “Turn On Capturing” button in the Toolbar. 

3. Press the Escape (esc) Key twice to activate the BBS. 

This takes about 30 seconds, then a message appears about loading the 

BBS. 

The next few prompts are questions you'll need to answer to register for 

the BBS. 

A BBS is maintained by a system operator, or sysop for short, who regularly 

updates information and checks the BBS for new users. Most bulletin board 

systems require first-time callers to answer a few questions, including a voice 

phone number, so the sysop can call and verify you are who you say you are. 

This not only protects the BBS from the electronic equivalent of vandals, but 

ensures the integrity of the BBS. 

1. Type your first and last name, and press Return. 

If you inadvertently mistype your name, you can correct it by typing “n” for 

No at the next prompt. Otherwise, type “y” for Yes. 

2. Type “n” for No when the questions about ANSI graphics 

and hot-keyed menus appear. 

These questions are for callers who are using IBM-compatible machines. 

3. Press Return when asked about lines for your display. 

This sets the default value of 24 lines per screen. 

4. Type “n” for No if you don’t want the BBS to pause after 

each screen page (24 lines), and press Return. 

Otherwise, type “y” for Yes, and press Return. 

5. Type “n” for No about screen clearing codes, and press 

Return. 

Again, this question is for IBM-compatible machines. 
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6. Type the city and state you are calling from, and press 

Return. 

7. Type your phone number, including area code, and press 

Return. 

If you inadvertently mistype your number, you can correct it by typing “n” 

for No at the next prompt, and press Return. Otherwise, type “y” for Yes. 

8. Type your business phone number, including area code, and 

press Return. 

If you inadvertently mistype the number, you can correct it by typing “n” 

for No at the next prompt, and press Return. Otherwise, type “y” for Yes. 

9. Type your birth date, using the format DD-MM-YY, and 

press Return. 

10.Type a password, press Return, and type it again when 

prompted. 

11.If all information is correct, type “y” for Yes, and press 

Return. 

The following illustration shows part of a first-time registration sequence: 

$iTcomm « Connection Open 

RemoteAccess 1.11/Professional 
Please type your full name: Aladdin Systems 

Scanning user-file ... 

Your name was not located in the system user file. 

Name entered: Aladdin Systems 

Did you enter your name correctly [Y/n]? Yes 

Would you like ANSI colour and graphics [VY/n]? No 

Would you like hot-keyed menus [Y/n]? No 

How many lines does your display have ©18-66, 24 recommended >: 24 

Would you like to pause after each screen page [Y/n]? N 

Do you want screen clearing codes to be sent [Y/n]? N 

Where are you calling from ‘city/state?: Watsonville, CA 

Please enter your home/voice phone number [use format: xxx—-xxKx—-xKxxx] 
Number : 408-76 1-6200 

Number entered: 408-76 1-6200 

Is this correct [Y/nl? ¥ 

Please enter your business/data phone number [use format: xxx-xxx-xxxx] 
Number : 408-76 1-6200 

Number entered: 408-76 1-6200 Bue 
Is this correct [Y/n]l? ¥ 

ene re ee a ee 

12.Press Return when prompted. 
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Downloading a File 

Several informational screens about the BBS appear. If you said Yes to 

pause after each screen of information, press Return to continue to the 

next screen. 

13.Type “n” for No when asked about checking your mailbox, 

and press Return. 

Since this is the first time you’ve been on the BBS, there won’t be any mail 

for you! 

14.Press Return after reading each screen until the Main 

Menu appears. 

Nain Menu 

Welcome to PNUG BBS! 

You have the following options: 

[Nlessage areas 
Flille areas 
[C]hange your current settings 

[L]ook at Your Statistics 
[Slystem Statistics 
[YJell for SysOp 
[Glood-bye (log off) 
[Fleedback to SysO0p 

Now you are going to receive (or download) a file from the BBS. This file, 

called PMUG.TXT, contains information about the Portland Macintosh Users 

Group. 

1. Type “i” for Files, and press Return. 

The Files Section menu appears. 

The FILES Section 

File Area *#1,,.FILELSTS:File Lists 

[Slcan Directory (list of files) 
[Nlew Files in all areas 

since last time online 

[Dlownload file from this area 

[Plortland Macintosh Users Group 

download club information 

[AJI1 Files-download list of all files online 

[C]hange file area 
[L]ast menu 

[Nlain Nenu 

[GJood-bye 
[F Jeedback 

2. Type “P” for the Macintosh user group information file, 

and press Return. 
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Using the Online Editor 
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3. Type “X” for XMODEM at the Protocol prompt, then press 

Return. 

The name of the file, PMUG.TXT, and its size (approximately 17750 bytes) 

appears. 

PMUG.TXT 17750 bytes 

(S)tart transfer, (Ljogoff after transfer, (A)bort: s 

4. Type “s” for Start transfer, and press Return. 

5. Click RECV in the Toolbar to activate the download 

process. 

As the BBS downloads the file to your Macintosh, a progress bar displays 

its status. 

§iTcomm <<H/¥MODEM>> 

Receiving: KModem Temp File 

Status: Receiving Data 

Method: HMODEM MacBinary 

._~a AAAS EE EE SE SE 

» v¥.1.1.©1993 Aladdin Systems, Inc. 

6. Type a name for the file, if prompted, after the transfer is 

complete, and press Return. 

You should be back at the Files Section menu. 

Now that you have successfully logged onto and downloaded a file from the 

PMUG BBS, let’s leave a message for the sysop. If you have enjoyed your brief 

exposure to the PMUG BBS, and would like to be called by the sysop so you 

can be verified, use the online editor to write the message. 

1. Type “F” for Feedback, and press Return. 

These messages are automatically sent to the sysop. 

2. Type “SITcomm user” in the Subject field, and press 

Return. 

3. Type “N” for No at the next two prompts, pressing Return 

after each. 

4. Type your message. 



You don’t have to worry about pressing Return at the end of each line. The 

online editor wraps to the next line automatically. 

The following illustration shows a typical message. 

Note: If you called the PMUG BBS just to test SITcomm, and don’t think you’ll 

call again, please let the sysop know. That will save the sysop a needless long- 

distance phone call to verify you. 

$iTcomm ¢ Connection Open 

[Cihange file area 

[Llast Menu 

[Mlain Menu 
[G lood-bye 
[F Jeedback 

f 

Posting message in Local area "Feedback to Sysop". 

From : Aladdin Systems 
To : Karen Hal 
Subject: SITcomm user 
Change anything [y/N1]1? n 
Upload a prepared message [y/N1]1? n 

Begin your message now. Words are wrapped automatically, blank line to end. 
Maximum of 66 lines, 7@ characters per line 

: I just bought SITcomm, and I’m using the tutorial to figure out 
: exactly what it does. I would like to call your board again, so the 
: best time to call and verify me is in the evening, after 6 pm (East 
: cost time>. Thanks! 

Functions available: [5 lines in text] 
[D0] Delete, [E] Edit line, [RF] Replace, [I] Insert, [H] Help, 
[C] Continue, [L] List text, [S] Save, [Q] Quit 

Select:S 

Ci) ere Sa Ne 

5. When you have finished your message, press Return twice. 

This exits the online editor. 

6. Type “s” to send your message to the sysop. 

Your message is saved to disk, and you return to the Files Section menu. 

Logging Off and Quitting Now that you are finished with this session, you are ready to log off from the 

service and disconnect your modem. 

1. Type “g” for Good-bye, and press Return. 

The BBS gives you another chance to change your mind about logging off. 

2. Type “g” again, and press Return. 

You will hear “Connection closed” when SITcomm logs you off of the 

system and the modem disconnects. Notice that “Disconnect” becomes 

“Connect” in the SITcomm Toolbar. 
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Where To Go From Here 
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Note: If the remote system does not automatically end the phone call for you, 

you may need to click “Disconnect” in the Toolbar. 

The timer in the lower left corner of the Terminal Window shows you the 

total amount of time you just spent online. 

3. If you are finished working in SITcomm for the time being, 

quit the application by choosing “Quit” from the File menu. 

Now that you've successfully completed the tutorial and learned the basics 

about SITcomm, you can read through the next chapter, “Beyond the Basics,” 

to learn more about SITcomm. Or, work with SITcomm on your own, using the 

rest of the manual for reference as you need it. 



Getting Ready to 
Connect 

Chapter 4. Beyond the 
Basics 

This chapter covers what you can do with SITcomm. You'll learn how to 

connect and disconnect and how to accomplish tasks while online. After 

working through the examples in this chapter, you will know how to use all of 

the main features of SITcomm. 

Before you can connect to another computer and conduct a communications 

session, you must do two things: supply the phone number to dial and specify 

certain settings to use during the session. 

The settings you need to specify are: 

e Connection: Settings for your modem (including phone number) and the 

port through which your modem is connected. Required for all 

communications sessions. 

e Terminal Emulation: Settings for getting your Macintosh to emulate a 

dumb terminal. Required only if you plan to connect to a mainframe or 

other computer that expects you to be using a specific kind of terminal and 

keyboard. 

e File Transfer: Settings for the protocol you want to use during file 

transfers. Required only if you plan to send or receive data during a session. 

SITcomm gives you three different ways to specify any of these settings: 

e Choose the appropriate command (“Connect,” “Terminal,” “File Transfer”) 

from the Session menu. 

e Click the corresponding button in the Toolbar. 

e Use the Address Book. 

The easiest way to set all settings at once is to use the Address Book, which 

is described next. For information on changing settings using one of the 

other methods, see See “Specifying Settings” on page 42. 
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Using the Address Book 

Example: Setting Default 
Tool Settings 
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One of the most powerful features of SITcomm is the Address Book. It lets you 

automate and store all of your connections with other computers. You can 

save time because you don’t have to type the settings required to dial an 

online service, BBS, or remote computer every time you want to connect. 

Instead, you simply select an Address Book entry, and SITcomm does the rest. 

Each Address Book entry stores the phone number and appropriate settings 

(connection, terminal, and file transfer) for each system you call. Anytime 

you want to connect to one of the systems, open the Address Book and select 

the entry you want. 

Before you add your own entries, the SITcomm Address Book contains one 

entry: Default Tool Settings. (The Default Tool Settings entry name has a “@” 

prefix in the Address Book.) These are the preset settings for the 

connection, terminal emulation, and file transfer tools; SITcomm 

automatically uses these settings if no Address Book entry is in effect. You 

can change all of these settings at once by editing the Default Tool Settings 

Address Book entry. Changing the Default Tool Settings entry automatically 

changes the default tool settings in all entries. (See “Example: Setting 

Default Tool Settings” in the following section for more information. ) 

After you add your own Address Book entries, they appear in alphabetical 

order below the Default Tool Settings entry in the Address Book. 

Each Address Book entry has its own Notepad. This lets you store notes from 

different sessions and keep them organized by the system you dialed. 

The following examples give you detailed instructions for using the Address 

Book. 

Feature Explained: The Default Tool Settings entry in the Address Book. 

Related Topics: See the other examples in this section for instructions on 

adding a new entry, editing an entry, and deleting an entry. See “Connecting” 

on page 46 for information about using the Address Book to log on. 

Problem: You want to set up SITcomm so you can dial another computer or 

the local BBS. These settings will be those you use most often during your 

work with SITcomm. 

Solution: Use the Address Book to specify default settings. 

1. Click “Show Address Book” in the Toolbar, or select 

“Address Book” from the Session menu. 



The Address Book window opens. 

© Default Tool Settings 

Connection © 2400-N-8-1 

Service Terminal © TTY 

T = Automatically open connection Transfer > XMODEM 

2. Click “Default Tool Settings,” if it is not already selected. 

The current default settings appear in the lower part of the dialog box. 

Phone Connection “ 2400-N-8-1 

Serrice Terminal © TTY 

= Automatically open connection Transfer > MODEM 

3. Click Edit to change the settings. 

The Address Editor opens, where you can change the default connection, 

terminal emulation, or file transfer settings used by SITcomm. 

The following illustration shows the default settings for each tool. 

SSS Address Editor 

© 2400-N-8-1 
Connection... 

TTY 
Terminal... 

> HMODEM 
File Transfer... 

General 

4. Click Connection to change connection settings. 

The Connection settings dialog box appears. See “Example: Changing 

Connection, Terminal, and File Transfer Settings” on page 43 for details. 

5.Click Terminal to change terminal emulation settings. 

The Terminal settings dialog box appears. See “Example: Changing 

Connection, Terminal, and File Transfer Settings” on page 48 for details. 
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Example: Adding a New 
Address Book Entry 
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6. Click File Transfer to change the file transfer protocol. 

The File Transfer settings dialog box appears. See “Example: Changing 

Connection, Terminal, and File Transfer Settings” on page 48 for details. 

Note: To use the default settings for the Tools — Connection, Terminal, and 

File Transfer — press the Option key as you click the appropriate Tool 

button. To use the current session’s settings, press the Option and Shift key 

as you click the appropriate Tool button. 

7. Make the necessary changes, and click OK. 

8. Click Save when you are finished changing the settings. 

SITcomm stores the changes as the new default settings. Notice that the 

settings in the lower part of the dialog box now show your new settings. 

9. Click the Address Book’s close box to close the Address 

Book. 

Note: When you change Default Tool Settings, your changes are automatically 

reflected in other Address Book entries that use the default settings. For 

example, if you change modem speed to 9600 baud in the Default Tool 

Settings entry, modem speed is changed to 9600 baud in all other Address 

Book entries that use the default connection tool settings. 

Features Explained: Address Book, Address Editor, automatic Username 

and Password logon. 

Related Topics: See “Creating an Address Book Entry” in the Tutorial for 

information on how to set up a BBS Address Book entry. Also, see 

“Connecting,” beginning on page 46 for information about using the Address 

Book to log on. 

Problem: You want to add a new entry to the Address Book for your new 

account with the CompuServe online service. 

Solution: Use the Address Book to store your new account information. 

Note: This example uses the CompuServe online service, but the same steps 

apply for adding any online service or BBS entry to the Address Book. 

1. Open the Address Book by clicking “Show Address Book” in 

the Toolbar. 

2. In the Address Book, click New. 



You'll see the Address Editor, where you can enter the name and phone 

number of the new address. This is also where you can tell SITcomm to 

automatically supply your user name or ID and password. 

Address Editor 

General 

3. In the Name box, type “CompuServe.” 

4. Press Tab to move to the Phone box, and enter the local 

access number for the service. 

You can get this information from the manual or setup instructions that 

you get when you subscribe to CompuServe, or the online service or BBS 

you are using. 

5. Click in the Service pop-up menu to open it. 

You see a list of online services. 

“Manual Logon 

BBS: FirstClass 

BBS: Generic 

BBS: TBBS 

BBS: TeleFinder 

CompuServe 

Dow Jones 

GEnie 

MCI Mail 

QuickMail™ 

Unix: Generic 

Unix: Netcom 

Unix: The WELL 

Unix: The WELL (via CPN) 

Unix: World 

UMS: Generic 

You can manually log onto the service, which means you enter your user 

name or ID and password when prompted to do so by the service after 

dialing the access number. 

If you choose “Manual Logon,” the Username and Password areas of the 

dialog box remain unavailable; you must manually supply this information 

during logon. 
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If you choose a service in the Service pop-up menu, the Username and 

Password boxes are available for you to type in the logon information 

appropriate for the given service. (The names of these entry boxes vary by 

the service you select in the pop-up menu.) SITcomm then supplies this 

information automatically during logon. 

If you are connecting to a BBS, you should use Manual Logon first to 

determine what kind of logon information you need to supply. Then, you 

can edit the BBS Address Book entry to include automatic logon 

information. 

6. Choose “CompuServe” from the Service pop-up menu. 

7. In the “User ID” box, enter your CompuServe ID. 

8. In the “Password” box, enter your password. 

The text of your password appears in the Password box. The next time you 

open the Address Editor, bullet characters (¢) appear to mask your entry. 

This way, someone else can’t just open your Address Book and find out 

your password. 

Note: If you would rather not enter your password for security reasons, you 

can leave the Password box blank. You will then be prompted to enter your 

password when you log on. 

9. If you want to change any of the tool settings, click Tools in 

the left area of the dialog box. 

The dialog box looks just like the one you see if you select Default Tool 

Settings from the Address Book. For information on changing tool 

settings, see the “Example: Setting Default Tool Settings” earlier in this 

section. 

10.If you want to change any file transfer preferences for this 
Address Book entry only, click Transfers. 

These preferences affect the way a received file is expanded or checked 

for viruses. The preferences are only in effect for the current Address 

Book entry. (For information on the different file compression formats, 



see “Introduction to Compression” on page 18 and “Translating Files,” 

beginning on page 97.) 

Address Editor 

After Receiving Files: 

—X] Expand 

[x] Delete after Expanding 

] Expand Stuffit Archives 

—] Expand Compact Pro Archives 

(J Expand AppleLink Packages 

—x] Decode BinHex 

[X] Expand result 

(J Detect viruses with 

General 

Expand: This option expands any files automatically that have been 

previously compressed. It is selected by default, which makes more 

expansion options available. 

Delete after Expanding: This option deletes the compressed version of a 

received file after successfully expanding it. The default is on. 

Expand Stuffit Archives: This option expands StuffIt (.SIT) archives 

automatically after downloading them. The default is on. 

Expand Compact Pro Archives: This option expands Compact Pro (.CPT) 

archives automatically after downloading them. The default is on. 

Expand AppleLink Packages: This option expands AppleLink package 

(.PKG) archives automatically after downloading them. The default is on. 

Decode BinHex: This option decodes an encoded BinHex file (.HQX) 

automatically after downloading it. When this option is selected, the 

“Expand result” option is available. 

Expand result: This option expands a .HQX compressed file automatically 

after downloading and decoding it. 

Detect Viruses With: Select this option to have SITcomm automatically 

check received files for viruses. Clicking Select opens a standard Open 

dialog box for you to specify an anti-virus detection program to use. When 

activated, SITcomm uses Apple events to “talk to” the anti-virus program. 

The default is off. 

Note: Not all anti-virus programs support standard Apple events. Check with 

the anti-virus program manufacturer before selecting the virus option. 

11.If you want to change any general preferences for this 

Address Book entry only, click General. 
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These preferences affect the general nature of your connection, and are 

only in effect for the current Address Book entry. (For information on 

setting global preferences, see “Setting Preferences,” beginning on 

page 92.) 

Address Editor 

(] Automatically open connection 

(J Recognize DEC Printer Sequences 

Capture Data: 

@ from Terminal 

© from Connection 

] 8:3 control characters 

Automatically open connection: When this option is on, SITcomm 

automatically dials and connects to this Address Book entry when you 

select that entry from the Address Book pop-up menu in the Toolbar. The 

default is off. 

Recognize DEC Printer Sequences: DEC remote computer programs can 

send special commands to turn a local printer on and off. Select this 

option if you want SITcomm to watch for these commands during the 

current session. The default is off. 

Capture Data: 

from Terminal: This option instructs SITcomm to capture the text that is 

pushed off into the scrollback buffer. The default is on. 

from Connection: This option instructs SITcomm to capture all data as it 

comes into the serial port, including non-printable character sequences 

you’d never see on your screen. This is useful for debugging purposes. 

When you select the “from Connection” option, the “Strip control 

characters” option is available. 

Strip control characters: This option removes non-printable control 

characters from the captured file. 

12.When you are finished defining the settings for your new 

Address Book entry, click Save. 

The new entry appears listed in the Address Book. To use it for logging on, 

select it and click Connect. See “Connecting,” beginning on page 46 for more 

information. 
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Example: Editing an Entry 

Example: Deleting an Entry 

Features Explained: Address Book, Address Editor 

Related Topics: The Address Book options and settings are described 

earlier in “Example: Adding a New Address Book Entry.” 

Problem: You have an existing Address Book entry whose settings you need 

to change. For example, suppose the access number for an online service has 

changed. 

1. Open the Address Book by choosing “Address Book” from 

the Session menu. 

2. Double-click the entry you want to change, such as 

CompuServe. 

You see the Address Editor, where you can change any of the settings 

associated with the selected Address Book entry. This dialog box is 

identical to the one you see when you click New in the Address Book. 

3. Make the necessary changes to your Address Book entry. 

For example, to change the access number, click in the Phone box, delete 

the old number, and type the new phone number. 

To change any of the tool settings, click Tools in the left area of the dialog 

box. To change any file transfer preferences for the current entry, click 

Transfers. To change any general preferences for this entry, click General. 

4, When you are finished editing the Address Book entry, click 

Save. 

Features Explained: Address Book 

Problem: You have an Address Book entry that is old and you want to 

permanently remove it from the Address Book. 

1. Open the Address Book. 

2. Select the entry you want to remove, and click Delete. 

SITcomm verifies that you want to delete the selected entry. 

( Delete entry “Tutorial BBS” from 

the Address Book? 
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3. To permanently delete the entry, click OK. To cancel the 

operation, click Cancel. 

When you click OK, SITcomm removes the entry from the list in the Address 

Book, and leaves the Address Book open and active. 

Example: Duplicating an Features Explained: Address Book 

Entry Problem: You have an Address Book entry that contains settings that match 

a new BBS in everything but name and phone number. You don’t want to 

have to manually configure the new entry. 

1. Open the Address Book. 

2. Select the entry you want to duplicate, and hold down the 

Option Key. 

3. Notice the New button changes to Duplicate. Click 

Duplicate. 

A new Address Book entry appears with the word “copy” appended to the 

name, directly under the one you duplicated. Then the Address Editor 

appears. 

4. Type the name and phone number of the new BBS, and 

select a service, if necessary. 

5. Make any other changes, then click Save when you’re 

through. 

The name of the entry now appears in the Address Book. 

Specifying Settings This section describes how to set or change connection, terminal emulation, 
and file transfer settings. You can specify settings by choosing the 

appropriate command from the Session menu or by selecting the appropriate 

tool in the Toolbar. You can also specify settings via the Address Book. See 

“Using the Address Book” on page 34 for more information. 

Before specifying or changing any settings, make sure you have the 

information you need. You’ll need to know the phone number to dial, the 

correct modem settings for your modem, and the terminal settings and file 

transfer settings expected by the other computer. 
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Example: Changing 
Connection, Terminal, and 
File Transfer Settings 

Features Explained: “Connection,” “Terminal,” and “File Transfer” (Session 

menu). Connection, terminal, and file transfer buttons of the Toolbar. 

Settings area of the Address Book. 

Related Topics: See the close-ups in “Mastering Tool Settings” on page 71 in 

Chapter 5, for complete reference information on the options available in 

the Connection Settings, Terminal Settings, and File Transfer Settings dialog 

boxes. 

Problem: The connection, terminal, and/or file transfer settings are not 

correct for the current communications session. 

Note: Because the procedure for changing each of these types of settings is 

similar, the following steps apply generally to changing any setting. 

1. To set connection settings, choose “Connection” from the 

Session menu, or click the Connection button of the 

Toolbar. 

The Connection Settings dialog box opens. (For details on this dialog box’s 

options, see “Close-up: Connection Settings” on page 71 in Chapter 5.) 

This dialog box shows the connection settings you can specify with the 

Apple Modem Tool. 

Connection Settings 

Method: Apple Mode... w 

; When dialing :¢Port Settings 

|DialPhoneNumber[ NEED aud Rate: ‘EOC ows | 
| Dialing Method: | Parity:  [LNone +] 

DataBits: [_s v] 
fe hhen ans wer Mg mnie | StopBits: [1+] 

Answer phone after i 7 Handshake : 

| Error Correction: i 

Correction Type: i 

i Cc] Display Modem Monitor Window 

Printer Port 

2. If you want to connect via your modem, leave the Apple 

Modem Tool selected. If you want to connect directly to 

another computer, select the Serial Tool from the Method 

pop-up menu. 
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Switching to the Serial Tool changes the connection setting options 

available in the dialog box. This figure shows the connection settings you 

can specify with the Serial Tool. 

Connection Settings 

Method: Serial Tool v 

Port Settings Current Port 

Baud Rate: [ 9600 * ae 
(og? 

Data Bits: | “Modern Port Printer Port 

Stop Bits: Gba> 

Handshake : 
When Closing Document 

[EX] Hold Connection 

C Remind to Disconnect 

With the Serial Tool, the settings in the Connection Settings dialog box 

must match those of the other computer to which you want to connect. 

With the Apple Modem Tool, if you have a 2400-baud Hayes-compatible 

modem and it is connected to your Macintosh through the modem port, 

you probably don’t need to change the default connection settings. 

Because you are specifying connection settings, you shouldn’t supply the 

phone number to dial at this point. You can do that later. See “Example: 

Quick Dialing” on page 48 for more information on supplying the phone 

number. 

3. Change any connection settings as required by the other 

computer, and click OK. 

4. To change terminal emulation settings, choose “Terminal” 

from the Session menu, or click the Terminal button of the 

Toolbar. 

The Terminal Settings dialog box opens. (For details on this dialog box's 

options, see “Close-up: Terminal Emulation Settings” on page 77.) This 
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dialog box shows the default Terminal Settings, where TTY is the selected 

emulation tool. 

Terminal Settings 

Emulation: TTY Tool ¥ 

Text Cursor 

cg @® Block 

“" €) Undertine 

width: [80 Columns Scroll Text 

Characters 

CT] Show Control Characters 

C] Auto Wrap to Next Line 

Holding Down Keys ‘will i 

Ex] Auto Repeat Keys i CT] Swap ‘Backspace’ and ‘Delete’ 

I Repeat Control Keys C] New Line on a Return 

5. Click in the Emulation pop-up menu and select another 

terminal emulation tool. 

The options available in the Terminal Settings dialog box vary depending 

on which terminal emulation tool you select. If you select the VT102, the 

dialog box shows a different set of options for each setup icon — General, 

Screen, Keyboard, and Character Set. These options are described in 

detail in the “Close-up: Terminal Emulation Settings,” beginning on 

page 77. 

6. Change any terminal settings as required by the other 

computer, and click OK. 

7. To change file transfer settings, choose “File Transfer” 

from the Session menu, or click the File Transfer button of 

the Toolbar. 

The File Transfer Settings dialog box opens. (For details on this dialog 

box’s options and for information on file transfer protocols, see “Close-up: 

File Transfer Settings,” beginning on page 84 in Chapter 5.) This dialog 

box shows the default File Transfer settings, where X/YMODEM is the 
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Connecting 

Connecting to an Online 
Service or BBS 

Example: Using the Address 
Book to Logon 
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selected file transfer tool. The options available in the File Transfer 

Settings dialog box vary depending on which file transfer tool you select. 

File Transfer Settings 
Protocol: Aladdin H/¥M...¥ 

Transfer As: Timeout Seconds 

Name Change: : 

Document Type: : [_] Enable Auto Receive 

Creator: & [EX] Use 1K Packets 

Type: Cc] Use YMODEM-g 

(eet Doounent Topacl C Start as XMODEM 

ix] Show Error Messages 

rey Default Settings 

8. Click in the Protocol pop-up menu and select another file 

transfer tool. 

9. Change any file transfer settings as required by the other 

computer, and click OK. 

Connecting involves dialing the phone number of the other computer, online 

service, or BBS to which you want to connect, and then supplying your 

username or ID and a password. If you are directly connecting two computers 

together, turn to the “Directly Connecting to Another Computer” section 

later in this chapter. 

SITcomm gives you three ways to connect to an online service or BBS. You 

can: 

e Use the Address Book. 

e Click the Connect button in the Toolbar. 

e Choose “Quick Dial” from the Session menu, or press Command-D. 

Using the Address Book is the easiest, most efficient way to connect. Read 

the next example to find out how to do it. 

Features Explained: Address Book, automatic Username and Password 

logon. 

Related Topics: See “Using the Address Book” on page 34 for complete 

information on adding, editing, and deleting Address Book entries, and a 

description of the Address Book options. For information on commercial 

online services, see “Appendix A. Overview of Online Services,” beginning on 

page 1238. 



Problem: You want to use the Address Book to log onto CompuServe. (This 

example also applies to using the Address Book for connecting to any 

commercial online service or BBS.) 

1. Open the Address Book. 

Address Book 

© Default Tool Settings fay 
CompuServe 

Tutorial BBS 

B 
Phone 15032311072 Connection © 2400-N-8-1 

Service CompuServe Terminal a i Me 

= Automatically open connection Transfer %/YMODEM 

2. Click once to select the entry you want to use (such as 

CompuServe ), and click Connect. 

CompuServe (or the entry you selected) becomes the current Address 

Book entry, indicated in the Toolbar. 

SITcomm dials the phone number stored in the Address Book entry and 

displays a status box, which indicates the progress of the connection. 

Modem Status 

Rea Initializing modem... 

If your Address Book entry is set for Manual Logon, CompuServe (or other 

service or BBS) prompts you to enter your username or ID and your 

password. If the entry is set for automatic logon, SITcomm automatically 

supplies either the username or the password or both, depending on the 

settings. 

After the service verifies your logon information, you’ll see an introductory 

screen or welcome notice. This lets you know the connection was 

successfully established. 

Once you are connected, use the appropriate commands to find the 

information or accomplish the specific tasks you want. For example, if you 

want to send electronic mail to Aladdin on CompuServe, our CompuServe ID 

is 75300,1666. 

For information on other Aladdin electronic mail addresses, see Appendix A. 

For information on transferring files while online, see “Transferring Data,” 

beginning on page 54. 
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Alternate Method m@ Ifthe name of the Address Book entry to which you want to connect 
appears in the Toolbar, click Connect. SITcomm automatically initiates 

the connection with a single click of the mouse. 

Example: Quick Dialing Feature Explained: Quick Dial 

1. Choose “Quick Dial” from the Session menu. 

The Quick Dial dialog box opens. 

Quick Dial 

2. Type the phone number to dial. 

You can use or omit hyphens in the phone number. If you want dialing to 

pause after dialing an access number (such as 9), type a comma. One 

comma is equivalent to a two-second delay. 

3. Click Dial. 

SITcomm dials the phone number. If there is no Address Book entry in effect, 

SITcomm uses the current tool settings to connect. 

Directly Connecting to In addition to logging onto an online service or BBS, SITcomm gives you two 
Another Computer ways to directly connect to another computer: local or remote. Either type of 

direct connection lets you interact between systems in real time. 

First, you can do a local, direct connection between two computers that are 

in the same room. For this type of session, you don’t use a modem; rather, 

you use a special cable that is connected directly to the serial or modem port 

of each computer. The cable must be a nwll modem cable. You connect one 

end of the cable to the modem port of one computer and the other end to the 

modem port of the second computer. Then, you must use the identical 

connection, terminal emulation, and file transfer settings on both 

computers. 

Second, you can do a remote, direct connect in which you set your Macintosh 

to wait for a call from another, remote computer. For this type of session, you 

must use a modem. The other computer calls your computer by dialing the 

phone number of the telephone line connected to your modem. Then, you 

can transfer data from the remote computer. (See “Transferring Data,” 

beginning on page 54 for more information on downloading files and data.) 
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Example: Directly 
Connecting Two Computers 
in the Same Room 

Features Explained: “Connect” command in the Session menu, Serial Tool, 

TTY Tool. 

Related Topic: See “Mastering Tool Settings” on page 71 in Chapter 5 for 

details on the options available in the Connection Settings and Terminal 

Settings dialog boxes. 

Problem: You have a desktop Macintosh, which is your main computer at 

home or at the office, and a PowerBook, which you use when you are away 

from your main computer. You want to be able to transfer files between your 

PowerBook and your main Macintosh. 

Solution: Using a special, null-modem serial cable, directly connect both 

computers to one another via their modem ports. Then use SITcomm on both 

machines to allow them to communicate. 

Note: The steps that follow assume that both computers are using SITcomm 

to conduct the session. If one of your computers uses a different 

communications application, you can use the settings described here as a 

guide for how to set up the other communications program. In either case, 

both computers’ settings must match each other. 

1. Connect a null modem cable to both computers via their 

modem ports. 

Because you don’t use a modem for direct connections, it is best to 

connect the cable to both modem ports. This is because the modem port 

is better at preventing interference during connections than the printer 

port is. 

2. Launch SITcomm on both computers. 

3. On the desktop Macintosh, click the Connection button in 

the Toolbar to open the Connection Settings dialog box. 
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4. Choose the Serial Tool from the Method pop-up menu, and 

click OK. 

Connection Settings 

Method: Serial Tool v 

Port Settings : Current Port 

Baud Rate: 

Parity : [None > ]} 

Data Bits: 

Stop Bits: [i +] 

Handshake : 
When Closing Document 

EX] Hold Connection 

C] Remind to Disconnect 

5. Repeat steps 3 and 4 on the PowerBook to specify the same 

connection settings. 

Now you must specify certain terminal emulation settings on both 

computers. 

6. On the desktop Macintosh, click the Terminal button in the 

Toolbar to open the Terminal Settings dialog box. 

7. Choose the TTY Tool from the Emulation pop-up menu. 

For information on the TTY Tool options, see “Close-up: Terminal 

Emulation Settings” on page 77 in Chapter 5. 

8. Click Local Echo, Auto Wrap to Next Line, and New Line on 

a Return to turn on these options. Click Auto Repeat Keys 

to turn that option off, then click OK. 

With Local Echo turned on, you can see the characters as you type them 

on the computer; that is, they echo on your screen. (You can also turn local 

echo on by choosing the “Turn On Local Echo” command from the Session 

menu.) Auto Wrap to Next Line makes it easier for you to read the text 

appearing on screen; without auto wrapping turned on, the text appears 

as one long line, and characters are lost past the end of the line. The New 

Line on a Return setting tells SITcomm to start a new line for text when 

you press Return. By turning off Auto Repeat Keys, non-control characters 

do not automatically repeat when you hold them down. This is a safer 

setting during direct connection, because it gives you more control over 

how the keyboard reacts to your keypresses. 
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The settings in the dialog box should look like this: 

Terminal Settings 

Text Cursor 

Ra oe Block 
“IE: © 

i?) Underline 

width: [80 Columns _¥ Scroll Text 

ze: [Spent >] Gump © smooth 
Characters 

e Show Control Characters : : 
‘ i iThis is a sample of T: 

x] Auto Wrap to Next Line i ITY text. ; 

: This is a sample of T: 
Holding Down Keys Will i ; 3 

C] Auto Repeat Keys CJ Swap ‘Backspace’ and ‘Delete’ 

Cc Repeat Control Keys & New Line on a Return 

9. Repeat steps 6, 7, and 8 on the PowerBook to specify the 

same terminal settings. 

With your connection and terminal settings specified for both computers, 

you are ready to connect. 

10.To initiate the connection between your two computers, on 

either computer, click “Connect” in the Toolbar. On the 

other computer, click “Connect” in the Toolbar. 

You can also choose “Connect” from the Session menu. 

The “Connect” command and button change to “Disconnect.” 

When the two computers are connected, type some text on the PowerBook. 

The text echoes in the Terminal Window on both computers. 

At this point, you can continue to type text on either computer to 

communicate between them, or you can transfer files from one computer to 

the other. (See “Transferring Data” later in this chapter for information on 

sending and receiving files. ) 

When you are ready to disconnect, click “Disconnect” in the Toolbar on both 

computers to disconnect them. 

Note: If you establish direct connections often, you can save the connection 

and terminal settings as an Address Book entry. 
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Example: Listening for a Cal] Features Explained: “Listen for Connection” command in the Session menu, 
Apple Modem Tool 

Related Topic: See “Close-up: Connection Settings” on page 71 in Chapter 5, 

for details on the Apple Modem Tool options. 

Problem: You want to set up your Macintosh so a friend of yours can send a 

file directly from her computer to yours via modem. 

Solution: Use the “Listen forConnection” command to set up your modem to 

wait for an incoming call. When the call comes in and your modem answers 

it, you are then remotely, versus locally, connected to the other computer. 

1. Make sure your modem is connected properly and the 

power is on. 

2. Click the Connection button in the Toolbar to open the 

Connection Settings dialog box. 

If the Apple Modem Tool is not the current connection tool, choose “Apple 

Modem Tool” from the Method pop-up menu. 

If you want to change the number of rings after which SITcomm answers 

the phone, type the number of rings you want before your modem answers. 

Note: If you expect to receive a file after a call comes in, select the Enable 

Auto Receive option of either the Aladdin X/YMODEM Tool or the Aladdin 

ZMODEM Tool in the File Transfer settings dialog box. 

3. Click OK in the dialog box. 

4. To put your computer on standby (that is, so your computer 

is waiting for an incoming call), choose “Listen for 

Connection” from the Session menu. 

The Modem Status box shows that SITcomm is initializing your modem. 

When SITcomm is ready to accept an incoming call, the Modem Status box 

displays the “Waiting for an incoming call...” message. To stop waiting for an 

incoming call, click Cancel in the Modem Status box. 

When your friend calls your computer, you hear the modem ring, and it 

answers after the number of rings you specified. Whatever you type appears 

on your friend’s screen, and whatever your friend types on her computer 

appears in your Terminal Window. You can also send or receive files. (See 

“Transferring Data” later in this chapter for instructions on how to receive 

and send files.) 
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When you are ready to break the connection with the remote computer, click 

“Disconnect” in the Toolbar, or choose “Disconnect” from the Session menu. 

Alternate Method m You can set your computer to listen for an incoming call by typing “listen” 

instead of a phone number in the Phone field of the Address Book. 

Disconnecting Disconnecting, or logging off, is essentially a two-step process: first, tell the 

other computer you want to disconnect, and then tell the modem. 

To disconnect: 

1. Issue the appropriate command to tell the other computer 

that you want to log off. 

Usually, the command is something like bye, off, exit, logoff, or quit. (Refer 

to your online service, network manual, or other service guide for the 

specific command. ) 

2. Click “Disconnect” in the Toolbar, or choose “Disconnect” 

(Command-K) from the Session menu. 

This hangs up the phone and resets your modem. Sometimes this step is 

unnecessary as SITcomm detects the hangup and closes the connection 

for you. 

After disconnecting, the timer in the lower left corner of the Terminal 

Window displays your total online time. 

roa:03:39 [SL 

Working Online While you are online and connected to another computer you can do a 

, number of things, including: 

e Transfer files between your Macintosh and another computer. 

e Capture incoming text to a file. 

e Send incoming text to the printer. 

e Use the Notepad for keeping notes to yourself. 

e Type outgoing text in the Buffered Keyboard. 

e Pause the connection. 

e Save selected text or append selected text to a file. 

The examples in this section give you step-by-step instructions for doing 

each of these tasks. 
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Transferring Data When you transfer data you either send (wpload) a file to another computer 
or receive (download) a file from the other computer. The most efficient way 

to transfer files is to compress them before sending them. This saves online 

time during the file transfer and reduces the amount of space the file 

occupies on disk. 

This section includes three examples. The first one explains how to 

compress data in preparation for sending it. The second example describes 

how to upload the compressed data. The final example explains how to 

receive a compressed file and discusses the differences between auto- 

expansion and manual expansion. 

Example: Stuffing Data Feature Explained: “Stuff? command (File menu) 

Related Topics: If you are new to file compression, read “Introduction to 

Compression” on page 18. For information on the Stuffing Preferences, see 

“Setting Preferences,” beginning on page 92 in Chapter 5. See “Translating 

Files,” beginning on page 97 for information on compressing data to other 

file formats, such as .ZIP files. 

Problem: You want to upload a series of related files to a colleague. You want 

to be able to send all of the files at once in one file. You also want to 

compress the resulting file because it will save you connect time. 

Furthermore, you don’t know if the colleague has StuffIt to expand the file 

once it’s received. 

Solution: Use the “Stuff” command from the File menu to combine and 

compress the files into a StuffIt self-extracting archive. 

1. Choose “Stuff’ (Command-S) from the File menu. 

The Stuff dialog box appears. A directory on the left side contains a list of 

files and folders from which to select. 

©) Aladdin Sys ¥ Items to Stuff: 

CQ Work, part 1 

OQ Work, part 2 

C] Delete item when finished C] Encrypt with password 

re! 
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2. One at a time, click on the files or folders you want to 

include in the Stuffit archive, and click Add to add them to 

the list of “Items to Stuff.” 

If you want to delete a file or folder after it has been stuffed, check the 

“Delete item when finished” option before adding the items to the “Items 

to Stuff” list. 

On the right side of the dialog box, you see the list of items to include in 

the Stufflt archive. 

Items to Stuff: 

D art 

OC Work, part 1 
C) Work, part 2 

L] Encrypt with password 

Stuff 38S 

. If you want to secure your archive by scrambling its 

contents with a specific password, check the “Encrypt with 

password” option. 

The status of the “Encrypt with password” option depends on the status of 

the Encryption checkbox in the Stuffing setting of the global preferences 

dialog box. The default global preference setting is off. 

Click Stuff to create the archive. 

A dialog box appears for you to name and save the archive. The default 

name is “Archive.sit,” where “.sit” refers to “stuff-it.” When the “Self- 

Extracting” option is checked in the Stuffing Settings of the global 

preferences dialog box (Edit menu), SITcomm automatically creates a 

self-extracting archive. Or you can check the “Self-Extracting” option in 
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this dialog box. (For information on self-extracting archives, see 

“Introduction to Compression” on page 18 or the “Glossary” on page 145.) 

©) Aladdin Sys ¥ <> Hard Disk 

D art 

i} Hiork. part § 

i} fork, par? 2 

Create New Archive as: 

_] Self-Extracting 

5. Name the archive, if you don’t want to use the default name, 

and locate the folder or disk where you want it saved. Click 

Save. 

If you did not check “Encrypt with password” in step 3, SITcomm creates 

the StuffIt archive and saves it to disk. You are finished stuffing the data, 

and ready to send it. 

If you checked “Encrypt with password” in step 3, a dialog box appears 

asking you to enter a password. 

Enter a password: 

a aaa 
Ci) 

6. Type a password, and click OK. 

Anything that can be typed from your keyboard is acceptable in the 

password, including international characters. If you can’t think of a 

password, click Generate Random to have SITcomm create one for you. 

You will be asked to re-enter the password to confirm it. After doing so, 

SITcomm creates the encrypted, self-extracting StuffIt archive. 

WARNING: If you forget an archive’s password, there is no way to recover the 

information or to modify the secured contents of the archive. Aladdin 

Systems has no way of decrypting archives. Be sure to remember your 

password or write it down and put it in a safe place. 

You are now ready to send the file to your colleague. Read the next example 

to learn how to do this. 



Example: Sending a Stuffit 
Archive 

Features Explained: “Send File” command (File menu), SEND button in the 

Toolbar 

Related Topics: For information on file transfer settings, see “Close-up: File 

Transfer Settings” on page 84 in Chapter 5. 

Problem: You want to send a Stuffit archive over the modem to another 

computer. 

Solution: Sending a Stufflt archive is no different than sending another type 

of file online. When online, you use the “Send File” command to select the 

file you want to send and instruct SITcomm to upload it. 

1. Follow the steps in “Connecting,” beginning on page 46 to 

initiate the connection. 

2. Let the other computer know that you want to upload a file. 

This varies from computer to computer. If the other computer is running 

SITcomm, it should be ready to receive your file by clicking the RECV 

button. 

3. When the other computer prompts you to begin sending the 

file, click the SEND button in the Toolbar. 

l+ |) l+ 
SEND fj REC 

You can also choose “Send File” from the Session menu. The Send File 

dialog box opens for you to select the file you want to upload. 

Aladdin $.¥ Items to Send: 

<> Hard Disk 

Desktop 

[] Stuff files before sending 

Send #5 

4. Select the StuffIt archive you want to send. Click Send. 
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Example: Downloading a 
Stuffit Archive 
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The SITcomm transfer progress box appears on the screen, indicating the 

progress of the upload. 

SSS Flicomm <<2MO0DEM>> SSS 

Sending: Final chapters .sea 

Status: Sending Data 

Method: Z2MODEM MacBinary 

vy v¥.1.0,©1993 Aladdin Systems, Inc. 

Note: You can also stuff files as part of the upload process by selecting the 

“Stuff files before sending” checkbox in the Send File dialog box. Stuffing the 

files before going online saves connect time and expense. (Do not select this 

checkbox if the files you are sending are already compressed. ) 

If you want to get more detailed information about the transfer, such as 

the elapsed time or the number of bytes transferred, you can expand the 

progress box by clicking the triangle in the bottom left corner. 

When the file transfer is complete, the progress box disappears. 

5. Issue the commands required by the other computer to 

identify the recipient of the file (or address the file) and to 

complete the upload process. 

On some online services or networks, you may have to address the file 

before sending it. 

6. When the upload is complete, log off the other computer, 

and click the “Disconnect” button in the Toolbar to 

disconnect. 

Note: Depending on the type of file you are sending and the file transfer 

protocols supported by the other computer, you may need to change file 

transfer settings for the upload. If you do, you can click the File Transfer 

button in the Toolbar to access the File Transfer Settings dialog box. See 

“Specifying Settings” on page 42 for more information. 

Features Explained: “Receive File” command (File menu), RECV button in 

the Toolbar, “Select Receive Folder” command (File menu), file transfer 

preferences in the Address Book, “Expand” command (File menu). 

Related Topics: For reference information on the file transfer settings, see 

“Close-up: File Transfer Settings” on page 84 in Chapter 5. For more 

information about the Address Book, see “Using the Address Book” earlier in 

this chapter. 



Problem: You want to download a StuffIt archive from a local BBS. 

Solution: When online, you use the “Receive File” command to download a 

selected file from the BBS. 

1. To change the folder set for receiving incoming data and 

files, choose “Select Receive Folder” from the File menu. 

2. Locate the destination folder (or click New Folder to 

create a new one), and click “Save into [folder name].” 

Select Destination Folder: 

©] Hard Disk ¥ <— Hard Disk 

C1 Aladdin Sys 

© AppleLink 

O Comm 

2881K free on this disk. 

Save into “Aladdin Sys” 

SITcomm saves all received files to disk in the folder you selected. 

3. To download a Stuffit archive, log onto the computer to 

which you want to connect. 

4. Locate the file you want to download and tell the other 

computer that you want to download it. 

This varies from computer to computer. If the other computer is running 

SITcomm, it should be ready to send the file by clicking the Send button. 

5. When the other computer prompts you to begin receiving 

the file, choose “Receive File” from the Session menu, or 

click the RECV button in the Toolbar. 

[E|+ || El+ 
SEND f] RECY 

A progress box appears indicating the progress of the download. This 

progress box is similar to the one you see during an upload. 
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Capturing Data 

Example: Capturing Text 
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When the file transfer is complete, the progress box disappears, and the 

StuffIt archive is stored on disk in the Receive folder you specified earlier. 

Note: If you want to receive a file automatically, select the Enable Auto 

Receive option of either the Aladdin X/YMODEM Tool or the Aladdin 

ZMODEM Tool in the File Transfer settings dialog box. 

6. When the download is complete, log off the other computer, 

and click the “Disconnect” button in the Toolbar to 

disconnect. 

If you have the “Expand StuffIt Archive” option selected in the file transfer 

preferences, SITcomm automatically expands all downloaded archives after 

you disconnect from the online service. If the “Delete after Expanding” 

option is checked, SITcomm also automatically deletes the archive file, 

leaving the expanded file(s) on disk. 

If you did not select any auto-expansion preferences, you can “manually” 

expand a compressed file (such as a StuffIt archive). To do so, choose 

“Expand” from the File menu, select the file to expand in the dialog box, and 

click Open. A status box indicates the expansion progress. 

The auto-expansion preferences also apply to Compact Pro archives, 

AppleLink packages, and encoded BinHex files. To manually expand or 

decode other types of compressed files, use the Translate menu commands. 

See “Translating Files,” beginning on page 97 in Chapter 5 for details. 

SITcomm lets you save all the information you see on your screen (including 

what you type) during a telecommunications session. This process of saving 

incoming data is called data capture. Capturing data is as simple as turning 

Capture mode on or off. In SITcomm, you control data capture with the “Turn 

On Capturing” button in the Toolbar or with the “Turn On Capturing” 

command from the Session menu. You can also set the receiving folder and 

specify the creator for the captured file. 

When you no longer want incoming data captured to the file, turn capturing 

off. If you forget to turn capturing off, SITcomm automatically turns it off and 

closes the capture file when you quit the application, or switch addresses. 

Features Explained: “Turn On Capturing” command (Session menu), “Turn 

On Capturing” button in the Toolbar, “Select Receive Folder” command (File 

menu), “Capture File Creator” preference in the General Settings area of the 

Preferences dialog box (Edit menu). 

Related Topics: The “Select Receive Folder” command is also described in 

the “Example: Downloading a StuffIt Archive” earlier in this chapter. For 



more information on the preferences, see “Setting Preferences,” beginning 

on page 92. 

Problem: You want to be able to save everything you see in the Terminal 

Window to a disk file so you can later review the data. 

Solution: Turn on capturing. 

1. Set the folder into which the captured file should be saved 

by choosing “Select Receive Folder” from the File menu. 

Locate the folder you want to use, and click “Save into 

[folder name ].” 

If you have never set a receiving folder, SITcomm saves the capture file in 

the SITcomm folder. 

Note: You can specify a receiving folder “on the fly” by holding down the 

Option key and clicking “Turn On Capturing” in the Toolbar. A standard file 

dialog box then appears. 

2. To specify a creator for the captured file, choose 

“Preferences” from the Edit menu. 

3. In the General Settings area of the dialog box, click in the 

Capture File Creator pop-up menu, and choose an 

application. When you are finished, click OK to close the 

Preferences dialog box. 

BBEdit 

MacWrite 

MacWrite II 

Microsoft Word 

Nisus 

TeachTexut 

WordPerfect 

WriteNow 

Whichever application you choose is the application that can directly open 

and read the captured file. For example, if you choose Nisus, double- 

clicking the capture file icon in the Finder opens the Nisus application 

and displays the capture file. 

If the application you want to use is not listed, choose “Other,” and select 

the application from the directory dialog box. 

4. To begin capturing text, click “Turn On Capturing” in the 

Toolbar, or choose “Turn On Capturing” from the Session 

menu. 
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Printing Text 

Example: Printing Incoming 
Text 
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You can turn on data capture before connecting, during a session, or after 

disconnecting. 

Note: A capture file is specific for each session. For example, if you are 

capturing data from an Address Book entry called “Great Stuff,” the capture 

file is called Great Stuff 09/26/93 (the date is appended). The next time you 

capture data from Great Stuff, the new information is stored in another file 

called Great Stuff, but with the current date appended. 

Both the button in the Toolbar and the menu command change to “Turn 

Off Capturing.” 

5. To stop saving incoming data to the file, click “Turn Off 

Capturing” in the Toolbar or choose “Turn Off Capturing” 

in the Session menu. 

SITcomm lets you print text in three different ways. First, you can send all 

incoming text to the printer. This is useful if you need hardcopy of a session. 

Second, you can use the “Print” command (File menu) to print the entire 

contents of the Terminal Window or the Notepad. By printing the Terminal 

Window contents, you can keep regular hardcopy records of your sessions. 

The ability to print the contents of the Notepad lets you use it as a simple 

text editor. 

Third, you can print only a portion of the text in the Terminal Window or the 

Notepad. To do this, simply select the text you want to print, and choose 

“Print Selection” (Command-P) from the File menu. 

Features Explained: “Turn On Printing” command (File menu), “Turn On 

Printing” button in the Toolbar, “Page Setup” command (File menu). 

Related Topics: Printing is also described in the “Example: Printing the 

Contents of the Terminal Window’ in the next section. For more information 

on printing options, refer to your printer manual. 

Problem: You want to be able to print all incoming text that appears in the 

Terminal Window so you can later review the session. 

Solution: Turn on printing. 

1. Make sure your printer is properly connected to your 

Macintosh and that the power is on. 

If you want to select a different printer to use than the current one, use 

the Chooser (Apple menu). 



Example: Printing the 
Contents of the Terminal 
Window 

2. Choose “Page Setup” from the File menu, change any 

options for your printer, and click OK. 

3. To begin printing incoming text, click “Turn On Printing” 

in the Toolbar, or choose “Turn On Printing” in the Session 

menu. 

You can turn on printing either before connecting, during a session, or 

after disconnecting. When you turn on printing, SITcomm sends all 

incoming data and text you type to the printer until you turn printing off. 

Both the button in the Toolbar and the menu command change to “Turn 

Off Printing.” 

4. To stop printing incoming data, click “Turn Off Printing” in 

the Toolbar or choose “Turn Off Printing” in the Session 

menu. 

Features Explained: “Print” or “Print Selection” commands (File menu). 

Related Topics: Printing is also described in the “Example: Printing 

Incoming Text” in the preceding section. For more information on printing 

options, refer to your printer manual. 

Problem: You've just ended a communications session and you want to print 

the contents of the Terminal Window so you can review the session. 

Solution: Use the “Print” command. 

1. Make sure your printer is properly connected to your 

Macintosh and that the power is on. 

If you want to select a different printer to use than the current one, use 

the Chooser (Apple menu). 

2. Choose “Page Setup” from the File menu, change any 

options for your printer, and click OK. 

3. With the Terminal Window the active window, choose 

“Print” from the File menu, or press Command-P. 

The Print dialog box opens, listing printing options for your printer. 

4. In the dialog box, change any options that you want, and 

click Print. 

SITcomm prints the entire contents of the Terminal Window. You can also 

use this technique to print the contents of the Notepad (described next). 
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Alternate Method @ To print only a portion of the text in the Terminal Window or the Notepad, 
select the text you want to print, and choose “Print Selection” (Command- 

P) from the File menu. (When you have a selection of text highlighted, the 

“Print” command changes to “Print Selection.”) 

Using the Notepad You can use the Notepad like a simple text editor. The Notepad lets you: 

e Copy, cut, and paste text in and out of the Notepad. 

e Type text into the Notepad while you’re online. 

e Keep notes in the Notepad when you’re not online. 

e Search for text in the Notepad. 

e Print the contents of the Notepad. 

SITcomm maintains two types of Notepads — the Global Notepad and a 

separate Notepad for each Address Book entry. The Global Notepad is 

available when you do not have an Address Book entry in effect. Otherwise, 

you can hold down the Option key as you click the Notepad button in the 

Toolbar which brings up the Global Notepad. 

Global Notepad 

In addition, when you have an Address Book entry in effect (that is, an entry 

name appears in the Toolbar), a separate Notepad is associated with each 

entry. This lets you keep session-specific notes that only apply to the current 

Address Book entry. 

Notepad for CompuServe 

dust a reminder to check the Macintosh 
forums on CompuServe for the latest 
versions of my favorite public domain 
programs ! 

Also, let's check the educational 
forums for information on a good 
college. 
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Example: Using the Notepad 
while Online 

To open the Notepad, click “Notepad” in the Toolbar or choose “Notepad” 

from the Windows menu. When you open the Notepad, it becomes the front, 

active window. You can resize or move the Notepad window. 

The following examples show you how to use the Notepad during a session to 

take notes and how to search for text in the Notepad. 

Features Explained: Notepad associated with an Address Book entry. 

Related Topics: See “Using the Address Book” earlier in this chapter for 

information on the Address Book. For information on finding text in the 

Notepad, see “Example: Finding Text in the Notepad” in the next section. 

Problem: You need a place to keep some notes to yourself when you are 

online and connected to a BBS. 

Solution: Use the Notepad. 

1. Select the entry to which you want to connect in the 

Address Book pop-up menu in the Toolbar. 

2. Click “Connect” in the Toolbar to dial and connect to the 

service. 

3. While online, click “Notepad” in the Toolbar. 

A checkmark appears next to “Notepad” in the Windows menu, and the 

Notepad becomes the front, active window. Notice that the title bar of the 

Notepad indicates that it is associated with the selected Address Book 

entry. 

4. Type any text you want. Or, cut, copy and paste text into 

the Notepad. 

The Notepad can store up to 30, 000 characters. 

If you want to print the contents of the Notepad, make sure it is the front, 

active window, and choose “Print” (Command-P) from the File menu. 

SITcomm sends the contents of the Notepad to the printer currently selected 

in the Chooser (Apple menu). 

Note: You can select text in the Terminal window and append it to the 

Notepad associated with that session by selecting the “Append to Notepad” 

command from the Edit menu. 

To close the Notepad, click the Notepad's close box, or choose “Notepad” 

from the Windows menu again. 

The next time you select the same Address Book entry, you see the same 

contents of this Notepad. 

Chapter 4. Beyond the Basics 65 



Example: Finding Textinthe Features Explained: “Find” and “Find Again” (Edit menu), Notepad 

Notepad Related Topics: For information on using the Notepad online, see “Example: 

Using the Notepad while Online” in the preceding section. 

Problem: You want to find a string of text in the Notepad window. 

Solution: Use the “Find” and “Find Again” commands (Edit menu). 

Note: You can also use “Find” and “Find Again” to search for text in the 

Terminal Window. 

1. With the Notepad open as the active window, choose “Find” 

(Command-F ) from the Edit menu. 

The Find dialog box opens for you to type the text you want to find. 

Find Text 

Find this text: | Aladdin 

2. Type the text you want to find, and click Find. 

You can type from 1 to 31 characters in the Find dialog box. If the string 

exists in the Notepad, it is highlighted in the window. The search begins 

from the first character at the top of the document. If no match is found, 

the system beep sounds. 

Note: A Terminal window search starts at the bottom of the window, and goes 

backward. This results in a chronological search. 

3. To find the string of text again, choose “Find Again” 
(Command-G) from the Edit menu. 

If another occurrence of the text exists, it is highlighted in the window. 

Otherwise, the system beep sounds. 

Using the Buffered The Buffered Keyboard is a window that lets you send multiple lines of text 
Keyb oard all at once instead of one character at a time. The text stays in the buffer until 

you tell SITcomm to send it, by pressing Return or Enter. This is useful for 

online conferencing sessions. 
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Example: Using Buffered 
Keyboard during Online 
Chat 

Pausing the Connection 

Saving Text 

Feature Explained: Buffered Keyboard. 

Problem: You want to be able to send text over the modem multiple lines at 

a time during an online chat session. 

Solution: Use the Buffered Keyboard. 

1. Connect to the other computer, online service, or network 

using the procedures described earlier in the “Connecting” 

section. 

2. When you are ready to participate in the online chat or 

conference, open the Buffered Keyboard by choosing 

“Buffered Keyboard” from the Windows menu. 

The Buffered Keyboard appears on top of the Terminal Window. You can 

move the Buffered Keyboard around the screen by clicking in its title bar 

and dragging it to a new position. 

3. In the Buffered Keyboard window, type the text you want to 

send online. 

4, When you are ready to send the text, press Return. 

SITcomm sends the text over the modem, displays the text in the Terminal 

Window as it is sent, and clears the Buffered Keyboard. Repeat this 

sequence of steps whenever you want to send text. 

Note: To embed a carriage return in the buffered keyboard text, hold down 

the Option key when you press Return. 

When a connection is initiated, you can suspend or pause it at any time. This 

is most useful when you are receiving incoming text more quickly than you 

can read it. 

To pause a connection, click “Pause Connection” in the Toolbar, or choose 

“Pause Connection” in the Session menu. Each control becomes “Resume 

Connection.” To resume the connection, either click the button or choose 

the command. 

SITcomm optionally maintains the contents of the Terminal Window in a 

special area of memory called the buffer, and can save it when you quit 

SITcomm. This is an option that you can set with the “Preferences” command 

from the Edit menu. 

You have the additional option of saving a selection of text to a separate file. 

The following example explains how to do this. 
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Example: Saving a Selection Features Explained: “Save Selection As” and “Append Selection To” (File 

of Text menu) 

Problem: You want to save a portion of the data you see in the Terminal 

Window to a separate text file, and to save another part to the end of an 

existing text file. 

1. Click and drag to select the text that you want to save from 

the Terminal Window. 

Note: To select tabular information, such as stock quotes, hold down the 

Command key as you click and drag. This lets you select individual columns 

of text. 

2. To save the selection as a separate text file, choose “Save 

Selection As” from the File menu. 

A dialog box appears for you to give the file a name and select the folder 

into which the file should be saved. 

3. Type the file’s name in the text box. 

4. If desired, navigate to another folder into which the file 

should be saved. 

5. Click Save to save the selected text to the named file. 

If the named file exists, SITcomm asks you if you want to overwrite it. Click 

Yes to replace the old file, or click No to return to the dialog box and type 

another name. 

SITcomm saves the selection as an ASCII text file, which can be read by 

most word processors. You can specify a creator application — the same 

one as your capture files. This is done in the Preferences dialog box (Edit 

menu). 

6. To append selected text to the end of an existing file, 

choose “Append Selection To” from the File menu. 

The Append Selection To dialog box appears listing text files in the 

current folder. You can only append selected text to ASCII text files. 

7. Click once on a filename to select it, then click Append. 

SITcomm adds the text selection to the end of the selected file. 
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Where To Go From Here  Nowthat you know how to accomplish any communications task in SITcomm, 
the next chapter, “Mastering SITcomm,” teaches you about the advanced 

features of the program. 
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Mastering Tool 
Settings 

Close-up: Connection 
Settings 

Chapter 5. Mastering 
SITcomm 

This chapter gives you detailed information on these advanced topics: 

¢ Tool Settings: A close-up look at all of the options available in the 

Connection Settings, Terminal Settings, and File Transfer Settings dialog 

boxes. 

e SITcomm Preferences: Step-by-step procedures for changing and saving 

preferences, and a close-up look at the Preferences dialog box. 

e Scripting: Information on automating SITcomm. 

e Aladdin Translators: Step-by-step procedures for translating files, and a 

close-up look at each of the Translators. 

e Aladdin Viewers: Step-by-step procedures for using the Text and PICT 

Viewers, and a close-up look at each Viewer’s menus. 

This section provides reference information on connection, terminal, and file 

transfer settings. For information on how to specify these settings, see 

“Specifying Settings,” beginning on page 42 in Chapter 4. 

Note: Extensive balloon help is available in each dialog box of each tool. 

SITcomm comes with the Apple Modem Tool and the Serial Tool. The Apple 

Modem Tool is intended for connections to remote systems via a Hayes- 

compatible modem, while the Serial Tool is for direct connection to another 

computer. 
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Note: If you are using a PowerBook Duo computer, your System Software 

comes with the Express Modem Tool. Whenever you use SITcomm with a 

PowerBook that includes an Express Modem, use the Express Modem Tool as 

your connection method. That is, choose “Express Modem Tool” from the 

Method pop-up menu in the Connection Settings dialog box (Session menu). 

For more information on using the Express Modem Tool, refer to the 

documentation that came with your modem. 

Apple Modem Tool When you choose the Apple Modem Tool from the Method pop-up menu in the 

Connection Settings dialog box, you see the options shown here: 

Connection Settings 

Method: Apple Mode... 7 

r when dialing Port Settings 

Dial Phone — 3 so i Baud Rate: 2400 ¥ Cabling... 

: Dialing Method : if Parity: 
Data Bits: 

e When answering rrrreenenernnrnntnneennann ‘if Stop Bits: 

Answer phone after rings i Handshake : 

i Modem: il 
Error Correction : i 

| Correction Type: i 
[_] Display Modem Monitor window 

Printer Port 

The Apple Modem Tool lets you establish a connection with a remote 

computer through a modem attached to your Macintosh. The Apple Modem 

Tool provides a connection through either of the two serial ports built into 

the Macintosh and can recognize an attached Apple, Hayes, or other Hayes- 

compatible modem. Besides using the built-in serial ports, the Apple Modem 

Tool can establish connections through serial or modem cards installed in 

your Macintosh. 

The Apple Modem Tool enables your modem to answer an incoming call or 

make an outgoing call. You can specify the number of rings the modem 

should wait before answering. You can enter the destination phone number, 

the redial count, the redial interval, and the dialing method. The modem 

automatically dials for you. 

Other Apple Modem Tool options let you select the type of modem being 

used, as well as set data transmission parameters such as baud rate, parity, 

number of data bits and stop bits per character, and handshake method. 
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Phone Settings 

Modem Settings 

The options in this group let you specify whether the modem dials a number 

or answers an incoming call, and sets related features. 

> When dialing steeerseeeesseeeessceesaseesesessnceesceesesssensssnsnessessssnssssassssenenees! . 

OuPhneninbe| di 
: Dialing Method: 
[x] Redial [z_] times every seconds | 

er WHOM AMS WE ME crete eeeteeeeeeetesteeeeceeennnnnneeentnnnneenenannnenes : 

Answer phone after rings 
Neeseceeensnersnaceseserenecsusseeesensconsseccenccsenseecesssenesseasuessesseseesssessneseusunesenesenensnenes 

Dial Phone Number: Specifies the access phone number of the remote 

computer that you want to call. You can use or omit hyphens in the phone 

number. If you want dialing to pause after dialing an access number (such as 

9), type a comma. One comma is equivalent to a two-second delay. You can 

type up to 200 characters in the Dial Phone Number box, including hyphens, 

commas, and numbers. However, most modems only accept 40 characters. If 

you have already entered a number, it appears selected (highlighted), and 

you can change it by typing another number. 

An important point to keep in mind is: You don’t have to enter a phone 

number in this dialog box. If you use an Address Book entry, the number in 

the entry overrides any number entered here. (See “Using the Address 

Book,” beginning on page 34 for more information.) 

Dialing Method: Specifies the method used when dialing. If your telephone 

is a rotary phone, select Pulse. If you have a Touch-Tone phone, select that 

option. If you need a combination of both methods, choose Mixed. The 

default setting is Touch-Tone. 

Redial...Times, Every...Seconds: Specifies how many times the modem 

redials the number if the connection cannot be established, and the 

duration between redials. The default settings are 3 attempts to redial at 10- 

second intervals. 

Answer Phone After...Rings: Specifies the number of times the phone rings 

before the modem answers the call and establishes the connection. You can 

use any number between 1-255. The default setting is 2 rings. 

These settings let you specify the type of modem you are using, when to 

disconnect the modem, and whether or not an additional progress window is 

displayed. 

_ Moder : 
Error Correction: 

| Correction Type: 
Ci Display Modem Monitor ‘Window 

Seaasecessessascesecssesverssecesassseseccesnsseseseseccccssensconssnsecesosecseuesseseseverenseueusceenesecsened 

Modem: Displays a pop-up menu to select the type of modem to use for the 

connection. The modem you use must be Hayes-compatible, which is the 

default setting. The “Custom” option in this pop-up menu lets you edit your 

modem command strings and attributes. The “Modify This Menu” option lets 

you add or delete modems from the menu. 
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Port Settings 
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Error Correction: Specifies one of three methods of error correction. 

“Required” specifies the connections must be error-free. Non-error free 

connections are refused. “Optional” means a non-error free connection will 

be accepted if necessary. “None” is no error correction at all. 

Correction Type: Specifies one of two methods of handling errors. “Software 

MNP” uses the Microcom Networking Protocol (level 1 through 4) to achieve 

error-free connections. “Hardware” uses the error-correction built into the 

modem, which is usually faster, though less reliable, than the software 

method. 

Display Modem Monitor Window: Displays an additional window that 

shows communications between the connection tool and the modem. This 

window displays the connection being opened, closed, or listened to. It is 

usually not necessary to display this window. 

The pop-up menus in this group let you set port-specific settings, including 

baud rate, parity, number of data bits per character, number of stop bits per 

character, and handshake protocol. You also use this area of the Connection 

Settings dialog box to specify the port to use for the connection. 

Port Settings senevscacssoascsassssccescsnescosessscessesesscesasssscnesssocansecscessssensceses: 3 

Baud Rate: (Ceabting.._}} 

Data Bits: 

| StopBits: [1 +] 

Printer Port 

Baud Rate: Regulates the speed at which data is transmitted between your 

Macintosh and another computer. Both your Macintosh and the device it is 

communicating with must transmit data at the same baud rate. This is true 

unless you are using a modem that adjusts the sending baud rate to match 

the requirements of the remote modem. This technique, called “split baud,” 

is commonly used with high-speed modems. In that case, the baud rate for 

the Macintosh may be any rate that the local modem can handle. The default 

baud rate for the Apple Modem Tool is 2400. 

Parity: Checks that data is not garbled during transmission. You can select 

even, odd, or no parity, but the other computer you connect to must also use 

the same setting. The default setting for parity checking is None. 

Data Bits: Specifies the number of bits (5, 6, 7, or 8) that make up a 

character, whichever the computer you connect to requires. The default 

setting for data bits is 8-bit characters. 

Stop Bits: Specifies the number of stop bits (1, 1.5, or 2) to mark the end of 

a transmitted character. The default setting is 1 stop bit. 



Handshake: Regulates the flow of data between your Macintosh and the port 

or device you connect to. Both computers must use the same handshake 

setting. The default handshake setting is None. 

Handshake: @ fone 

XON/XOFF 
DTR& CTS 
DTR Only 

CTS Only 

XON/XOFF: Prevents the loss of data when either computer sends 

characters faster then the other computer can receive them. If you seem to 

be losing characters during a transmission, try using XON/XOFF. 

Note: This is a software-only method and should only be used when hardware 

handshaking is not available. 

DTR & CTS: Accommodates connections where both devices support flow 

control using DTR and CTS hardware handshake methods. This method can 

only be used with devices that are directly connected by an RS-232 cable 

that supports hardware handshaking. This is the standard form of hardware 

handshaking. 

Note: The DTR & CTS method is usually required by high-speed modems 

(9600 baud and faster). It also requires that the cable connecting your 

Macintosh to the modem is designed for this type of connection. Contact your 

modem manufacturer if you are unsure if your modem supports the DTR & 

CTS method. , 

DTR Only: Accommodates connections where DTR hardware handshake 

method is the only means of flow control. This method can only be used with 

devices that are directly connected by an RS-232 cable that supports 

handshaking. 

CCTS Only: Accommodates connections where the CTS hardware 

handshake method is the only means of data flow control. This method can 

only be used with devices that are directly connected by an RS-232 cable 

that supports handshaking. 

Current Port: Specifies which port on the back of your Macintosh to use for 

the connection. Choose one of the port icons displayed in the Current Port 

scrolling list. In a standard configuration — you haven’t installed an add-on 

serial or modem card — two port icons appear in the scrolling list. These 

icons are identical to those identifying the ports on the back of the 

Macintosh. You can use either port when establishing a connection, though 

the modem port is preferred in most cases. 

Cabling: Displays information about the proper cable to connect the current 

modem (displayed in the Modem Options panel) to your Macintosh. 
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Serial Tool When you choose the Serial Tool from the Method pop-up menu in the 

Connection Settings dialog box, you see the options shown here: 

Connection Settings 

Method: Serial Tool v 

Port Settings Current Port 

BaudRate: [ 9600 7 ee 
; i io ro 

Parity : M5 

Data Bits: : Moder Port Printer Port 

Stop Bits: 3 SSE | 

Handshake : [None > 
When Closing Document 

& Hold Connection 

[_] Remind to Disconnect 

The Serial Tool lets you transmit data in serial format; that is, one bit after 

another over a single wire. Compared to the Apple Modem Tool, which 

requires a modem to establish a connection, the Serial Tool accommodates 

other methods for setting up connections and offers a wider range of baud 

rates. 

Typically, you use the Serial Tool to establish a direct connection between 

your Macintosh computer and another computer, modem, or device (such as 

a piece of laboratory equipment) by connecting a cable to the serial port on 

each machine. 

Rather than redialing and executing other modem commands automatically, 

the Serial Tool requires that you redial or issue other commands manually to 

the modem. Use the Apple Modem Tool when you want to take advantage of 

automatic dialing features. 

Port Settings The Serial Tool Port Settings are the same as those for the Apple Modem Tool, 

except the default baud rate is 9600 for the Serial Tool. For more information 

on port settings, see “Port Settings” in the previous section. 

When Closing Documents The two options in this group let you specify whether you want the remote 

computer to keep your connection open, even after you have closed SITcomm 

itself. 

When Closing Document 

[x] Hold Connection 

pe] Remind ta Disconnect 

Hold Connection: Holds the connection after the application closes. You can 

then open another communications application to perform additional 

options. 
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Close-up: Terminal 
Emulation Settings 

TTY Tool 

On Line 

Remind to Disconnect: Notifies you the connection is remaining open, and 

gives you the opportunity to close it. This option is available only when the 

Hold Connection option is checked. 

Terminal emulation refers to the ability of your Macintosh to emulate, or 

imitate, a dumb terminal. Dumb terminals, which generally consist of a 

monitor and a keyboard with no CPU, are the type of terminals that connect 

to a mainframe or minicomputer. With SITcomm, you can set your Macintosh 

to emulate a TTY (default) or VT102 terminal. TTY, or teletype, is intended 

for basic fixed-function terminals; VT102 is for Digital Equipment 

Corporation (DEC) text-only terminals. 

When you choose TTY Tool from the Emulation pop-up menu in the Terminal 

Settings dialog box, you see the following options: 

Terminal Settings 

Emulation: TTY Tool w+ 

Text Cursor 

luge. @ Block 
“"" €) Underline 

Width: | 80 Columns *¥ Scroll Text 

ze: [_S point] Damp CO smooth 
Characters 

I Show Control Characters 
; iThis is a sample of T 

[_] Auto Wrap to Next Line This is a sample of T ; 
This is a sample of T ; 

Holding Down Keys ‘will 

i] Auto Repeat Keys 

Cc] Repeat Contral Keys 

CT] Swap ‘Backspace’ and ‘Delete’ 

CJ New Line on a Return 

The TTY (teletype) is a basic, line-oriented terminal. It supports typing, 

receipt of an incoming data stream, and on-screen data display. TTY 

emulation can be used to access timesharing or information services that do 

not require a specific terminal. 

As you change options for the TTY Tool in the Terminal Settings dialog box, a 

preview area immediately reflects your changes. 

When the On Line option is checked, your Macintosh is online; meaning it is 

connected to and can access the remote computer. The characters that you 

type are sent to the remote computer, and incoming data from the remote 

computer is displayed on your Macintosh screen. When this option is 

unchecked, your Macintosh stops sending data to the remote computer and 

ignores incoming data without terminating the connection (a condition 

called off line). Click the On Line option to resume communication with the 

remote computer. 
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Local Echo 

Text Cursor 

Scroll Text 

Width 
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Note: You can send a break signal to the remote computer using special key 

sequences. Press Command-Enter to send a short break; or press Command- 

Shift-Enter to send a long break. 

When the Local Echo option is checked, characters you enter are sent to your 

Macintosh screen as well as to the remote computer. Select this option when 

your Macintosh is communicating with a host that does not echo keystrokes. 

This is usually the case when communicating with another Macintosh or 

other personal computer. When this option is unchecked, characters you 

enter are sent only to the remote computer, not to your Macintosh screen. 

The characters that appear on your screen are sent by the remote computer. 

This is usually the case with most bulletin boards and other time-sharing 

services. If this option is turned on, you will most likely need to turn on the 

“New Line on a Return” option as well. 

Note: You can also turn local echo on and off by choosing the “Turn On Local 

Echo” command from the Session menu. 

The settings for the Text Cursor option determine whether the cursor is a 

solid block or an underline, depending on which radio button is chosen. 

Underline is the default setting. 

When the remote computer is sending data into the terminal region but it is 

already filled with data, the TTY tool automatically scrolls the data. The Scroll 

Text option lets you specify how the data scrolls. Smooth scrolling 

significantly slows down the rate at which the incoming data is displayed, but 

makes it easier to read rapidly scrolling lines. When you change these 

settings, the sample text in the option preview area scrolls accordingly to 

demonstrate the effects of the change you are making. The default setting for 

Scroll Text is Jump. 

Jump: Displays data one line at a time. When you change this setting, the 

text in the option preview area demonstrates how incoming text is displayed. 

Smooth: Displays data one pixel at a time. When you change this setting, the 

text in the option preview area scrolls smoothly out of the area, 

demonstrating how incoming text is displayed. 

In the Width pop-up menu, you set the number of display columns for TTY 

emulation. Two widths are supported: 80 or 132 columns per line. When you 

change the setting for the Width option, the scale in the option preview area 

of the dialog box changes accordingly. The default width is 80 columns per 

line. 

Note: When you change the Width option, SITcomm clears the Terminal 

Window and places the cursor at the top left of the screen. 



Size 

Character Settings 

Holding Down Keys Will... 

Swap ‘Backspace’ and ‘Delete 

New Line on a Return 

? 

Select the font size of the screen characters to display during TTY emulation 

from this pop-up menu. Two sizes are supported: 9 or 12 point. When changing 

the setting for the Size option, the sample in the option preview area of the 

dialog box changes accordingly. The default size is 9 point. 

The two options in this group provide choices of how characters are handled 

while your Macintosh is emulating a TTY terminal. 

Show Control Characters: The settings for this option determine whether 

control characters are displayed as readable characters. The default setting 

for this option is unchecked. When this option is checked, control characters 

are displayed on the screen as they are encountered in the incoming data 

stream and as they are entered from the keyboard (if the Local Echo option 

is on). Selecting this option also causes characters that would have extended 

beyond the right margin to wrap to a new line. Therefore, the Auto Wrap to 

Next Line option becomes dim. 

Auto Wrap to Next Line: When this option is unchecked (the default), the 

cursor stops when it reaches the last column of a row. Incoming characters 

overwrite the last character on the line until a carriage return character 

occurs in the incoming data stream. When this option is checked, the cursor 

moves to the first column of the next line when it reaches the last column of 

a row. 

These options control key repetition. 

Auto Repeat Keys: The settings for this option determine whether the Tab, 

Return, Backspace, Enter, and Escape keys, and all non-control keys, repeat 

when held down. The default setting for Auto Repeat Keys is checked. 

Repeat Control Keys: The settings for this option determine whether 

control characters repeat when held down. Control characters are generated 

by simultaneously pressing both the Control key and another key on an 

Apple Desktop Bus (ADB) keyboard. On a non-ADB keyboard, such as a 

Macintosh Plus keyboard, you generate control keys by simultaneously 

pressing both the Command key and another key. The default setting for 

Repeat Control Keys is unchecked. 

The settings for this option determine which character is sent when the 

Backspace key (on non-ADB keyboards) or the Delete key (on ADB 

keyboards) is pressed. By default, this option is unchecked. 

The settings for this option determine whether return characters in incoming 

data are interpreted as carriage return/line-feed pairs only. The default 

setting for this option is unchecked. When this option is checked, a return is 

interpreted as a carriage return/line-feed pair. When a return character is 

received from the remote computer, the cursor moves to the first position on 

the next line. Use this option when incoming data does not move down to the 
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VT102 Tool 

General Setup Options 
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beginning of the next line. If this option is required, you will probably need to 

turn on the “Local Echo” option as well. 

Terminal Settings 

Emulation: UT102 Tool w 

Terminal Mode: ANSIYYT102 ¥ Text Cursor 

©) Block 
—] On Line 

i Bb (®) Underline 
| LocalEcho : 

Cc Show Status Bar 

[_] Show Tab Ruler 

The DEC VT102 is a video terminal used as an input and output device for 

remote computers. With the VT102 Terminal Emulation Tool you can set 

general, screen, keyboard, and character set attributes for your Macintosh 

computer so it performs like a VT102 terminal. When you first select VT102 

Tool from the pop-up menu, the General icon becomes selected and the 

options that fall into the General category are displayed (as shown in the 

figure). 

Note: The VT102 Tool is a superset of the VT100. If you are accustomed to 

using a VT100 emulation tool, then use the VT102 Tool. 

When you select the VT102 emulation tool, the Keys menu appears at the far 

right in the menu bar. The Keys menu is useful if you don’t have a numeric 

keypad or function keys on your keyboard, or if the remote computer 

requires that you press a special key not available on a Macintosh keyboard 

(such as PF4). If you select the TTY tool, the Keys menu is not available. 

Keypad 

— ae 

FEE 
anal 

For each option, the most commonly used setting is preset as the default. 

However, you may need to change the setting for some options depending on 

the type of connection you are using, the type of information being 

transmitted, or the communications requirements of the remote computer. 

In these cases, you should refer to documentation for the remote computer or 

contact your system administrator for information on how the various options 

should be set for the communications environment you are establishing. 



Screen Setup Options 

Terminal Mode: Use this pop-up menu to specify in which VT102 mode your 

Macintosh should be. The default setting is ANSI/VT102. 

ANSI/VT 102: Typical mode for VT102 emulation. 

VT52: This is the mode used to emulate a DEC VT52 terminal. When this 

mode is chosen, the Character Set setup dialog box is disabled because VT52 

terminals do not support character set options. 

On Line: Same as the On Line option of the TTY Tool. 

Local Echo: Same as the Local Echo option of the TTY Tool. 

Text Cursor: Same as the Text Cursor option of the TTY Tool. 

Show Status Bar: The settings for this option determine whether a status 

bar (similar to the status lights on a DEC VT102 terminal) appears at the top 

of the VT102 terminal emulation screen (above any tab ruler). The default 

setting for Show Status Bar is unchecked; in which case, no status bar 

appears. 

Show Tab Ruler: Settings for this option determine whether a tab ruler 

appears at the top of the VT102 terminal screen, below the status bar. The 

default setting for Show Tab Ruler is unchecked; in which case, no tab ruler 

appears. 

Answerback Message: With this option you enter the character string that 

is sent to the remote computer when an Enquire (Control-E) character is 

detected in the incoming data stream. The answerback string provides an 

identification to the remote computer. You do not need to provide an 

answerback string unless the remote computer specifies it. Most public 

information services do not require an answerback string. (The system 

administrator for the remote system can tell you if an answerback string is 

required.) However, you may need to send an answerback message when you 

are communicating with certain types of private computer systems. 

SITcomm’s answerback string can contain from 1 to 20 characters. Some 

answerback messages require that you type a control character to generate 

the appropriate answerback message — for example, typing Control-M to 

generate the carriage return character in the answerback message area. 

When communicating with another computer system, the VT102 Tool sends 

the answerback string you have specified when the other computer requests 

it. 

When you click the Screen icon with VT102 selected as the terminal 

emulation tool, you see options for controlling the display of data on the 
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screen. As you change Screen setup options for VT102 terminal emulation, a 

preview area on the right of the dialog box immediately shows your changes. 

Terminal Settings 

Emulation: UT102 Tool w 

Width: | _80 Columns hal Scroll Text 

Size: Spent +} | @Qyump © Smooth 

Characters 

C] Show Control Characters 

; : iThis is a sample of VT: 
C] Auto Wrap to Next Line : This is a sample of UT: 

CJ Insert Characters i Thi 

Keyboard C] Origin at Scrolling Margin Cc] Inverse Video 

Width: Same as the Width option for the TTY Tool. 

Size: Same as the Size option for the TTY Tool. 

Scroll Text: Same as the Scroll Text options for the TTY Tool. 

Character Settings — Show Control Characters and Auto Wrap to Next 

Line: Same as these options for the TTY Tool. 

Insert Characters: The settings for this option determine whether 

characters are inserted between existing text or on top of the existing text, 

thereby overwriting it. The default is unchecked. When this option is 

unchecked, characters are inserted at the cursor location, writing over any 

existing text. The cursor moves to the right as new characters are inserted. 

Characters moving past the right margin are lost, unless you have Auto Wrap 

to Next Line turned on. 

Origin at Scrolling Margin: The settings for this option determine whether 

the cursor can move outside of the scrolling region (the area between the 

top and bottom margins). In addition, this option determines whether 

screen addressing is in absolute or relative coordinates. The remote 

computer determines the appropriate setting for this option. The default 

setting for this option is unchecked. 

When this option is unchecked, the cursor can be positioned beyond the 

boundaries of the scrolling region. In this case, screen addressing is based 

on absolute coordinates, where line 1, column 1, is in the top-left corner of 

the screen, rather than within the scrolling region. 

Inverse Video: The settings for this option determine whether the Macintosh 

displays white text on a black background or black text on a white 

background. Normally, the Macintosh displays black text on a white 

background. When you activate Inverse Video, white text appears on a black 

background. The default setting for Inverse Video is unchecked. 
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Keyboard Setup Options When you click the Keyboard icon with VT102 selected as the terminal 

emulation tool, you see options for controlling the keyboard during 

emulation. 

Terminal Settings 

sete Numeric Keypad Generates : Holding Down Keys Will 

ooo @® Numeric Sequences 
Hy WN Ia) i Auto Repeat Keys 

General i (e all ©) Application Sequences x , : 
i C Repeat Control Keys 

Cursor Keys Generate i 

Screen @ ANSI Cursor Sequences | 

© Application Sequences se 
eyclick Soun 

CT] New Line on a Return 

Numeric Keypad Generates: The settings for this option determine whether 

the keys on the keypad generate Numeric Sequences or Application 

Sequences, depending on the button selected. The default setting for this 

option is Numeric Sequences. 

Numeric Sequences: The keys on the keypad generate characters that 

match the typical numeric, comma, period, and minus sign keys on the 

VT102-type keyboard (in accordance with ANSI specifications). 

Application Sequences: The keys on the keypad generate special escape 

sequences (specified by Digital Equipment Corporation). 

Cursor Keys Generate: The settings for this option determine the 

characters transmitted when the Cursor (arrow) keys are pressed. The 

default setting for this option is ANSI Cursor Sequences, which you will not 

need to change under most circumstances. Usually, the remote computer 

sets the option appropriately. 

ANSI Cursor Sequences: When Cursor keys are pressed, ANSI cursor- 

control sequences are transmitted to the remote computer. 

Application Sequences: When Cursor keys are pressed, cursor-control 

functions (specified by Digital Equipment Corporation) are transmitted to 

the remote computer. 

Swap ‘Backspace’ and ‘Delete’: Same as the option for the TTY Tool. 

Holding Down Keys Will...: Same as the Holding Down Keys option for the 

TTY Tool. 

Keyclick Sound: The settings for this option determine whether an audible 

clicking sound is made when a key is pressed. You can change the volume 

level from the General or Sound Control Panel Device available from the 

Macintosh Control Panel. The default setting for Keyclick is unchecked. 

New Line on a Return: Same as the option for the TTY Tool. 
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Character Setup Options 

Close-up: File Transfer 
Settings 
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When you click the Character Set icon with VT102 selected as the terminal 

emulation tool, you have access to pop-up menus where you specify the 

national replacement and active character sets for display on your Macintosh 

screen. 

Terminal Settings — 

Emulation: UT102 Tool w 

fee National Replacement Set: | US ASCII ¥ 

Screen 

Active Character Sets Temporary Character Sets 

ieiincd @ co:(_usascn +) _ o2:[Lusasci + 

THe C) Gi:| US ASCII = G3:| US ASCII - 

A character set is somewhat like a Macintosh font; it is a collection of 

characters that can be shown on a screen or used to code computer 

instructions. US ASCII and French are examples of character sets. 

The VT102 Tool supports 13 different international character sets and a 

graphics character set (each of which contains 128 characters). The VT102 

Tool is preset to use only the US ASCII character set (as you can see from the 

example above). In almost every circumstance, you won’t need to change 

anything in this dialog box because remote applications take care of setting 

these options. Usually, the remote system resets the options to your original 

settings. 

However, in the rare case that a remote application changes a character set 

setting but doesn’t change it back, you will need to reset the setting yourself. 

In addition, you may want to change the character set options, if for 

example, you need a Graphics character set to generate on-screen graphics 

or a foreign character set to communicate with a multilingual host 

computer. In short, only change the character set if you are communicating 

with a host that transmits in non-US ASCII. 

SITcomm supports the following file transfer protocols: Text, XMODEM, 

YMODEM, ZMODEM, and Kermit. 

Note: The Aladdin X/YMODEM Tool handles both XMODEM and YMODEM 

file transfers. 

When you choose a file transfer tool, you tell SITcomm which corresponding 

protocol you want to use for a file transfer. The default file transfer tool is 

Aladdin X/YMODEM. 

The file transfer protocol (and thus file transfer tool) you use depends on the 

requirements of the remote computer. For example, if the other computer or 



Text Tool 

Timing Settings 

Line Ending Settings 

online service requires you to use the YMODEM protocol, you must select the 

Aladdin X/YMODEM file transfer tool in the File Transfer Settings dialog box. 

Usually, the tool’s settings must match those expected by the remote 

computer. However, the tools are intelligent to a degree, and can adjust on 

the fly. 

Here is a close-up look at each of the file transfer tools and their settings. 

When you choose Text Tool from the Protocol pop-up menu in the File 

Transfer Settings dialog box, the following dialog box appears (default 

settings shown): 

File Transfer Settings 

Protocol: Text Tool vr 

When Sending Text ... 

Timing Line Endings 

Delay Per Character : 

(60ths of Second) 

Delay Per Line: 

(é60ths of Second) CA 

The Text Tool is best used for straight ASCII text files or files whose 

formatting you don’t care about retaining. This file transfer method is the 

least reliable because it doesn’t provide any error checking during 

transmission. 

Use these options to specify transmission delays between characters and 

between lines when you are communicating with a computer that can’t 

receive data as fast as the Macintosh is sending it. If you can’t adjust the baud 

rate being used (either because you don’t have direct access to the remote 

computer or because the other computer does not support that baud rate), 

setting transmission delays provides another way to decrease the rate at 

which data is sent and thus, prevent data loss. 

Delay Per Character: Specifies a delay period between characters. Use 

whole numbers ranging from 0 to 32767. The value entered indicates the 

number of increments in 60ths of a second. For example, a delay of 2 

indicates 2/60 or 1/30 second. The default for this option is no delay (0). 

Delay Per Line: Specifies a delay period between lines. Use whole numbers 

ranging from 0 to 32767. The value entered indicates the number of 

increments in 60ths of a second. For example, a delay of 2 indicates 2/60 or 

1/30 second. The default for this option is no delay (0). 

End Lines With: Specifies the character or characters the Text Tool sends to 

indicate the end of a text line. When transmitting a file, the Text Tool 

replaces each carriage return it finds in the text with the end-of-line 

character you select here. Since Macintosh files use a carriage return 
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Aladdin X/YMODEM Tool 
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character (ASCII 13) to indicate the end of a line, leave this option set to CR 

when transmitting to another Macintosh. Some remote systems use a line- 

feed character (ASCII 10) or a carriage return/line-feed pair to indicate an 

end of line. To set this option correctly, find out how the receiving application 

interprets end-of-line characters. The default end of line setting is a carriage 

return. 

CR: Sends a carriage return character to indicate the end of a line. 

LF: Sends a line-feed character to indicate the end of a line. 

CR & LF: Sends both a carriage return and a line-feed character to indicate 

the end of the line. 

Wrap Lines at Column: Specifies the column at which lines in the outgoing 

file end. You should specify this option when the receiving application has a 

line limit that is less than the line length in the file you are sending, or when 

sending text to a system that does not wrap text automatically. The Text Tool 

inserts a carriage return character at the column specified unless doing so 

would divide a word, in which case the tool inserts the carriage return 

character in front of that word. When filtering lines of text, the tool ignores 

lines that are shorter than the line length you specify in this option, which 

means that short lines of text are not concatenated. The default setting for 

this option is to leave line lengths unchanged. 

When you choose Aladdin X/YMODEM Tool from the Protocol pop-up menu in 

the File Transfer Settings dialog box, the following dialog box appears 

(default settings shown): 

File Transfer Settings 

Protocol: Aladdin H/¥M...7 

Transfer As: [_MacBinary ¥ } Timeout Seconds 

Name Change: [Unchanged V) 
ea Show Error Messages 

Document Type: 

Creator : &B : [x] Use 1K Packets 

Type: ([] Use YMODEM-g 

psn 

C4 Enable Auto Receive 

bias Default Settings 

Use the X/YMODEM file transfer tool to transfer binary files or text files 

whose formatting you want to retain during the transfer. 

XMODEM was the original file transfer protocol and it includes error 

checking and error correction during transfer. YMODEM is an extension of 

XMODEM. It adds the ability to send multiple files in a batch, and it sends 

file information, such as the name and size of the transferred file. Like 



Transfer Methods 

Name Change 

XMODEM, YMODEM includes error checking and error correction during 

transmission. The Aladdin X/YMODEM Tool combines the functionality of 

both XMODEM and YMODEM in one file transfer tool. 

Use the Transfer As pop-up menu to select a file transfer method. The X/ 

YMODEM Tool supports four different methods of file transfer. MacBinary is 

the default transfer method. 

PC Text 

Unix Text 

Binar 

® MMacBinary 

PC Text: Transfers a text file created on the Macintosh as PC text format. 

Only the data fork part of the file is transferred. During an upload, carriage 

returns are converted to carriage return/line feeds (CR/LF). (DOS-based 

machines use the CR/LF line ending.) During a download, this method 

removes all the line feeds from the CR/LF pair so text can be read by the 

Macintosh. 

UNIX Text: Transfers a text file in UNIX text format. Only the data fork part 

of the file is transferred. During an upload, carriage returns are converted to 

line feeds. (UNIX-based machines use line feeds only to terminate a line. ) 

During a download, this method converts all line feeds to carriage returns so 

text can be read by the Macintosh. 

Binary: Transfers the data fork of a binary file to the remote computer. 

MacBinary (default): Transfers any Macintosh file (a document, 

application, or system file) to or from a Macintosh or any computer that 

supports binary X/YMODEM protocol. This method deals with both the data 

and resource forks of the file. 

Use the Name Change pop-up menu to change the name of a file during 

transmission so it is readable by either the remote computer (after an 

upload) or by your computer (after a download). The options are Unchanged, 

UNIX, and PC. 

When you send a file, the Name Change option searches for an extension (a 

period in the last four characters) and uses that extension. If there is no 

extension, a “.bin” (for “binary”) or “.txt” (for “text”) extension is appended 

as appropriate. 

When you receive a file, the Name Change options try to get the name into 

Macintosh-like format by capitalizing the first character of a word and lower- 

casing the rest, and by replacing all colons (“:”) with semicolons (“;”). If 

MacBinary was the file transfer method, the original name is retained. 

® Unchanged 

Unix 

PC 

Unchanged (default): Doesn’t change the file name. 

Chapter 5. Mastering SITcomm 87 



Document Type 

Timing Options 

Other Options 

88 Chapter 5. Mastering SITcomm 

UNIX: Converts all non-alphanumeric characters to underscores (except the 

period associated with the extension). 

PC: Truncates the filename to eight characters in the body and three in the 

extension. Also replaces characters that DOS doesn’t accept with an “X,” 

then capitalizes the whole name. 

Use these options to specify the creator ID and file type for non-MacBinary 

files you receive. 

Creator: Type a 4-character creator ID for the file. If you don’t know the 

creator ID of the file, click Set Document Type, select an application or a 

document created by the application you want to use. Default is “ttxt,” for 

TeachText. 

Type: Type a 4-character file type designator for the file. If you don’t know 

the file type, click Set Document Type, select an application or a document 

whose file type is the same as the one you want to use. Default is TEXT for 

text files. 

These options regulate retransmission attempts. 

Timeout X Seconds: Determines the length of time (in seconds) that the 

receiving computer waits between blocks of data for an appropriate 

response from the other computer. Enter a whole number between zero and 

32767; the default is ten seconds. When using online services that may be 

slow to respond, you may need to increase the timeout value. 

Show Error Messages: This option is checked by default. If a transfer fails 

and this option is on, you see a note explaining why it failed. You may want to 

turn off this option if you leave your machine unattended with another 

program (such as QuickMail) running. 

Enable Auto Receive: Only the MacBinary method activates this option. 

Lets you automatically receive files under certain conditions. The default 

setting is unchecked. When unchecked, the MacBinary method does not 

provide automatic file receipt. When checked, file receipt is automatic with 

the MacBinary method as long as the sending computer supports this 

feature. SITcomm monitors the incoming data for a receive request from the 

sending computer and, when one is detected, notifies the X/‘YMODEM Tool to 

receive the file. If the remote computer doesn’t send the receive request, you 

can still choose “Receive File” from the File menu. 

Use 1K Packets: Transmits files in 1K packets, or blocks, which is 

equivalent to 1,024-byte blocks. When deselected, transmits files in 128-byte 

blocks, which is slower. This option is checked by default. 

Use YMODEM - G: YMODEM -G is a fast version of YMODEM designed to be 

used on error-free connections, such as with error-correcting modems 



Aladdin ZMODEM Tool 

Escape Control Chars 

(MNP-type). You should only select this option if you are sure the connection 

is error free. The default for this option is unchecked. 

Start as XMODEM: Uses XMODEM first if YMODEM is not supported by the 

host computer. 

Save Preferences: Saves all settings in this dialog box in the Tools 

Preferences file, which is located in the Preferences folder. 

Default Settings: Reverts all options to their default settings. 

When you choose Aladdin ZMODEM Tool from the Protocol pop-up menu in 

the File Transfer Settings dialog box, the following dialog box appears 

(default settings shown): 

File Transfer Settings 

Protocol: Aladdin 2MO0... 

Transfer As: Timeout Seconds 

Name Change : 

Non-MacBinary Document Type: 
J Show Error Alerts 

ix] Enable Auto Receive 

Cc] Escape Control Chars 

Windows : $192 ° 4 

zea Save Default Settings Restore Default Settings 

This protocol is the most intelligent, advanced, and fastest file transfer 

protocol available. The ZMODEM file transfer protocol has several 

advantages over its predecessors (XMODEM and YMODEM). With ZMODEM, 

if a transfer is interrupted, it can be resumed at any later time. ZMODEM is 

fast because it transmits data without waiting for responses from the remote 

computer. Also, if there is a problem with a transfer, such as network delays, 

the ZMODEM protocol is often able to adjust itself and recover the transfer. 

The Aladdin ZMODEM Tool offers similar options to the Aladdin X/YMODEM 

Tool, with the addition of the following options: 

e Escape Control Chars 

e Windows 

These ZMODEM options are described next. For information on other 

options of the Aladdin ZMODEM Tool, refer to the X‘YMODEM Tool options 

described earlier. 

When Escape Control Chars is checked and control characters need to be 

sent, the sender encodes them into a two-character format suitable for 

transmission over connections that don’t handle control characters. This 
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option can significantly slow down transfer rate. It is primarily used with 

some network connections such as Telnet. 

If you are uploading to a system that cannot write the data to its storage 

device as fast as it can receive it, you can select a window size, in kilobytes, 

of data to transmit. The default window size is 8K. This means your Macintosh 

will send 8K of data to the receiving computer, then wait for a signal before 

sending the next 8K. Valid values range from 512K to infinity. 

When you choose Aladdin Kermit Tool from the Protocol pop-up menu in the 

File Transfer Settings dialog box, the following dialog box appears (default 

settings shown): 

File Transfer Settings 

Protocol: Aladdin Kerm...7 

Transfer As: Timeout [s_] Seconds 

Name Change : 

Document Type: 
i] Show Error Messages 

Peaster: & | Packet Length: E:2_]ika 

Error Checking: 
Type: TEXT i 9 

Set Document Type... | Expert Settings... 

be Defeat Bettina 

Kermit was developed in the early 1980s at Columbia University. Used by 

universities, research institutes, government agencies, and businesses, 

Kermit was developed to work across a multitude of telecommunications 

equipment. 

Kermit encapsulates the data being sent into packets. Kermit is very flexible 

with its definition of packets. Unlike XMODEM, you can specify to some 

degree the format of Kermit packets. The protocol calls for the sender to 

send one packet at a time, wait for the remote computer to acknowledge 

successful receipt and then send the next. Consequently, Kermit is not as 

fast as ZMODEM. 

The following options of the Aladdin Kermit Tool dialog box are the same as 

those for the Aladdin X/YMODEM Tool dialog box. For information on these 

settings, see “Other Options” on page 88. 

e Transfer As (default is Text) 



Packet Length 

Error Checking 

Expert Settings 

e Name Change (default is Unchanged) 

¢ Document Type: Creator (default is ttxt) and Type (default is TEXT) 

e Timeout...Seconds (default is 5 seconds) 

e Show Error Messages (default is on) 

e Save Preferences 

e Default Settings 

The remaining options — Packet Length, Error Checking, and Expert 

Settings — are described next. 

The Packet Length option specifies the size of the block, or packet, to use for 

the transfer. You should experiment with your setup to find the optimum 

packet length for getting the best throughput. Default is 512. 

Note: Some hosts do not support packets greater than 94. 

The Error Checking option specifies the error-checking method to use during 

file transfer. Sum 1 is the fastest but the least secure; CRC 3 is slowest and 

most secure, and less likely to be implemented by the remote. Default is Sum 

ig 

® Sur 1 

CRC 3 

When you click the Expert Settings button, the Kermit Expert Settings dialog 

box opens. The options in this dialog box let you specify more advanced 

settings for a Kermit file transfer. 

Protocol Specific Characters 

Purpose ASCII Character 

Receive Start <SOH> 
Ue Number of Pads 

Send Start <SOH> 

C] Force 8-Bit Prefixing 
Padding <NUL> 

—] Send File Information 
Control Prefix 

6th Bit Prefix 

End of Packet 

—] Use Run Compression 
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Protocol Specific Characters: Use these settings to change the ASCII 

control characters to use for the corresponding purposes during a Kermit 

file transfer. 

Number of Pads: Sets the number of filler characters to precede each 

packet during a send. You may need to set this if your connection requires 

some null space to separate individual packets. Default is zero. 

Force 8-Bit Prefixing: Allows you to request that 8-bit encoding be done 

during the connection. Default if off. Turning this option on can slow down 

the transfer rate. 

Send File Information: Uploaded file sends information about itself during 

transmission. Default is on. 

Use Run Compression: Compresses occurrences of characters that repeat 

several times in a row (such as tabs, spaces, and so on). Default is on. 

Setting Preferences This section describes how to customize SITcomm by changing the settings in 

the SITcomm Preferences dialog box (Edit menu). The first part of this 

section offers an example of how to change and save preferences, while the 

second part gives detailed close-up information on all options in the 

Preferences dialog box. 

Example: Changing and ~ Features Explained: “Preferences” command (Edit menu) 

Saving Preferences Related Topics: For information on setting session-specific preferences, see 
“Example: Adding a New Address Book Entry” on page 36 in Chapter 4. 

1. Choose “Preferences” from the Edit menu. 

The Preferences dialog box appears. (The display in the Preferences 

dialog box varies depending on what icon you select on the left side.) 

2. To change general preferences, click General. To change 

preferences for dialing, click Dialing. To change 

preferences for compression and expansion of data, click 

Stuffing. 

Each of these preferences and their options are described in “Close-up: 

The Preferences dialog box” in the next section. 

3. When you are finished, click Save to save your preferences. 

Note: SITcomm saves your preferences settings in the “SITcomm 

Preferences” file, stored in the Preferences folder within the System Folder. 

92 Chapter 5. Mastering SITcomm 



Close-up: The 
Preferences dialog box 

General Settings 

This section explains each of the options in the Global Preferences dialog 

box. 

These preferences affect general SITcomm behavior. 

Global Preferences 

General Settings: 

(] Command (3) key as control key 

>] Warn for inactivity of minutes 

“SS _] Save/Restore terminal window text 
Dialing 

& {X] Use sounds for special events 

Stuffing Capture File Creator:| TeachText v 

Command key as control key: Enables the Command key on a Macintosh 

keyboard to behave as a Control key expected by another host system. Only 

use this option if you have an older keyboard that doesn’t have a Control key. 

The default is off. 

Warn for inactivity of...minutes: Sounds a system beep and flashes the icon 

in the menu bar after a designated number of minutes of inactivity during a 

connection. This is useful for saving online time and money. To specify the 

amount of time, type a number from 1 to 99 that is the number of minutes. 

The default for this option is on with the default set for 4 minutes. 

Save/Restore terminal window text: Saves the contents of the terminal 

window, including data that scrolls off the screen. This is handy if you’d like 

SITcomm to restore itself to the way it was the last time you used it. The 

default is off. 

Note: You can increase the size of the scrollback buffer, to a point, by 

allocating more memory to SITcomm in the Finder. 

Use sounds for special events: Plays prerecorded sounds when the 

connection is established and terminated, when a file transfer concludes, 

and when you quit SITcomm. The default is on. 

Capture File Creator: Selects another file creator for the captured file. The 

default file creator is TeachText. 
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Example: Using a Calling 
Card 
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The Dialing Settings affect the way SITcomm dials your modem. 

Global Preferences 

Fa=| [o [x] Access outside line with: 

 veeigg >] Disable call waiting with: 

[] Use this Area Code if none supplied: | 

Send Calling Card information 

_] before phone Hr 

Stuffing CJ after phone #: 

It is important to remember that the values you supply in this dialog box are 

in addition to each number you want to call. SITcomm provides these 

options for those with calling cards, those who may have telephone service 

providers accessed by 800 numbers, or those who must go through a PBX or 

hotel telephone system to get an outside line. 

Access outside line with: Adds a prefix to each phone number you dial. 

When checked, type up to 7 characters in the box. The default is off. 

Disable call waiting with: Turns off the Call Waiting feature during the 

connection. If you do have Call Waiting, you should leave this option turned 

on; otherwise, if a call comes in while you are online, the connection may be 

dropped. Type the sequence of characters (up to 7 characters) accepted by 

your phone company to turn off Call Waiting. (The most common sequence is 
a) 

Use this Area Code if none supplied: Adds a specific area code. 

Send Calling Card information before phone #: Adds the access number of 

your calling card before the actual number you want to dial. This field, which 

accepts up to 31 characters, must end with a zero or one, depending on how 

the call is being billed. (See the following example.) 

Send Calling Card information after phone #: Adds the billing number of 

your calling card after the number you want to dial. 

Features Explained: Dialing preferences in Global Preferences dialog box. 

Related Topics: See “Connecting Q&A” on page 117 in the Troubleshooting 

chapter. 

Problem: You're in a hotel room in a different state, and need to send an 

important file to your husband at home. You want to use your telephone 

service provider calling card to bill the call to your home phone. 

Solution: Use the Dialing preferences in the Global Preferences dialog box. 

1. Choose “Preferences” from the Edit menu. 

2. Click the Dialing icon. 



3. Click the “Access outside line with” checkbox, and type 9, 

(comma). 

Note: For this example, we are assuming the hotel uses a “9” to access an 

outside line. 

The comma tells SITcomm to wait two seconds before continuing. This 

gives the hotel telephone system time to switch to an outside line. 

4. Click the “Send calling card information before phone #” 

checkbox, and type a zero. 

This indicates you want to bill this to your home phone. If you enter a one 

in this field, that indicates you want to charge the call to the hotel phone. 

Note: If you use a telephone service provider that must be accessed with an 

800 number, you would enter that number in this field. See the “Connecting 

Q & A” section in the Troubleshooting chapter for more information. 

5. Click the “Send calling card information after phone #” 

checkbox, and type a W, followed by your calling card 

number. 

The “W” tells SITcomm to wait for a tone other than a dial tone. 

The dialog box should look like the following illustration: 

Global Preferences BSS 

General 

= 
Re Send Calling Card information 

& (] before phone #: 

stuffing [ XX] after phone #: |W2061234567 

6. Click Save. 

7. Select your home modem number from the Address Book, 

and click Connect. 

Alternatively, you can select the “Quick Dial” command from the Session 

menu. 
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Automating 
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SITcomm modifies the entry “on the fly,” if necessary, by eliminating 

redundant characters (such as area code) and unnecessary characters 

(such as hyphens and spaces). 

8. Once you are connected, select the file you want to send, 

and click Send in the Toolbar. 

9. Disconnect when the file has been sent. 

The Default Stuffing Settings affect the way SITcomm compresses files before 

uploading them. 

Global Preferences ]]]]_]SSSS= 

Des C) Stuff files before sending 
Genera 

Default Stuffing Settings: 

{] Compression 

CJ Encryption 

CJ Make Self-Extracting 

.. 
Dialing 

Stuff files before sending: Select this to set the “Stuff files before sending 

option” in the Send File dialog box (File menu). You can choose to override 

this preference before sending files. 

Default Stuffing Settings: Select the defaults — compression, encryption, 

and self-extracting — that are set in the Stuff and the Send File dialog boxes 

(File menu). 

With SITcomm’s scripting feature, you can automate many repetitive, routine 

tasks. Scripting lets you perform communications when you are not present, 

or while you are working in another application (if the other application also 

supports AppleScript). 

Scripting refers to writing a series of instructions to do a task for you, such 

as logging onto a service. When you write a script in SITcomm, you do so 

using AppleScript, Frontier, or other Apple event-based scripting system. 

AppleScript is the language Apple developed to run Apple events. Frontier is 

a scripting environment developed by UserLand. 

Because SITcomm supports AppleScript, you can write your own AppleScript 

scripts to automate SITcomm in any way you want. You can also create a 

custom script by recording, using the AppleScript Script Editor. 

SITcomm comes with some sample scripts for AppleScript and for Frontier. 

You can use these as they are, or use them as a guide for writing your own 

scripts. 



Translating Files 

Close-up: Translators 

Appendix C lists all of the scripting commands you can use to automate 

SITcomm. 

For more information on using AppleScript and on writing or recording an 

AppleScript script, refer to the AppleScript reference manual. For more 

information on Frontier, refer to the UserLand Frontier documentation. 

In the real world of computers and telecommunications, you are more than 

likely to encounter files or documents that you cannot read or access. When 

Macintosh computers are connected to each other over local area networks 

(LANs), they communicate using file servers and electronic mail. Under 

those conditions, you may receive a file that was created by an application you 

don’t have. Furthermore, Macintosh computers can also communicate with 

Intel-based machines running MS-DOS or Windows, with Digital VAX 

computers, or with UNIX-based machines through direct connections or 

telecommunication programs. In those configurations, you can be sure you 

will receive a file that was not only created by an application you don’t have; 

it was also created with a completely foreign disk and file structure. It may 

even be compressed using a foreign archive format. 

With these situations in mind, SITcomm comes with Translators. The 

Translators, which reside in the Aladdin folder within the Extensions folder 

of your System folder, help you manage foreign file and foreign archive 

formats. (Foreign archives are those created with compression software 

other than a member of the Aladdin product family.) You access the 

Translators through the Translate menu. You also have the option of setting 

certain foreign file compression and expansion preferences. For more 

information, see “Setting Preferences” on page 92 in the previous section. 

The Translate menu lists all of the Translators that are available to SITcomm 

for translating foreign archive and data formats. 

Translate 

AppleSingle 

BinHex4 

btoa/atob 

DefArc... 

MacBinary 

tar 

Text Convert 

Unik Compress 

UnPack... 

UnZip... 

uUUCode 

This section gives you close-up information on each of the Translators. 

(Unlike other “Close-up” sections in this manual, this section provides step- 

by-step instructions for using each Translator. ) 
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AppleSingle allows files to maintain their attributes on foreign file systems 

that do not support the same attributes. In the AppleSingle format, a file’s 

contents and attributes are stored in a single file in the foreign file system. 

For example, the data fork, the resource fork, and the Finder information are 

all arranged in a single file with a simple structure. 

Choose the “Encode” command from the AppleSingle submenu to encode a 

file in AppleSingle format. 

1. To encode a file to the AppleSingle format, choose 

“Encode” in the AppleSingle submenu. 

A directory dialog box appears for you to select a file. 

2. Select the file to encode, and click Open. 

3. In the Save dialog box, supply a file name and destination 

for the file. 

SITcomm automatically adds a .AS suffix to the encoded file’s name. 

4. Click Save to encode the file in AppleSingle format and save 

it to disk. 

Choose the “Decode” command from the AppleSingle submenu to decode a 

file in AppleSingle format. 

1. To decode a file to the AppleSingle format, choose 

“Decode” in the AppleSingle submenu. 

A directory dialog box appears for you to select a file. 

2. Select the file to decode, and click Open. 

3. In the Save dialog box, supply a file name and destination 

for the file. 

4. Click Save to decode the file to its original format and save 

it to disk. 

BinHex4 is a standard conversion algorithm used to convert Macintosh binary 

files to and from ASCII format. This format is used primarily for transmission 

over networks that only support characters that can be typed from a 

keyboard, like Internet mail/news. On the Internet, BinHex4 is most 

commonly used on files that have already been compressed. If you don’t 

already know about BinHex4, chances are you don’t need it. Choosing 



“BinHex4” from the Translate menu opens a submenu with “Encode” and 

“Decode” menu choices. 

Encode Choose the “Encode” command from the BinHex4 submenu to encode a file 

in BinHex4 format. 

1. To encode a file to the BinHex4 format, choose “Encode” 

in the BinHex4 submenu. 

A directory dialog box appears for you to select a file. 

2. If you want to add linefeeds to the file, check the “Include 

LFs” option at the bottom of the dialog box. 

On older computer systems, a linefeed causes the paper on a printer to 

advance to the next line without the carriage returning to the start of the 

next line. In some environments, a BinHexed file may not be usable unless 

linefeeds are included with the normal carriage returns. 

3. Select the file to encode, and click Open. 

4. In the Save dialog box, supply a file name and destination 

for the file. 

SITcomm automatically adds a .HQX suffix to the encoded file’s name. 

5. Click Save to encode the file in BinHex4 format and save it 

to disk. 

Decode Choose the “Decode” command from the BinHex4 submenu to decode a file 

from BinHex4 format. 

1. To decode a file from the BinHex format, choose “Decode” 
in the BinHex4 submenu. 

A directory dialog box opens for you to choose a file. 

2. Select the file to decode, and click Decode. 

3. When prompted, supply a file name and destination for the 

file. 

4. Click Save to decode and save the file. 

A progress window appears as SITcomm decodes the file. 
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btoa/atob Btoa/atob (Binary to ASCII/ASCII to Binary) provides compatibility with the 

UNIX programs “btoa” and “atob,” which convert 8-bit binary data to 7-bit 

ASCII data. This conversion becomes necessary for transmitting across 

channels that only support 7-bit ASCII data. 

Choosing “btoa/atob” from the Translate menu opens a submenu with the 

“Binary to ASCII” and “ASCII to Binary” menu choices. 

Binary to ASCII Choose the “Binary to ASCII” menu choice from the btoa/atob submenu to 
convert any Macintosh file to 7-bit ASCII. 

1. To convert a binary file to ASCII, choose “Binary to ASCII” 

in the btoa/atob submenu. 

A directory dialog box appears for you to select a file. 

2. If you are converting a Macintosh file, leave the “Make 

MacBinary” option checked at the bottom of the dialog 

box. 

This option converts your file to MacBinary format before doing the btoa 

translation. Unchecking this eliminates information about your file, such 

as its type and creator. 

3. Select the file to convert to ASCII format, and click Open. 

4. When prompted, supply a file name and destination for the 

file. 

SITcomm automatically adds a .MBin.ascii suffix to the encoded file’s 

name. 

5. Click Save to convert the file to 7-bit ASCII and save it to 

disk. 

ASCII to Binary Choose the “ASCII to Binary” command from the btoa/atob submenu when 
you receive a 7-bit ASCII file, and you want to convert it for use on the 

Macintosh. 

1. To convert a 7-bit ASCII file to binary, choose “ASCII to 

Binary” in the btoa/atob submenu. 

A directory dialog box appears for you to select a file. 

2. Leave the “Recognize MacBinary” option checked at the 

bottom of the dialog box. 
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DeArc, UnPack, UnZip 

Normally, you should keep this option checked. The Translator knows 

when a file being decoded has been MacBinary-encoded and when it 

hasn’t. If you know the file was not from a Macintosh source or was not 

MacBinary-encoded, then make sure this is not checked. 

. Select the file to convert to ASCII format, and click Open. 

. When prompted, supply a file name and destination for the 

file. 

. Click Save to convert the 7-bit ASCII file to Binary and save 

the file to disk. 

The process for using the DeArc, UnPack, and UnZip Translators is similar. 

Choose the “DeArc” command to expand files created with any of the 

numerous Arc programs. Arc files have a .ARC suffix. You may not be able 

to use the extracted files on the Macintosh because they were created ona 

foreign computer. You must have an application that can read these files to 

use them. 

Choose the “UnPack” command to expand files created with the PackIt II 

and PacklIt III compression utilities written by Harry Chesley. Packlt files 

generally have a .PIT suffix. If the PackIt archive was encrypted, you won’t 

be able to expand it. 

Choose the “UnZip” command to expand files stored in the Zip format. Zip 

files have a .ZIP suffix. Just like Arc files, you may not be able to use the 

unzipped files on the Macintosh because they were created on a foreign 

computer (usually an IBM PC). You must have an application that can read 

these files to use them. If the Zip archive was encrypted, you won’t be able 

to expand it. 

The following procedure applies to the DeArc, UnPack, or UnZip Translators. 

1. Choose the appropriate command from the Translate 

menu. 

Chapter 5. Mastering SITcomm 101 



A directory dialog box appears for you to select a file. 

UnZip Translator 3.0.5. © 1990-93 Aladdin Systems, Inc. 

and Raymond Lau. All Rights Reserved. 

GS $lfcomm™ ¥ 

CQ Address Book 

D Icon 
© Read Us First 

© Scripting Tools 

O Services 

@ $iTcomm™ 

CL] Show files ending in .zip only 

] Show all file types 

2. To see only files of the format you want to expand, check 

the “Show files ending in .zip or .arc only” option. 

SITcomm limits the items listed to the appropriate type. 

Note: Since Packlt files were created on a Macintosh (with no file suffix), 

SITcomm automatically lists all Packlt files in the dialog box. There is no 

option to check for listing these files. 

3. Select the archive you want, and click Open. 

A directory dialog box lists all the files stored in the selected archive. 

4. Select the file(s) you want to expand. 

To select all files, press Command-A. To select more than one file, Shift- 

click or Command-click them in the list. The Shift key extends the file 

selection to the point where you clicked. The Command key lets you add 

or remove items from your selection. 

5. If you are translating the file(s) from an IBM PC or 

compatible system, select the “Convert CR/LFs to CRs” 

option in the bottom of the dialog box. 

Doing so converts the PC carriage return and linefeed “end-of-line” 

markers to the Macintosh-friendly carriage returns. Text files on the 

Macintosh use carriage returns to terminate lines. 

6. Click either DeArc, UnPack, or UnZip in the dialog box. 
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MacBinary 

Encode 

Decode 

SITcomm displays a dialog box so you can save or convert the file(s). 

e Click Save or Save All to expand the file(s) and saves to disk. 

e Click Skip to skip any file you are expanding. 

e Click Cancel to cancel the operation. 

MacBinary is an external Translator that lets you encode or decode a file in 

MacBinary format. This is useful for exchanging files with foreign computers 

across foreign networks. The main purpose of the MacBinary Translator is to 

combine the data and resource forks under these circumstances. MacBinary 

is sometimes referred to as BinHex5d. 

Note: SITcomm can automatically encode or decode MacBinary files when 

you have MacBinary selected in the Method pop-up menu of the File Transfer 

dialog box. See “Mastering Tool Settings” on page 71 for more information. 

Choosing “MacBinary” from the Translate menu opens a submenu with the 

“Encode” and “Decode” menu choices. 

Choose the “Encode” command from the MacBinary submenu to convert a file 

to MacBinary format. 

1. Choose “Encode” from the MacBinary submenu. 

A directory dialog box appears for you to select a file. 

2. Select the file to encode, and click Open. 

3. When prompted, supply a file name and destination for the 

file. 

SITcomm automatically provides the MacBinary .BIN suffix. 

4. Click Save to encode and save the file. 

Choose the “Decode” command from the MacBinary submenu to convert a 

MacBinary file into a regular Macintosh file. 

1. To decode a MacBinary file, choose “Decode” in the 

MacBinary submenu. 

A directory dialog box appears for you to select a file. 

2. Select the file to decode, and click Open. 

3. When prompted, supply a file name and destination for the 

file. 
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Create 
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SITcomm automatically provides a .BIN suffix to the encoded file’s name. 

4. Click Save to decode and save the file 

The tar Translator lets you decode and encode files for use with the UNIX tape 

archiver, tar. Many files available on UNIX systems are archived with tar. Tar 

file names generally have a .tar suffix. 

Choosing “tar” from the Translate menu opens a submenu with the “Create” 

and “Extract” menu choices. 

Choose the “Create” command from the tar submenu to build a UNIX tar file. 

1. To create a tar archive, choose “Create” from the tar 

submenu. 

J $iTcomm™ ¥ items to Archive: 

QO Address Book <— Lestat Address Book 

D Icon Scripting Tools 
© Read Us First 

© Scripting Tools 

O Services 

& $iTcomm™ 

Add >> 

<< Heayyndare 

Convert CRs to LFs Archive 3A 

2. Select the files and folders to be archived. 

You add files or folders from the directory list on the left in the dialog box 

to the list of items to place into a tar archive on the right. 

3. To make the files compatible with UNIX systems, select the 

“Convert CRs to LFs” option at the bottom of the dialog 
box. 

Macintosh text files use carriage returns to terminate lines, but UNIX 

systems use linefeeds to terminate them. 

4. Click Archive. 

5. When prompted, supply a file name and destination for the 

file. 



Extract 

6. Click Save to create the tar archive and save it to disk. 

Note: When you transfer a tar archive from the Macintosh to another system, 

you should normally have the MacBinary option turned off in your file transfer 

program. Otherwise, the MacBinary header added by your file transfer 

program prevents the archive from being recognized as a legitimate tar 

archive. 

Choose the “Extract” command from the tar submenu to retrieve the contents 

of tar files. 

1. To extract files from a tar archive, choose “tar” from the 

Translate menu, then choose “Extract” from the tar 

submenu. 

©) Send Folder ¥ 

~] Show files ending in .tar only 

Tar Translator v3.0.6 for Stuffit. 

By Raymond Lau. Copyright © 1992-93, Aladdin 

Systems, Inc. and Raymond Lau. All Rights Reserved. 

2. Select the tar archive you want to extract, and click Open. 

When the archive opens, SITcomm displays its listing in a window. In the 

listing, the first column displays a symbol, indicating that the item is a file, 
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directory, or a special file (block, link, etc.). The symbol used is the same 

as that used by the UNIX “Is-]” command. 

Select file(s) to extract from archive.tar: 

9/10/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
6/21/93 
9/10/93 
9/10/93 
9/6/93 
9/6/93 
9/6/93 

Clip Art/ 
Clip Art/Arrows 
Clip Art/Bal loons 
Clip Art/Borders 
Clip Art/Dingbats 
Clip Art/Electronic 
Clip Art/FlowChart 
Clip Art/Hardware 
Clip Art/Hol idays 
Clip Art/Icons 
Clip Art/Isogrid 
Clip Art/Misc 
Clip Art/OfficeSupp!l ies 
Clip Art/People 
Clip Art/Stacks 
Clip Art/Transport 
Final drafts/ 
Final drafts/Aladdin dictionary 

20480 
27648 
49152 
14336 
70656 
40960 
63488 
37888 
43008 
69632 
95232 
8192 

45036 
0 

22 
30720 
30720 
39936 

Final drafts/Appendix A 
Final drafts/Appendix B 
Final drafts/Appendix C 

d 

d 

>] Convert LFs to CRs when extracting 

If you just want to view the directory, you can click Done when you are 

finished and return to SITcomm. 

3. Select the files to extract. Use the Shift and Command keys 

to extend your selection, or press Command-A to select all 

files in the directory. 

4. If you want linefeeds (LFs) converted to carriage returns 

(CRs), check that option in the dialog box. 

5. Click Extract. 

SITcomm prompts you to indicate where to store the extracted files and/ 

or folders. If there are naming conflicts, SITcomm prompts you to skip or 

replace existing files (with the option of replacing all future conflicting 

files). You may also cancel the process. In keeping with the UNIX tar 

convention, folders are never replaced. Files are placed into existing 

folders if folders have the same name. 

The Text Convert Translator lets you convert a Macintosh text file for use on 

different types of computers. Text conversion is necessary because different 

computers use different characters to specify the end of a line; the Macintosh 

uses a Carriage return, UNIX uses a linefeed character, and the PC uses both 

(often expressed as carriage return/linefeed). 

Choosing “Text Convert” from the Translate menu opens a submenu with the 

“Convert for Macintosh,” “Convert for PC,” and “Convert for UNIX” menu 

choices. 



UNIX Compress 

Encode 

e Choose “Convert for Macintosh” when you are receiving a text file from a 

PC or UNIX computer. The conversion replaces the line endings with 

Macintosh-friendly carriage returns. 

e Choose “Convert for PC” when you are sending a Macintosh or UNIX text 

file to a PC computer. The conversion replaces the line endings with the PC 

carriage return/linefeed sequence. 

e Choose “Convert for UNIX” when you are sending a Macintosh or PC text 

file to a UNIX computer. The conversion replaces the line endings with 

linefeeds. 

The following procedure applies to using either conversion method. 

1. Choose the appropriate command from the Text Convert 

submenu. 

A directory dialog box appears for you to select a file. 

2. Select the file to convert, and click Open. 

3. In the Save dialog box, supply a file name and destination 

for the file. 

SITcomm automatically supplies the appropriate suffix: 

e .MAC for “Convert for Macintosh” 

e .PC for “Convert for PC” 

e .UNIX for “Convert for UNIX” 

4. Click Save to convert and save the file. 

The UNIX Compress format reduces the size of files using a modified Lempel- 

Ziv coding algorithm. 

Choose the “Encode” command from the Compress submenu to encode a file 

in Compress format. 

1. To encode a file to the Compress format, choose “Encode” 

in the Compress submenu. 

A directory dialog box appears for you to select a file. 
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<>] < Maxwell 

— Manwell ¥ 

D Icon 

@ LaserWriter Utility 
OO MactTools 

O Newton stuff 

© SilverLining 

O $itfcomm™ 

@ Stuffit 1.5.1 

@ TRISTAN 

2 Utilities 

—] Convert CR’s -> LFs 

Unix Compress Translator v3.0.3. 

Copyright ©1992 Aladdin Systems, Inc. 

All Rights Reserved. 

2. Select the file to encode, and click Open. 

3. In the Save dialog box, supply a file name and destination 

for the file. 

SITcomm automatically adds a .z suffix to the encoded file’s name. 

4. Click Save to encode the file in Compress format and save 

it to disk. 

Choose the “Decode” command from the Compress submenu to decode a file 

from Compress format. 

1. To decode a file from the Compress format, choose 

“Decode” in the Compress submenu. 

A directory dialog box opens for you to choose a file. 

&) Read Us First ¥ 

CD $iTcomm Notes.2 —Lestat 

Desktop 

—] Show files ending in .2 only 

Unix Compress Translator v3.0.3. 
Copyright © 1992 Aladdin Systems, Inc. 

All Rights Reserved. 



UUCode 

Encode 

Decode 

2. Select the file to decode, and click Expand. 

3. When prompted, supply a file name and destination for the 

file. 

4. Click Save to decode and save the file. 

UUCode is an external Translator that lets you uuencode and uudecode files 

for use over UNIX networks and computers. 

Choose the “Encode” command from the UUCode submenu to convert a file 
to UUCode format. 

1. Choose “Encode” from the UUCode submenu. 

A directory dialog box appears for you to select a file. 

2. Select the file to encode, and click Open. 

3. In the Save dialog box, supply a file name and destination 

for the file. 

SITcomm automatically appends a .UU suffix to the file. 

4. Click Save to encode and save the file. 

Choose the “Decode” command from the UUCode submenu to convert a 

UUCode file into a Macintosh file. 

1. Choose “Decode” from the UUCode submenu. 

A directory dialog box appears for you to select a file. 

2. To limit the file list to files with the .UU suffix, select the 

“Show files ending in .uu only” option. 

3. Select the file to decode, and click Decode. 

4. In the Save dialog box, supply a file name and destination 

for the file. 

5. Click Save to decode and save the file. 
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Viewing Files 

Text Viewer 

Example: Viewing a Foreign 
Text File 
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SITcomm comes with two Viewers — Text and PICT — which let you view 

text or graphics files before or after transferring them electronically. The 

Viewers are specifically designed to let you see the contents of files with 

foreign formats. For example, you can use the Text Viewer to read an 

unzipped PKZIP file that was originally created under Windows. 

In the Viewer, you can copy and paste between documents, or you can print 

the file. In the Text Viewer, you can also change font size and style, and 

search for text. When you open files in the Viewer, they are read-only 

documents; you can’t use the Viewer to edit documents. 

Features Explained: Text Viewer. 

Related Topics: See “Close-up: Text Viewer Menus,” and “Example: Viewing 

a PICT File” later in this chapter. 

Problem: You've just downloaded a word processor file that has been created 

on a DOS machine. You want to be able to view the contents of this file on 

your Macintosh. You also want to print the file so you have a hard copy. 

Solution: Use the Text Viewer in SITcomm. 

Note: If the file is formatted and not plain text, you will not be able to view it. 

1. Choose “View File” from the File menu (or press Command- 

L). 

The View File dialog box opens. 

2. Double-click the desired file name in the View File dialog 

box. 



Since the file is all text, SITcomm opens it in the Text Viewer. 

View of TEST. DOC 

¥P can play music through the internal PC speaker, the Sound Blaster card, 

the Sound Blaster Pro card, or one or two digital to analog converters (DAC) 

connected to the printer ports, LPT1 and LPT2. Itis very cheap and easy to 

build a DAC and plug it on the printer port. A simple circuit design is 

given below. 

YP needs a YGA card, and because of the graphic features of the program, 

the faster the computer is, the better YP will run. IFyou have already 

The Text Viewer displays the document in a window with its own menu 

bar. (See “Close-up: Text Viewer Menus” for a description of each menu 

command.) You can copy text from it and paste it into another document. 

Or, change the font type or size while viewing it. (Font changes apply to 

the whole document, not just selected text. ) 

If you want to print the file, continue with step 3. Otherwise, skip to step 5. 

3. Choose “Page Setup” from the File menu, change any 

printing options (such as page orientation, reduction, or 

special effects), and click OK. 

4. Choose “Print” (Command-P) from the File menu, change 

any printing options you want, and click Print to begin 

printing the file. 

5. When you are finished printing and viewing the text file, 

choose “Close” (Command-W) from the Viewer File menu. 

Close-up: Text Viewer Menus 

Text Viewer File menu The File menu contains the commands for saving and printing the contents 

of the Viewer window. 

File 

About Text Viewer... 

Save As... #5 

Page Setup... 

Print... 36P 

Close a6 LU 
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Text Viewer Edit Menu 

Text Viewer Find Menu 

Text Viewer Font Menu 

Text Viewer Size Menu 
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Save As: Saves a copy of the file outside of SITcomm. When you choose “Save 

As,” a standard Save dialog box appears. You can select the location where 

you want to save the file and rename it if you like. 

Page Setup: Opens the standard Page Setup dialog box and sets printing 

options. 

Print: Prints the contents of the Viewer window. The printer you have 

selected in the Chooser determines which print dialog box you will see. 

Close: Closes the Viewer window and returns to SITcomm. 

The Edit menu contains the standard editing commands. Because Viewer 

documents are read-only, you can’t edit the text. So, the “Undo,” “Cut,” and 

“Paste” commands are not available. You can select any or all of the text and 

copy it to paste into any text editor or word processor for editing. 

The Find menu lets you search for a text string in the Viewer window. 

Find 

Find... SF 

Find Next 36 

Find: Lets you type the text string (up to 255 characters) to find in the 

document. 

Type the word or words to search for in the text box. 

Find Next: Searches for the next occurrence of the current search string. 

The Font menu lets you change the font for all text in the document you are 

viewing. Selecting a different font from the menu changes the view of all of 

the text in the window. You can save font changes by choosing “Save As” in 

the Viewer’s File menu and saving a copy of the document outside of 

SITcomm. 

The Size menu lets you change the font size for text in the entire document. 

Tab Width... 

9,10,12,14,18,24: Offers most common point sizes. If the size you wish to 

use is not here, choose “Other.” 



PICT Viewer 

Example: Viewing a PICT 
File 

Other: Brings up a dialog box for you to enter a font size that isn’t available 

in the Size menu. 

Other Font Size: | 

Cancel 

To change the size for viewing or printing, type in the size you want (in 

points), and click OK. You can type from 1 to 255. 

Tab Width: Lets you change the number of spaces per tab. 

Tab Width 

To change a tab width for viewing or printing, type in the number of spaces 

for the tab width you want, and click OK. You can type from 1 to 255. 

Features Explained: PICT Viewer 

Related Topics: See “Close-up: PICT Viewer Menus,” later in this chapter. 

For information on the Text Viewer, see “Example: Viewing a Foreign Text 

File.” 

Problem: You’re preparing to upload a PICT (graphics) file to a friend. 

Before sending it, you want to look at it to make sure it’s the most recent 

version. But you want to look at it without launching a graphics program to 

view the file. 

Solution: Use the PICT Viewer in SITcomm. 

1. Choose “View File” from the File menu (or press Command- 

L). 

The View File dialog box opens. This is the same dialog box that you use to 

select a text file for opening in the Text Viewer. 

2. Double-click the desired file name in the dialog box. 

Because the file is a graphics document, SITcomm opens it in the PICT 

Viewer. 
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Close-up: PICT Viewer Menus 

PICT Viewer File menu 

PICT Viewer Edit Menu 
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=== View of Lighthouse 

The PICT Viewer is similar to the Text Viewer, with its own menu bar. (See 

“Close-up: PICT Viewer Menus” for a description of each menu command. ) 

You can also select and copy parts of the image and paste the selections 

into another document. 

3. When you are finished viewing the file, choose “Close” 

(Command-W) from the Viewer's File menu. 

The File menu contains the commands for saving and printing the contents 

of the Viewer window. 

File 

About PICT Viewer... 

Save As... 5 

Page Setup... 

Print... 

Close 36LU 

Save As: Saves a copy of the file outside of SITcomm. When you choose “Save 

As,” a Save dialog box opens. You can select the folder where you want to 

save the file and rename it. 

Page Setup: Opens the standard Page Setup dialog box and changes printing 

options. 

Print: Prints the contents of the PICT Viewer window. The printer you have 

selected in the Chooser determines which print dialog box you will see. 

Close: Closes the Viewer window and return to SITcomm. 

The PICT Viewer Edit menu lets you select and copy all or part of the 

document to the Clipboard. See “Text Viewer Edit Menu” for more 

information. 



Moving On Congratulations! You've mastered the advanced features of SITcomm and can 
safely call yourself a SITcomm pro! As a pro, you should know what to do if 

and when you run into a troublesome situation. The next chapter, 

“Troubleshooting,” presents detailed answers to the most frequently asked 

questions about SITcomm. 
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Chapter 6. 
Troubleshooting: 
Commonly Asked 
(Juestions 

Because of the wide variety of modems and online services available, it’s 

impossible to anticipate every potential telecommunications problem. 

However, this chapter gives you information to help you solve the most 

common problems you might encounter while using SITcomm. The 

information is presented in a question-and-answer format so you can find the 

specific solutions you need quickly and easily. 

Connecting Q& A Q: Why can’t I connect? 

A: Make sure your modem is on and that you have the correct cabling 

connected between it and your Macintosh. Also make sure that the 

connection, terminal emulation, and file transfer settings are properly 

established for your modem and for the remote computer. Verify that the 

phone line is properly connected to the modem. 

Q: When I dial the modem to initiate a connection, I get the error 

message “Modem is not responding.” What causes that? 

A: There are several reasons for this error message. First, if the LED lights 

on the modem don’t blink when SITcomm tries to initiate a connection, 

the modem is either not connected to the Macintosh, or the modem 

power is not on. If the LED lights blink, you may have the wrong cable; 

make sure you are using a Macintosh-modem cable. 

Chapter 6. Troubleshooting: Commonly Asked Questions 117 



Q: Why does the connection sometimes fail without apparent reason? 

A: The other system may have hung up without notice, or the carrier may 

have been lost as a result of “noise” on the line. If you have a “Call 

Waiting” feature on your modem line, someone may have tried to call you 

on that line. You should disable call-waiting. 

Q: How can I disable call-waiting when using my modem? 

A: This varies depending on your local phone company. If you’re using tone 

dialing, try preceding the phone number with “*70,” (omit the quotes but 

not the comma). If you are using pulse dialing, try preceding the phone 

number with “1170.” 

You can include these characters in your Address Book entry, the Quick 

Dial dialog box (Session menu), or the Dialing Settings in Preferences 

dialog box (Edit menu). Using the Address Book disables call waiting 

each time you dial the selected entry. Using Quick Dial disables call 

waiting for that call only. Using the Preferences dialog box globally 

disables call waiting for all calls. We suggest you use the Preferences 

dialog box so you don’t forget to disable call waiting. 

Q: Iwant to dial a long-distance remote computer using my calling card. 

How can I tell SITcomm dial the appropriate sequences of access, 

phone, and calling card numbers? 

A: Most long distance calling cards require you to dial an access number 

first, wait for a special tone, dial the phone number second, wait for 

another special tone, then enter your calling card number. Before you 

“send” the next sequence of numbers across the modem, you need to 

instruct SITcomm to wait for the special tone. To do this, include a “W” 

character (without the quotes) between sequences. The “W” tells 

SITcomm to “wait for a tone that is not a dial tone.” For example, if you 

are using Sprint, the phone number field in your Address Book (or Quick 

Dial dialog box) would resemble this: 

1-800-877-8000 W 1-212-555-5432 W 123-456-7890-1234 

The “800” number is the Sprint access number. The second sequence of 

numbers is the number you want the modem to dial. The last sequence 

of numbers is your calling card number. 

Note: SITcomm ignores dashes and spaces because many modems can accept 

only 40 characters. 

Q: When I’m online, two characters appear in the Terminal Window 

when I type just one from the keyboard. Why? 

A: Your system is set to “echo” local characters, but the remote computer 

doesn’t require you to have local echo on. Try turning it off by choosing 

“Turn Off Local Echo” in the Session menu. 
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Q: When I’m online, no characters appear in the Terminal Window when 

I type from the keyboard. Why? 

A: The remote computer expects you to have local echo turned on, but you 

don’t. Choose “Turn On Local Echo” from the Session menu. 

Q: During a connection with the remote computer, the Terminal Window 

is filled with rectangular-type characters, symbol-type characters, 

international characters, and some readable characters. What’s 

causing this? 

A: These characters are called control characters, and they indicate that 

you are either using the wrong terminal emulation setting or the wrong 

connection settings. First, verify that the Emulation setting (TTY or 

VT102) in the Terminal Settings dialog box matches the emulation 

setting required by the host computer. Second, try changing the Parity to 

Even and the Data Bits to 7 in the Connection Settings dialog box. If 

these settings are correctly set, perhaps the telephone line connection is 

bad; try redialing or using a different phone line. 

Q: Sometimes text that I’m typing from the keyboard types over older 

text in the Terminal Window, and sometimes it appears double- 

spaced. Why? 

A: The “New Line On a Return” option is not set correctly in the Terminal 

Settings dialog box. If the text is typing over older data, turn on “New 

Line On a Return,” if the text is double-spaced, turn this option off. 

Q: Why doesn’t my Delete/Backspace key work? 

A: Some remote systems use the DEL ASCII character while others use the 

BS ASCII character to indicate a backspace. If your Delete (or 

Backspace key, on older Macintosh keyboards) isn’t working correctly, 

change the setting of the “Swap Backspace and Delete” option in the 

Terminal Settings dialog box. 

File Transfer Q& A Q: Why can’t I seem to send or receive text or data? 

A: Make sure the baud rate settings match on both your Macintosh and the 

remote computer. If they match but you still have problems, make sure 

the “On Line” option is on in the Terminal Settings dialog box. Make sure 

that the two computers are using the same file transfer protocol. Also, 

check your communications settings; only Kermit works in 7 bit. 

Q: Why does a file transfer not start correctly when I try to download or 

upload a file? 

A: You may be telling SITcomm to initiate the file transfer too soon. Be sure 

to wait until the remote computer instructs you to “start sending file” or 

“ready to receive file,” or a similar message. Then either click “SEND” or 

“RECV” in the Toolbar. Another possibility is that the remote computer 
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doesn’t support the file transfer protocol you have selected for this 

session. If so, choose another protocol in the File Transfer Settings dialog 

box. 

Q: Why do I seem to get so many errors during a file transfer, and why 

does the file transfer suddenly stop or seem to take forever to 

complete? 

A: You may have static on the phone lines. Try disconnecting and calling 

back; or try another phone line. You may also have the 

“Timeout...Seconds” option set too high in the File Transfer Settings 

dialog box. Try reducing the number of seconds. 

Q: Why does data seem to get lost when I’m transferring files using the 

Text Tool? 

A: The speed of transmission is set too high. Try increasing the “Delay Per 

Character” or “Delay Per Line” options in the File Transfer Settings 

dialog box. Also, the Text Tool is not an error-correcting protocol like X/ 

Y/ZMODEM. 

Q: Can I have SITcomm automatically check downloaded files for 

viruses? 

A. Yes, SITcomm can automatically run any anti-virus software you have 

installed in your Macintosh, provided the anti-virus application supports 

the standard Apple event for virus checking. To use this feature, open the 

Address Editor, click the Transfers buttons to access Address Book file 

transfer preferences, and select the “Detect Viruses With” option. When 

this option is checked, you can click Select to specify the virus detection 

to use on all files you receive from the service associated with the current 

Address Book entry. You must take this step for each Address Book entry 

if you want all of them to detect for viruses. 

Compression Q& A Q: How does compression work? 

A: Compression works by minimizing or eliminating redundancy and empty 

space. For example, these 10 characters “AAAAAAABBB” could be 

stored in a file “as is” which would occupy 10 locations, or could be 

encoded as “7A38B” which would only occupy 4 locations. This results in 

a savings of 60%! SITcomm uses this very simple concept along with some 

complex compression algorithms when you Stuff files. 

Q: How do I send a compressed file to a friend who doesn’t have any 

Aladdin product (such as SITcomm or Stuffit)? 

A: You can send your friend a self-extracting archive (.SEA) file. Turn on 

the “Make Self-Extracting” option in the Stuffing section of global 

preferences (Preferences dialog box). For details on SITcomm 

Preferences, see “Setting Preferences,” beginning on page 92. 
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Miscellaneous Q&A 

Q: I received a Stuffit archive from a friend. What is a quick and easy 

way to access the files or folders contained with the archive? 

A: SITcomm gives you an easy way to expand archives. Choose “Expand” 

from the File menu, select the archive you want to UnStuff, and click 

“Open.” This UnStuffs the items from an archive and places them into a 

single folder. If only one item exists in the archive, that item is placed 

individually on your disk. 

You can also set up SITcomm to automatically expand compressed files 

(such as StuffIt archives) after they’ve been downloaded to your 

computer. To do so, use the Transfers preferences for a specific Address 

Book entry in the Address Book Editor. See “Using the Address Book,” 

beginning on page 34 in Chapter 4 for more information. 

Q: I downloaded a Stuffit archive from my favorite BBS, but SITcomm 

won't recognize it. What’s wrong? 

A: Sometimes during a file transfer, a file gets modified in a way that makes 

StuffIt unable to recognize it. Before you download a file, make sure that 

MacBinary is the selected “Transfer As” method in the File Transfer 

Settings dialog box. If you have already downloaded the archive with 

MacBinary disabled, choose “MacBinary” from the Translate menu, then 

choose “Decode” to convert the file into a usable archive. See 

“MacBinary,” on page 103 for details on decoding a MacBinary file. 

Q: Ireceived a .ZIP file from a friend who has an IBM-PC (or 

compatible). Can I do anything with it? 

A: Yes. SITcomm includes an UnZip Translator that can be accessed from 

the Translate menu. The UnZip Translator gives you access to the files 

contained in the .ZIP file. See “DeArc, UnPack, UnZip,” on page 101 for 

information on UnZipping your file. 

Q:May I give my co-workers a copy of this software? 

A: No. It is unlawful to copy this software for any reason other than to 

maintain a backup set of disks. Read your software registration 

agreement for details. If you are interested in volume discount or site 

licensing information, contact Aladdin Systems at (408) 761-6200. 

Q: I’ve read the User’s Guide and I’m still having problems using 

SITcomm. What do I do? 

A: Contact our Technical Support staff either by calling our Technical 

Support Hotline at (408) 761-6200 between the hours of 9 am and 5 pm 

Pacific time, or by reaching us online. Aladdin Systems maintains online 

addresses with America Online, AppleLink, CompuServe, GEnie, and the 

Internet. Whether you contact us via phone or online: 
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e Know your hardware and software configuration, including the type of 

Macintosh, the amount of memory, and the startup documents, 

Control Panel documents, and System Extensions you have installed. 

Also provide the communications and modem settings you are using. 

e Know the version numbers of SITcomm and the System Software you 

are using. 

e Know the serial number of SITcomm. 

e Have a detailed description of what happened or what you are trying to 

accomplish. 

e Be seated at the Macintosh with the software running. 
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CompuServe 

Service Overview 

Appendix A. Overview of 
Online Services 

This appendix gives you an overview of some commercial online services most 

frequently used by Macintosh owners. You'll find contact information and a 

brief description for each online service. Included is the appropriate Aladdin 

address and/or support area where you can reach us for technical support. 

Only those services to which SITcomm can directly connect are included 

here. Online services that require special software for access (such as 

America Online, AppleLink, and Prodigy) are not included. 

At the end of this appendix you'll find tips for using a BBS and how to find 

BBSs that interest you. 

CompuServe Inc. 

5000 Arlington Centre Blvd. 

P.O. Box 20212 

Columbus, OH 43220 

Voice:(614) 457-8600 

800-848-8990 

Aladdin Address: 75300,1666 

CompuServe is one of the most popular commercial online services. It has 

been in operation for nearly twenty years and is the largest service in the 

world. CompuServe offers a complete array of services and subject areas, 

including electronic mail, special interest group (SIG) forums, real-time 

conferences, news, financial information and stock quotes, weather, sports, 

travel, and an electronic shopping mall. CompuServe has many Macintosh- 

specific forums where you can find information from other Macintosh users, 

data libraries, shareware, fonts, and messages. 

Appendix A. Overview of Online Services 123 



Delphi 

Service Overview 

Dow Jones News/ 
Retrieval 

Service Overview 

CompuServe supports modem speeds of 300, 1200, 2400, and 9600 baud. 

You don’t need any additional software to use CompuServe. 

General Videotex Corporation 

1030 Massachusetts Ave. 

Cambridge, MA 02138 

Voice: 800-695-4003 

Delphi does not require any additional software. You can subscribe online by 

dialing 1-800-365-4636 from any modem. At the password prompt, type MP22. 

Follow the prompts to subscribe. 

Dow Jones Information Services 

P.O. Box 300 

Princeton, NJ 08543-0300 

Voice: 800-522-3567, ext. 279 

(609) 520-8349, ext. 279 

Dow Jones News/Retrieval is the business and financial online service. It is 

the exclusive online provider of the full text of The Wall Street Journal. Also 

provided is the complete text of selected articles from Barron’s, Business 

Week, Forbes, Fortune, and The Washington Post. Dow Jones News/Retrieval 

gives you online access to 60 business and financial services, such as current 

stock quotes, historical stock quotes, business news, investment analysts’ 

reports, corporate profiles, P/E ratios, company vs. industry performance, 

income statements and balance sheets, and an online business library. You 

can also use Dow Jones News/Retrieval for electronic mail, shopping, flight 

reservations, movie and book reviews. 

This service supports modems running at 300, 1200, 2400, and 9600 baud. 

Dow Jones News/Retrieval doesn’t require any addition software. To 

subscribe, call one of the telephone numbers listed above. 

124 Appendix A. Overview of Online Services 



GEnie 

Service Overview 

Internet 

GE Information Services 

401 North Washington Street 

Rockville, MD 20850-1785 

Voice: 800-638-9636 

(301) 251-6475 

Aladdin Address: ALADDINSYS 

GEnie is another large online service, with thousands of subscribers. Like 

CompuServe, GEnie uses a command-line interface to access its services. The 

GEnie Basic Service offers electronic mail, bulletin boards, shopping, stock 

quotes, news, weather, sports, travel planning, and games. The bulletin 

boards, called RoundTables, are where you access software libraries and real- 

time conferences. The GEnie Professional offers all that the Basic Service 

does, plus premium business and financial services that include access to 

Dow Jones News/Retrieval. 

GEnie supports modems running at 300, 1200, or 2400 baud. 

You don’t need any special software to use GEnie. To subscribe online, dial 1- 

800-638-8369 (or 1-800-387-8330 in Canada). When you’re connected, type 

HHH. At the “U#=” prompt, type SIGNUP, then press Return. You'll be asked 

for a credit card number to use for monthly billing purposes. 

Unlike commercial online services, such as GEnie or CompuServe, the 

Internet is not owned or operated by any one entity, nor does it have any 

physical location. There is no master computer into which users can dial. 

Instead, the Internet is a giant web of thousands of interconnected computer 

networks scattered across the world. More than 10 million people worldwide 

use the Internet to exchange electronic mail (primary use), transfer 

computer files, search databases, and “chat” in real time with other users. 

Most Internet hosts are run by educational institutes (like universities) or 

government agencies (like NASA). 

Most commercial online services provide gateways to the Internet. For 

example, an America Online mailbox can be reached by an Internet user (or 

by members of other commercial services, through Internet) by using the 

appropriate Internet address: “username@AOL.COM,” where “COM” means 

America Online is a commercial server on the Internet. College and 

university addresses have the “.EDU” suffix, and government addresses have 

the “.GOV” suffix. 

Aladdin Address: aladdin@well.sf.ca.us 
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MCI Mail 

Service Overview 

BBS Tips 

MCI 

1150 17th Street, NW 

Suite 800 

Washington, DC 20036 

Voice: 800-444-6245 

(202) 833-8484 

MCI Mail is an online service specifically designed for sending and receiving 

electronic mail — called Instant Letters. You can also use MCI Mail to send 

paper mail via courier within four hours, overnight mail, first class mail, or 

telex dispatch. For an additional charge, you can use your own letterhead for 

printed mail you send with the service. MCI Mail also gives you the option of 

purchasing link accounts for gateway systems, such as REMS, VREMS, and 

ONR. 

In addition to using MCI mail for exchanging mail, you can access Dow Jones 

News/Retrieval directly. (Surcharges apply to access Dow Jones News/ 

Retrieval). MCI Mail supports modems at 300, 1200, and 2400 baud. 

You don’t need any special software to use MCI Mail. To subscribe to MCI 

Mail, call 1-800-444-MAIL. When you sign up, you receive the MCI Mail 

starter kit, which includes your user name, an assigned password, access 

phone numbers, and documentation. 

You can think of a BBS like a smaller version of an online service, but 

cheaper. A BBS is a wonderful place for you to communicate with other 

people who have similar interests to yours. For example, most computer user 

groups have their own BBSs. A typical BBS offers you electronic mail, 

conferencing, and the ability to download shareware, public-domain 

software, fonts, graphics, and other useful items. Most BBSs don’t cost 

anything except the price of the phone call; others may charge you a small 

annual fee, which gives you a password to the BBS. 
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How to Find a BBS 

Expressing Yourself on a 
BBS 

You can find a listing of BBSs in the MicroTimes or Computer Currents (both 

are free magazines available in many bookstores or newspaper racks). 

Computer Shopper, amonthly magazine, also contains listings of BBSs across 

the country. Many local weekly newspapers list BBSs in the classified section. 

You can even get a list of BBSs on commercial online services such as 

CompuServe and GEnie. 

A BBS can only accept straight ASCII text; you cannot format text you type 

online. So, when you use a BBS, you’ll probably find that people use very 

creative methods to express themselves. For example, TYPING IN ALL 

UPPERCASE is like shouting online. Or, you may see asterisks used for 

*emphasis*. 

“Smiley faces” are another way to express yourself online. Also known as 

“emoticons,” you need to turn your head to the side to view them correctly. 

For example, a happy-face icon consists of a colon, a dash, and a closing 

parenthesis, like this :-). Below is a sampling of Smiley Faces; to create 

them, just type the appropriate sequence of characters. To obtain a Smileys 

file, contact Bryan Kaplan, ATTN: Smiley Faces, P.O. Box 195, Los Angeles, 

CA, 90049. 

!-) Winking 

:-( Frown 

8-) Glasses 

I-) Sleeping 

:-* Kissing 

:-b Sticking out tongue 

:-o Singing 

:-| Apathy 
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Power-saving Tips 

Microprocessor 

Appendix B. Tips for 
PowerBook Users 

SITcomm is the ideal communications software for your PowerBook because 

it only occupies 200K of disk space and uses approximately 500K of RAM 

(suggested application memory size). Here are a few tips for general 

PowerBook use. 

The three major things that place the greatest demands on a PowerBook’s 

battery are microprocessor (CPU) access, hard disk access, and screen 

backlighting. If you can control these power-draining culprits, you can 

squeeze more battery time out of your PowerBook. 

The biggest drain on a PowerBook’s battery comes from the microprocessor. 

All PowerBooks rest the microprocessor during periods of inactivity. Rest 

mode is a very good power-saver, but it can slow down performance, 

especially of applications like fax-modem software that use background 

processing. Although you can turn off the resting feature, it’s best to leave 

resting on. You may experience a slightly slower performance, but you will 

save significant battery power. 

Note: If AppleTalk is on, the microprocessor in your PowerBook won’t go into 

its rest mode. If you’re not going to need AppleTalk, turn it off. 

If you have a PowerBook 145, 145B, 160, 165c, 170, 180, 180c, or Duo, which 

gives you the option of choosing a slower processor speed, always choose the 

slower option (such as 16 megahertz) when you’re using battery power. 

Again, you may experience performance degradation, but the power you save 

will be worth it. 

Appendix B. Tips for PowerBook Users 129 



Hard Disk Access 

Screen Backlighting 

Battery Conditioning 

Compression Tips 

File Transfers in the 
Background 

If you have at least 6 MB of RAM available, try setting up a RAM disk. (Follow 

the instructions in the PowerBook manual.) Reading from or writing to the 

PowerBook’s hard disk drains battery power. Once you’ve got a RAM disk set 

up, copy your System file and some key applications (like SITcomm) to the 

RAM disk. Doing so will let you work longer without having the PowerBook 

access the hard disk. (Don’t forget to save your files to disk periodically.) 

You can also use the PowerBook control panel (System 7.1) or the Portable 

control panel (System 7.01.) to “spin down” your hard drive every 2 minutes 

or so. This is another way to avoid unnecessary hard disk access and, thus, 

loss of battery power. 

SITcomm will not spin up the hard disk under normal usage, except when 

doing a file transfer, capture, or print operation. 

Turn down the backlighting as low as possible, work in a well-lit area, and 

adjust the angle of your screen accordingly. With some practice, you'll get to 

know the best combination of light and screen angle so you can turn down 

screen backlighting and save battery power. 

It is a good idea to condition your battery before using it and on a regular, 

monthly basis. To do so, completely drain the battery’s power: leave the 

machine on until it puts itself to sleep. This ensures that you'll get the 

maximum capacity from the battery. If you don’t take this step and the 

battery is only partially discharged, it will think that the current level of 

power is the limit to its capacity. (This is not applicable for PowerBook 100 

or PowerBook Duo batteries. ) 

Increasing your PowerBook’s storage capacity from 40 to 80 megabytes can 

cost up to $800. Fortunately, you don’t have to spend that much to get 

additional disk space. By using a compression utility, such as Stufflt 

SpaceSaver, you can reduce the amount of used disk space from 40% to 60%. 

Because System 7 lets you run multiple applications simultaneously, you can 

choose to transfer files with SITcomm running in the background while you 

do other tasks. For example, you may want to write a memo in your word 

processor before sending it in SITcomm. Or, work on other tasks in SITcomm 

like expanding files you just received or compressing files you’re about to 

send. 

If you do background file transfers, you should be aware of some 

considerations. File transfers do require a certain amount of CPU time. Your 

PowerBook may not have all that much time to spare depending on the other 

tasks you want to be doing. For example, certain applications occupy so 

much foreground time that SITcomm’s normal background functioning can 

be significantly slower. You can guard against file transfer trouble by setting 
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Express Modem Tool 

up for long timeouts; but you may be using more expensive phone time that 

way. 

If you opt for background file transferring, be sure to check the SITcomm file 

transfer progress bar regularly. (Make sure the progress bar is open to 

expanded view so you can see all the vital statistics.) This way you can 

monitor how fast (or slow) the transfer is progressing 

If you are using a PowerBook Duo computer, your System Software comes 

with the Express Modem Tool — a communications tool that is added to the 

Communications Toolbox. Whenever you use SITcomm with a PowerBook 

that includes an Express Modem, use the Express Modem Tool as your 

connection method. That is, choose “Express Modem Tool” from the Method 

pop-up menu in the Connection Settings dialog box (Session menu). (For 

more information on establishing connection settings, see “Close-up: 

Connection Settings” in Chapter 5.) 

For detailed information on using the Express Modem Tool, and the options 

available for this connection method, refer to the Express Modem Users 

Guide that came with your Express Modem, and to any of the readme files 

that come on the Express Modem disk. 
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Appendix C. SITcomm 
Scripting Reference 
SITcomm uses the AppleScript scripting language so you can automate 

common tasks while you work with SITcomm and other applications. This 

appendix contains a list and definition of each of the scripting commands 

you can use with SITcomm. 

For more information on AppleScript, refer to the AppleScript reference 

manual. For more information on UserLand’s Frontier, refer to its 

documentation. 

Note: This chapter contains fairly technical information. If you are a novice 

to scripting, try using the Record button in the AppleScript Script Editor to 

see how a script is constructed. 

Error Codes Many of the scripting commands generate the following common error codes: 

Zero (0) Successful; no errors. 

-128 User-canceled error code. 

Negative Numbers Standard Macintosh Operating System error codes. See Inside Macintosh for 

full details. 

Note: Some of the commands generate a negative number error code that is 

unique to that command. In these cases, the error code is documented with 

the command. 
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Append Selection 

Purpose 

Parameters 

Result 

Clear Buffer 

Purpose 

Parameters 

Result 

Connect 

Purpose 

Parameters 

Result 

Error Codes 

Disconnect 

Purpose 

Parameters 

Result 

Appends current text selection to the specified file. 

The current selection is added to the end of the specified file. File will be 

created if it does not exist. 

None. 

Small integer. 

Clears entire contents of terminal window. 

None. 

None. 

Opens a communication channel to external devices using the current 

connection tool and settings. 

[string] The optional string is an Address Book entry name as defined in the 

alphabetical list in the Address Book. If no parameter is specified, an attempt 

is made to open the connection using the current tool settings. 

Small integer. 

-1 if the Address Book entry does not exist. 

-2 if the connection is established, but waiting for a password. 

-3 if the connection is established, but automatic logon failed. 

-4 if the connection is already open. 

Closes the communication channel to external devices. 

None. 

Small integer. 
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Expand 

Purpose 

Parameters 

Result 

Error Codes 

Get Address List 

Purpose 

Parameters 

Result 

Note 

Get Connection 
Status 

Purpose 

Parameters 

Result 

Error Codes 

Get Current Address 

Purpose 

Parameters 

Result 

Unstuffs a list of archives. 

[destination string]: This optional parameter indicates a folder in which the 

expanded archive files are to be placed. If no folder is specified, one is 

created in the same location as each archive file. 

[deleteOriginal boolean]: If archives are to be deleted after expanding, pass 

true for this optional parameter. 

Small integer. 

4 indicates an archive integrity error. 

Returns a list of all entries in the current Address Book. 

None. 

List. 

Not recordable. 

Returns a numeric value indicating the most basic state of the connection. 

None. 

Small integer. 

0 if the connection is closed. 

1 if the connection is open. 

2 if listening for a connection. 

Retrieves the name of the current session as displayed in the Toolbar. 

None. 

String. 
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Note 

Get Notepad Text 

Purpose 

Parameters 

Result 

Note 

Get Receive Folder 

Purpose 

Parameters 

Result 

Get Selection 

Purpose 

Parameters 

Result 

Note 

Returns the name of the current session as displayed in the Toolbar, which is 

usually the last Address Book entry used. 

Not recordable. 

Returns the entire contents of the current session’s notepad. 

(useGlobal boolean] Optional parameter gets the Global Notepad text. 

String. 

The entire contents of the current session’s notepad is returned. Returns 

empty if there is no text, or if there is no current session. 

Not recordable. 

Returns the path to the folder where files will be received. 

None. 

String. 

Specification of the current receive folder as a full path. 

Returns the text of the current selection. 

None. 

String. 

If there is a selection in the Terminal window or the Notepad window, the 

selected text is returned. Empty if no selection. 

Not recordable. 
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Get Timer 

Purpose 

Parameters 

Result 

Note 

Get Tool Config 

Purpose 

Parameters 

Result 

Note 

Get Tool List 

Purpose 

Parameters 

Result 

Note 

Get Tool Name 

Purpose 

Parameters 

Result 

Returns the elapsed time (in seconds) since the current session connection 

was opened. 

None. 

Integer. 

Not recordable. 

Returns a text string from the tool of the given class that represents its state. 

{addressName string]: This optional parameter returns the Tool 

configuration for the current session. To get a specific configuration, use an 

Address Book entry name as defined in the alphabetic list displayed in the 

Address Book window. 

String. 

Not recordable. 

Returns a list of tools for the given class. 

None. 

List. 

The list contains the name of each tool in the Extensions folder of the 

specified class. 

Not recordable. 

Returns the name of a tool of the given class. 

[addressName string]: This optional parameter returns the tool name for the 

current session. To get a specific name, use an Address Book entry name as 

defined in the alphabetic list displayed in the Address Book window. 

String. 
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Note 

Listen for 
Connection 

Purpose 

Parameters 

Result 

Load Address 

Purpose 

Parameters 

Result 

Error Codes 

Pause Connection 

Purpose 

Parameters 

Result 

Empty if request made for specific Address Book entry and given name is not 

in the Address Book. 

Not recordable. 

Places the current connection tool in a waiting mode. 

[integer]: This optional parameter specifies one of three timeout values. 

Specify a positive value for time to wait (in seconds), zero for a single 

attempt, or -1 for no timeout. If the parameter is omitted, no timeout (-1) is 

used. 

Small integer. 

Zero is returned if a connection is made within any specified timeout. 

Makes the current session configuration the specified address. 

None. 

Small integer. 

-] if the Address Book entry does not exist. 

-4 if the connection is already open. 

Sends an XOFF character to the remote system. 

None. 

Small integer. 
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Print Selection 

Purpose 

Parameters 

Result 

Receive Files 

Purpose 

Parameters 

Result 

Resume Connection 

Purpose 

Parameters 

Result 

Save Selection 

Purpose 

Parameters 

Result 

Prints the current text selection with the current printer setup. 

None. 

Small integer. 

Enters receive mode using the current transfer tool and settings. 

[string] This optional parameter places files in a specified folder rather than 

the current receive folder. 

List. 

List of files just received is returned. If the tool receives a batch of files, all 

should be included. If the tool does not support batch receives, only a single 

file is returned. 

Sends an XON character to the remote system. 

None. 

Small integer. 

Saves current text selection into the file specified in the optional parameter. 

[filename] This optional parameter replaces the contents of specified file 

with the current selection. File is created if it does not exist. 

Small integer. 
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Send Break 

Purpose 

Parameters 

Result 

Note 

Send Files 

Purpose 

Parameters 

Result 

Send Text 

Purpose 

Parameters 

Result 

Set Notepad Text 

Purpose 

Parameter 

Result 

Error Codes 

Sends a hardware break signal to the remote computer. 

{longBreak boolean]: Set this optional parameter to true when you need a 

long duration instead of a short duration break signal (3.50 vs. 0.23 seconds). 

None. 

Not recordable. 

Sends the specified files to the remote system using the current transfer tool 

and settings. 

filename: Specifies one or more files to send. 

Small integer. 

Number of files sent. 

Sends the given text to the remote system. 

string: Text to send. 

[delay integer]: This optional parameter adds an inter-character delay, in 

60ths of a second. Zero is used if parameter omitted. 

Small integer. 

Sets the current session’s notepad text to the given text. 

string: Sets the current session’s notepad text to the given text. Any previous 

text in the current session’s notepad is lost. 

[useGlobal boolean]: Set this optional parameter to true to use the Global 

Notepad’s text. 

Small integer. 

-] if there is no current session. 
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Note 

Set Receive Folder 

Purpose 

Parameters 

Result 

Set Tool Config 

Purpose 

Parameters 

Result 

Set Tool Name 

Purpose 

Parameters 

Result 

Error Codes 

Stuff 

Purpose 

Parameters 

Not recordable. 

Sets the file receive folder to the given directory. 

string: Specifies the full path for the desired receive folder. 

Small integer. 

Calls the appropriate Communications Toolbox function for the given tool 

class. 

[string] This optional parameter should be compatible with the current tool. 

Small integer. 

Changes the current tool of the given class to the one specified by name. 

[string] This optional parameter specifies the name of a tool. 

Small integer. 

-1 if the tool is not found. 

Stuffs a list of files and folders to an archive. 

[string] This optional parameter specifies a filename for the resulting 

archive. Default is to name as “Archive.sit” and place archive in same folder 

as first file in list. 

[deleteOriginal boolean]: If archives are to be deleted after unstuffing, pass 

true for this optional parameter. 

[makeSEA boolean]: To make the archive self-unstuffing, pass true for this 

optional parameter. 

[encrypt boolean]: To encrypt items added to the archive, pass true for this 

optional parameter. 
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Result 

Translate 

Purpose 

Parameters 

Result 

Note 

Turn Off Capturing 

Purpose 

Parameters 

Result 

Turn On Capturing 

Purpose 

Parameter 

Result 

[noCompress boolean]: To not compress the items that are added to the 

archive, pass true for this optional parameter. 

Small integer. 

Translates a file. 

string: Specifies a name from a published list of translators. 

[toMacFormat boolean]: This optional parameter indicates true if 

translation is from foreign TO Macintosh format, and false for translating 

FROM Macintosh to foreign format. If omitted, true is presumed. 

[destination string]: This optional parameter specifies a single destination 

folder. If none is specified, the resulting files are placed in the same folder as 

each source file. 

Small integer. Always returns a zero. 

Not recordable. 

Closes the currently active capture file. 

None. 

Small integer. 

Opens a file to capture incoming and outgoing text data. 

[string] This optional parameter names the capture file. If none supplied, 

default name is Address Book session name, or “Capture File” if not a session 

name, and the date as the shortDate format. 

Small integer. 
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Turn Off Printer 

Purpose 

Parameters 

Result 

Turn On Printer 

Purpose 

Parameters 

Result 

Wait For Text 

Purpose 

Parameters 

Result 

Closes the current printer job. 

None. 

Small integer. 

Opens the current printer to print incoming and outgoing text data. 

None. 

Small integer. 

Places a search on the connection for the specified text string(s). 

string: Specifies a list of text strings to wait for. 

[timeout integer]: This optional parameter specifies the number of seconds 

to wait for any of the specified text strings. If the parameter is omitted, no 

timeout is used. 

[inStream boolean]: This optional parameter specifies true if you want the 

search for the specified text to be placed on the connection rather than 

anywhere in the terminal emulation region. Connection searches ARE case- 

sensitive, whereas terminal searches are not. 

String. 

The text found is returned unless a timeout occurs, then the text is empty. 
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ACK 

Algorithm 

ANSI 

Answerback message 

Archive 

ASCII 

Asynchronous 

Glossary 
The acknowledgment sent by the receiving computer to the sending 

computer during file transfer to verify accuracy of transmission. Derived from 

the ASCII ACK character. (Compare with NAK. ) 

A set of methods used to analyze the sequence of characters that make up a 

file and reorganize them in a more efficient manner. Sometimes referred to 

as compression algorithm. 

American National Standards Institute, the U.S. branch of the International 

Standards Organization. ANSI is responsible for establishing various 

standards for the U.S. computer industry, such as the data transmission 

protocols, programming languages, computer terminal definitions and 

magnetic storage media standards. 

A string, of up to 20 characters, sent to the remote computer in response to 

an Enquire (Control-E) character. The answerback ensures that the 

information is sent only to the intended computer. The answerback is used 

most often with computer-dependent proprietary systems such as Telex 

systems and real estate multiple listing services. 

A special file that contains multiple files and/or folders. Archive files may be 

compressed or even encrypted. (See also Self-extracting archive) 

An acronym for American Standard Code for Information Interchange. ASCII 

encoding changes typed characters into a format that is easily transmitted 

and universally recognized. When the ASCII code is received by the host 

computer the process is reversed and your character appears on the screen. 

A mode of data transmission in which characters are sent at varying time 

intervals. Each character is preceded by a start bit and followed by a stop bit. 

Asynchronous communication eliminates the need for computers to have a 

common synchronized clock to coordinate communication. (Compare with 

Synchronous.) 
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Batch 

Baud rate 

BBS 

Bell 103 

Bell 212A 

Binary 

BinHex 

Bit 

Block size 

BPS 

Buffer 

Bulletin board system 

Byte 

Capture 

146 Glossary 

A method of processing in which similar items, such as files, are grouped and 

processed together. Batch file transfers allow you to transfer several files 

with a single command. 

The speed at which data is transmitted across a modem. The baud rate is 

equal to the number of discrete signals per second, sometimes called bits per 

second (or BPS). Although it is incorrect to do so, the term BPS is commonly 

used interchangeably with baud rate. 

See Bulletin board system. 

A standard U.S. protocol for exchanging information at 800 baud. 

A standard U.S. protocol for exchanging information at 1200 baud. 

A number system limited to ones and zeros as opposed to the decimal system 

that uses ten digits (zero to nine). At the lowest level, all digital computers 

handle information in binary form. 

A method of converting binary files to a 7-bit text format so that they can be 

stored and exchanged with older computers and mainframes. (See also 

MacBinary.) 

A binary digit (one or zero). The fundamental unit of information for all 

computer systems. Bits are often grouped in chunks of eight, called bytes. 

(See also Byte.) 

Size of the unit being transmitted across a network or communications line. 

The unit consists of a group of words or characters. For example, 1K is a 

typical block size. 

An acronym for bits per second. The number of bits that can be transferred 

per second. Although it is incorrect to do so, the term BPS is commonly used 

interchangeably with baud rate. 

A temporary storage area used to accumulate data before it is passed on to 

another device or program. A buffer may be used to compensate for the 

difference in the data flow rate between two devices. (See also Screen 

buffer.) 

A host computer set up to act as an electronic bulletin board for computer 

owners with similar interests or needs to call in, read and send messages, and 

transfer files. Also referred to as BBS. 

A group of eight bits that are treated as a single unit or that represent a single 

character. (See also Bit.) 

The process of saving the incoming stream of data you see in the Terminal 

Window to a text file. 



Carriage return/linefeed 

Carrier 

CCITT 

Checksum 

Communications session 

Communications tools 

Compression 

Connection tools 

Creator 

CRC 

Data bits 

DB-9 

The character sequence used to terminate lines in text files on Intel-based 

computers (such as an IBM PC). 

The analog signal used by modems to transmit data. When calling another 

modem, if the signal is missing, full of noise or somehow distorted, most 

modems will report “NO CARRIER” and hang up. If the carrier signal is of a 

recognizable frequency and is trouble-free, most modems will report 

“CONNECT” and then allow data to be sent. 

Comité Consultatif International Télégraphique et Téléphonique 

(International Consultative Committee on Telegraphy and Telephony). An 

international organization that establishes protocols and other 

communications standards. 

An error-checking mechanism for file transfers. An extra byte that is added 

to each block of data by the sender and that is used by the receiver to verify 

accuracy of transmission. (See also CRC.) 

The activity during the time your Macintosh is connected to another 

computer. 

Software components that supply the communications functions your 

Macintosh needs to communicate with another computer. Communications 

tools fall into three categories: connection tools, terminal emulation tools, 

and file transfer tools. Each type of tool manages a different aspect of the 

communication process. 

The process of reducing the size of files or folders through a mathematical 

algorithm that re-organizes the data more efficiently. 

One of the three types of communications tools. A connection tool determines 

the type of connection that is established between your Macintosh and the 

other computer. The Apple Modem Tool and the Serial Tool are examples of 

connection tools. 

A four character code that identifies the parent application of a Macintosh 

file. If a file does not have the correct creator code, it usually appears as a 

generic icon on the desktop. 

An acronym for Cyclic Redundancy Checking. An error-detecting mechanism 

used during file transfers. (Compare with Checksum.) 

A setting for the number of bits used to make up a character. 

The serial connector for cables on Macintoshes earlier than the Macintosh 

Plus as well as IBM PC-AT and compatible Intel-based computers. The “9” 

refers to the number of pins in the connector. 
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DIN-8 

Downloading 

Dumb terminal 

EBCDIC 

Echo 

ENQ 

Even parity 

Expand 

File transfer 

File transfer protocol 

File transfer tools 

Forum 

Full duplex 

Half duplex 

Internet 

Kilobyte 
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The type of serial cable connector that most modems are built to 

accommodate. Also, the connector on the IBM PC-XT and compatible Intel- 

based computers. The “25” refers to the number of pins in the connector. 

The standard Macintosh modem cable connection (for a Macintosh Plus 

computer or later). The “8” refers to the number of pins. 

The process of receiving a file. 

This consists of a monitor and keyboard, but no CPU. It is usually connected 

to a mainframe or a minicomputer. 

Extended Binary-Coded Decimal Interchange Code. An alternative to ASCII 

that is used primarily by IBM mainframes. (See also ASCI/) 

Characters you type are displayed (echoed) in the Terminal Window. 

The abbreviation for the ENQUIRE control character used by some protocols 

to permit a remote system for an answerback. 

A method of parity error checking in which a parity bit is added to a group of 

bits to keep the total number of ones in the group even. If the number of ones 

in the group is odd, the parity bit is set to one, so that final total for the group 

is even. If the number of ones in the group is already even, the parity bit is set 

to zero, keeping the total number of ones even. (See also Parity.) 

The process of decoding a compressed or stuffed file. 

To send a file from one computer to another. 

See protocol. 

One of the three types of communications tools. A file transfer tool 

implements the protocols used for sending files from one computer to 

another. The Text Tool and the ZMODEM Tool are two examples of file 

transfer tools. 

An electronic area for exchanging information with other CompuServe 

subscribers. 

A mode of communications in which information is transferred in both 

directions simultaneously. 

A mode of communications in which information is transferred in only one 

direction at a time. 

A vast web of thousands of networked computers scattered across the world. 

Most Internet hosts are run by universities or government agencies. 

Often expressed as K. Equivalent to 1024 or 210 bytes. (See also Byte.) 



Handshake 

Hayes Command Set 

Host computer 

Kermit 

Log on 

MacBinary 

Macintosh Communications 
Toolbox 

Mark parity 

MNP 

MNP4 

MNP5 

Modem 

NAK 

Regulates the flow of data between your Macintosh and the port or device 

(modem) you connect to. The Serial Tool offers five handshake settings, with 

the default setting being None. 

Synonymous with the AT command set, a collection of modem commands 

used to control the actions of a Hayes or Hayes-compatible modem. 

Considered the industry standard modem command set. 

The computer that your Macintosh is connected to. Can be another personal 

computer or mainframe. 

File-transfer protocol used primarily by educational institutions and older 

mainframes. It is the slowest file-transfer protocol. 

The process of establishing a connection and getting access to a remote 

system. 

A file format intended to ensure that complete Macintosh files are sent along 

with their Macintosh-specific attributes, which include the file type, Finder 

information, creator, file name, and the data and resource forks. This allows 

the receiver to recreate the file accurately. Sometimes referred to as 

BinHexd. 

A set of extensions to Macintosh system software that provide Macintosh 

applications, like SITcomm, with standard communications services and a 

consistent interface for using those services. 

A method of parity checking in which the parity bit is always set to one. (See 

also Parity.) 

An abbreviation for Microcom Networking Protocol (proprietary). This was 

the first error checking protocol for use in modem hardware, and it has 

evolved in a series of levels (most common are Level 4 and Level 5). 

This is MNP Level 4 and is the U.S. standard for error checking and correction 

between two modems. It has been superseded by V.42, the CCITT standard. 

This is MNP Level 5 and is the U.S. standard for data compression in modems, 

achieving an average of 2 to 1 data compression. It has been superseded by 

V.42bis, the CCITT standard. 

An acronym for modulate/demodulate. A peripheral device that enables a 

computer or terminal to transmit and receive over telephone lines by 

modulating, or converting, data from a digital to analog form. When receiving 

data, the modem converts an analog signal to digital (demodulation); when 

sending data, the modem converts the digital signal to analog (modulation). 

Refers to a negative acknowledgment error-checking response during file 

transfers. Derived from the ASCII NAK character. Compare with ACK. 
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Network 

Null modem cable 

Odd parity 

Online service 

Packet 

Parity 

Protocol 

Screen buffer 

Script 

Serial port 

Self-extracting archive 

Start bit 
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A collection of interconnected, individually controlled computers, the 

hardware and software used to connect them, and the communications 

protocols that govern the exchange of information between the computers 

and other devices. A network allows users to share data and peripheral 

devices such as printers and storage media, to exchange electronic mail, and 

So on. 

A cable or adapter plug used to connect two computers without using 

modems. 

A method of parity error checking in which a parity bit is added to a group of 

bits to keep the total number of ones in the group odd. If the number of ones 

in the group is even, the parity bit is set to one, so that final total for the group 

is odd. If the number of ones in the group is already odd, the parity bit is set 

to zero, keeping the total number of ones odd. (See also Parity.) 

Commercial network that provides services (such as electronic mail and 

messaging, file downloading/uploading, and so on) to users who connect via 

modem. 

A group of characters that contain portions of the data being sent during a file 

transfer. (See also Block size.) 

Checks that data is not garbled during transmission. 

A set of rules for sending and receiving data on a communications line. A 

formal set of conventions governing the format and relative timing of message 

exchange between two communications systems. Protocols also 

automatically check for errors during file transfer, and correct them if 

possible. 

Contains the data that has rolled off the top of the Terminal Window since the 

session began or since the buffer was lasted cleared. The screen buffer is a 

temporary holding spot for capturing text during a communications session. 

Earlier text may be lost as more information is accumulated and the buffer 

space is filled. (See also Buffer and Terminal Window.) 

Aseries of instructions to SITcomm that allows the automation of frequent or 

routine communications tasks. 

Either one of the communications ports in the back of your computer; either 

the modem or printer port. 

A special type of archive that can be decompressed and used without need for 

the compression program. 

The primary bit that, with the stop bit, frames a transmitted character. (See 

also Stop bit. ) 



Stop bit 

Stuff 

Stuffit 

Synchronous 

SySop 

Telecommunicating 

Telecommunications 

Terminal 

Terminal emulation 

Terminal emulation tools 

Terminal Window 

Toolbar 

Uploading 

XMODEM 

YMODEM 

ZMODEM 

A setting used to mark the end of a transmitted character. (See also Start 

bit.) 

See Compression. 

The standard archive format on the Macintosh. 

A mode of data transmission in which bits, characters, or units of data are 

transmitted at constant time intervals. (Compare with Asynchronous.) 

Abbreviation for system operator. This is a person who maintains a BBS. 

The process of connecting to another computer and transmitting information 

across phone lines or across networks. 

The science and technology of communication by electronic means. 

A video screen, teletypewriter or other device, and often a keyboard that may 

be connected to a remote or local system to allow communication between a 

user and a computer system. 

The ability of your Macintosh to emulate a dumb terminal. Dumb terminals, 

which generally consist of a monitor and a keyboard with no CPU, are the type 

of terminals that connect to a mainframe or minicomputer. 

One of the three types of communications tools. The terminal emulation tool 

that you use determines the type of terminal that your Macintosh emulates 

during the communications session. The TTY Tool and the VT102 Tools are 

examples of terminal emulation tools. 

Main SITcomm window. Displays all incoming and outgoing communications 

between your Macintosh and the other computer. This is where you view and 

work with data during a communications session. 

The nerve center of SITcomm, which lets you see at a glance information 

about your communication settings. The Toolbar also provides quick access 

to the most frequently-used SITcomm features. 

The process of sending a file. 

The most common file-transfer protocol. Includes error-checking. 

Faster than XMODEM, this file-transfer protocol includes error-checking and 

allows you to upload and download more than one file at a time for batch file 

transfers. 

Best, fastest file-transfer protocol. Like YMODEM, allows batch file transfers, 

plus you have the option of resuming a transfer if a connection should break. 
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Index general options 40 
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options 39 
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Apple Modem Tool 12, 72 
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cabling option 75 
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data bits 74 

dialing a number 73 

error correction type options 74 

explained 72 
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modem options 73 

modem settings 73 
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phone settings 73 

port settings 74 
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AppleSingle translator 98 
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defined 18 
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Auto-receive option 

Aladdin X/YMODEM tool 88 

B 
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fun with Smiley Faces 127 

tips on using 127 
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BinHex4 translator 98 

BinHexd 103 
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sending 78 

Breaking the connection 53 

btoa/atob translator 100 

Buffer 
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embedded returns 67 

Bulletin board systems 1 

C 
Call 

listening for 52 

Call waiting 

disabling 94 

Calling card 

using with SITcomm 94 

Capture File Creator 93 

Capturing data 60 

from connection 40 

from terminal 40 

settings 40 

Carriage return 

answerback message VT102 Tool 
81 

Changing Address Book defaults 35 

Changing preferences 92 

Changing settings 

connection, terminal, file transfer 
42 
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45 

Changing the Terminal settings 44 
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VT102 Tool 84 

Character settings 

TTY Tool 79 

Clear Buffer scripting command 134 
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file transfer settings 84 
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tools 16 
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Introduction to 18 
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Apple Modem Tool 72 

modem settings 73 

phone settings 73 
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Serial Tool 76 
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Dialing options (cont. ) 

global preferences 94 

in Apple Modem Tool 73 

using a calling card 94 

Direct connection using null modem 
cable 48, 49 

Disabling call waiting 94 

Disconnect scripting command 134 

Disconnecting 27, 53 

Document type 

Aladdin X/YMODEM tool 88 
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Downloading 17 
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type in Apple Modem Tool 74 

Escape characters 

Aladdin ZMODEM tool 89 

Example 
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transfer methods 87 
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